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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Some application pages have help icons    to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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Introduction

1  Introduction

Overview of Implementing Performance Management  
This guide describes the setup and implementation tasks for Performance Management work area in the Workforce
Development offering. Using these tasks you can implement and maintain Oracle Fusion Performance Management to
set up performance documents to review workers as part of a performance evaluation.

Oracle Fusion Performance Management Cloud Service is part of the Workforce Development offering of Oracle Human
Capital Management Cloud. To start an implementation of Oracle Human Capital Management Cloud, a user with the
Application Implementation Consultant role (ORA_ASM_APPLICATION_IMPLEMENTATION_CONSULTANT_JOB) must
opt into the offerings applicable to your business requirements. Refer to the Oracle Applications Cloud Using Functional
Setup Manager guide to manage the opt-in and setup of your offerings. This topic:

• Lists where to find information about prerequisite tasks and pertinent information about implementing Oracle
Fusion Performance Management

• Describes the Worker Performance functional area of the Workforce Development offering

Prerequisites
Before setting up Performance Management you must implement either:

• HCM Base

• Talent Management Base

You are also required to configure other applications and elements. The table lists sources of information, including
guides and help topics, and a description of what they contain, to help you set up the configuration that fits your
business needs and processes.

Source Contents

Oracle HCM Cloud Getting Started with
Oracle Talent Management Cloud
 

Provides an overview of Talent Management Cloud options, purchasing and activation options, basic
information for implementing Talent Management applications, and describes work areas.
 

Oracle Talent Management Cloud
Implementing Talent Management Base
 

Describes user and role synchronization, implementation user setup, enterprise and workforce
structures, workforce profiles, approvals, help configuration, and more.
 

Oracle Global Human Resources Cloud
Implementing Global Human Resources
 

Describes user and role synchronization, implementation user setup, enterprise and workforce
structures, workforce profiles, approvals, help configuration, and more.
 

Human Capital Management Cloud
Integrating with Oracle HCM Cloud
 

Describes integration types, how to use file-based and spreadsheet loaders, integrations with Oracle
Taleo Recruiting Cloud Service, web services, and coexistence.
 

Human Capital Management Cloud
Securing Oracle HCM Cloud
 

Describes Oracle Human Management Cloud security, types of roles and how to create them,
 managing user accounts, types of security profiles and managing them and Oracle Fusion
Transactional Business Intelligence and Business Intelligence Publisher security.
 

1
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Workforce Development Offering
Use this offering to configure and define the worker performance. The functional area in the offering and primary
features are available in the following table.

Functional Area Description

Worker Performance
 

Use this functional area to configure worker performance settings such as value sets, lookups, profile
options, notifications, performance roles, Talent eligibility profiles, scheduled processes, document
types, templates, target ratings distribution, performance and potential box chart labels.
 

Related Topics
• Plan Your Implementation

Guide Structure  
This topic gives a summary of each chapter and describes where to find additional information for the tasks in the
Worker Performance functional area.

The primary features of the Workforce Development offering are explained in this guide. For the full list of
functional areas and features in this offering, use the Associated Features report that you review when you plan the
implementation of your offering. This topic describes the contents of each chapter included in the following sections of
the guide:

• Introduction

• Questionnaires

• Performance Management Settings

• Performance Management Application Implementation

Introduction
This table provides the chapter details.

Chapter Title Contents

2
 

Overview and Integrations
 

An overview of the Performance Management
implementation and description of how it
integrates with other applications.
 

Personalization
This table provides the chapter details.

2
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Chapter Title Contents

3
 

Personalization Using Transaction Design
Studio
 

Using Transaction Design Studio to hide or
include fields in performance pages.
 

Questionnaires
This table provides the chapter details.

Chapter Title Contents

4
 

Questionnaires
 

Creating questionnaire templates,
 questionnaires, and questions to use in the
Manage Participant Feedback task in a
performance evaluation.
 

Performance Management Settings
This table provides the chapter details.

Chapter Title Task Contents

5
 

Descriptive Flexfields
 

Performance Descriptive Flexfields
 

Describes the available flexfields
for Performance Management and
where they're used.
 

6
 

Profile Options
 

Performance Profile Option Values
 

Describes how to configure the
profile options for Performance
Management and the effects of the
settings.
 

Performance Management Application Implementation
This table provides the chapter details.

Chapter Title Contents

7
 

Performance Roles
 

Creating roles that can access performance
documents to provide feedback and enter
ratings and comments about a worker.
 

8
 

Matrix Management
 

Configuring roles, process flows, and
performance templates to use matrix
management.
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Chapter Title Contents

9
 

Eligibility Profiles
 

Creating eligibility profiles to restrict availability
of performance documents to a specific
population based on criteria you set up.
 

10
 

Eligibility Batch Process
 

Describes how to run the eligibility batch
process to determine which performance
documents a population of workers is eligible to
use for their performance evaluation.
 

11
 

Performance Process Flows
 

Configuring process flows to determine
the tasks, and their sequence, used by the
performance template for performance
evaluations.
 

12
 

Performance Template Sections
 

Configuring sections that are required for the
tasks in the process flow, including section
type, calculation rules and rating models used
in the sections, weighting, and adding content
items.
 

13
 

Review Periods
 

Create review periods to link performance
management and goal management business
objects to measure and achieve results within
the review period time line.
 

14
 

Performance Document Types
 

Create performance document types to
associate with performance templates to create
performance documents, and goal plans to
determine which goal plan is used to populate
performance documents with goals.
 

15
 

Performance Templates
 

Configuring performance templates used to
create performance documents to specify
the process flow definition, the sections,
 and the document type, add review periods,
 static content, and roles that can access the
document.
 

16
 

Check-In Templates
 

Creating check-in templates to meet your
organization requirements and facilitate the
process of creating check-in documents by the
manager and employees.
 

17
 

Feedback Templates
 

Creating feedback templates to meet your
organization requirements and facilitate the
process of seeking feedback in the organization
all through the year.
 

4



Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 1
Introduction

Setup Tasks for Implementing Performance
Management  
To implement Oracle Fusion Cloud Performance Management, you must have the Application Implementation
Consultant role (ORA_ASM_APPLICATION_IMPLEMENTATION_CONSULTANT_JOB).

Oracle Fusion Cloud Performance Management is part of the Workforce Development offering of Oracle Fusion Cloud
Human Capital Management. Review the tasks listed in this table before you set up Performance Management.

Task Name Description Recommended Help

Manage Participant Feedback Create questionnaire templates, questionnaires,
 and questions for a performance evaluation.

Participant Feedback

Performance Descriptive Flexfields Describes the available flexfields for
Performance Management and where they're
used.

Descriptive Flexfields for Performance
Management

Performance Profile Option Values Describes how to configure the profile options
for Performance Management and the effects
of the settings.

Performance Management Profile Options

Performance Process Flows Create process flows for performance
evaluations to determine which tasks to include,
 and the order to perform them.

Options for Performance Process Flow Setup

Talent Performance Notifications Enable or disable Performance Management
notifications.

Overview of Notifications

Performance Roles Define roles to expand the scope of the
performance evaluations to include feedback
from participants other than the worker and
their manager.

Performance Roles

Eligibility Profiles Create and update combinations of criteria
to determine eligibility for performance
documents.

Examples of Using Eligibility Profiles with
Performance Documents

Performance Template Sections Create sections to include in the performance
document template.

Considerations for Creating Performance
Template Sections

Performance Document Types Create performance document types to
differentiate types of performance evaluations,
such as annual or project-specific.

Overview of Performance Document Types

Questions Create questions and format question types to
use in questionnaires.

Guidelines for Loading Questions, Questionnaire
Templates, and Questionnaires

Questionnaire Templates Define questionnaire templates from which to
create questionnaires to use to solicit feedback.

How You Configure Questionnaire Templates

Questionnaires Define questionnaires to determine the layout,
 and add questions and sections to use to solicit
performance feedback.

Questionnaires
Participant Feedback
 

5
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Task Name Description Recommended Help

Performance Templates Create templates for performance documents,
 including the structure, processing rules,
 content, and periods.

Guidelines for Setting Up Performance
Templates

Eligibility Batch Process Determine which performance documents a
population of workers is eligible to use for their
performance evaluation.

Eligibility Batch Process for Performance
Documents and Check-In Templates

Use these actions of Transaction Design Studio (TDS) to configure Performance Management pages:

• Performance Document

• Performance Management

• Performance Spotlight

For more information about configuring Performance Management pages using TDS, see the How You Configure
Performance Pages Using Transaction Design Studio topic.

Security Reference
The tasks that people can do and the data that they can see depend on their roles, duties, and privileges. For
information about these factors, see these two guides:

• Securing HCM

• Securing Reference for HCM

Options for Navigating in Performance  
This topic explains the different ways to navigate to the same page and how we refer to pages and areas in
Performance.

Setup and Maintenance
Did you know that you can use either the Setup and Maintenance work area or the Setup Maintenance area under My
Client Groups to access the same pages? This guide refers to the Setup and Maintenance work area and it's up to you
which way you access the page it's referring to. For example, you can reach the Performance Template page in both of
these ways:

• My Client Groups > Performance > Setup Maintenance

• On the toolbar, click the arrow by Initials or user image to open the Settings and Actions menu. In the
Administration area, click Setup and Maintenance. Click the arrow by the Setup menu and scroll to Workforce
Development. In the left part of the UI, click Worker Performance. Then on the right area of the UI, click
Performance Template.

6
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Performance Pages
This guide refers to Performance pages as a grouping to describe all the pages a user can access. For example:

• An employee selects the Performance tab to see their Performance spotlight page.

• A manager accesses the Performance Overview and Evaluate Performance pages.

• An HR specialist accesses all pages under My Client Groups.

Deep Links  
You can use deep links to provide easy navigation directly to a page in the HCM Cloud application.

You can also use deep links for mobile responsive pages on your intranet, custom and third-party applications, or in a
document. This helps people run transactions in the HCM cloud and provides quick access to their HR information.

To access deep links:

1. Open the main menu.
2. Go to Tools> Deep Links.
3. Copy the URL for a deep link.
4. Paste the URL in the appropriate location.

When you open Deep Links, you find a list of all available deep links.

Overview of Performance Management Scheduled
Processes  
Use these scheduled processes for Performance Management.

Process Name Description Parameters

All-in-One Evaluations for Performance
Documents

Initiates the process to submit manager
evaluations and calculate section ratings for
performance document data on the All-in-One
Evaluations page.
 

No parameters, submit the process.

Manage Eligibility Batch Process Determines the eligibility of workers for
performance documents.

Batch Process Type:
 
Assign Performance Document
 
Assign Check-In Template
 
Select one of the batch process types to select
these parameters:
 
Effective as of Date: It determines when
workers are eligible for performance documents
or check-in templates. If you set a future date,

7
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Process Name Description Parameters

performance documents can only be created
for eligible employees from that date.
 
Select Current Date to use the system date
every time the process runs.
 
Review Period: Using this, you can find a
performance document that matches the
selected review period.
 
Performance Document Name: Select the
name of the performance document that you
want to process.
 
OR

• Check-In Template Name: Select the
name of the check-in template that you
want to process.

Create Eligible Performance Document: If you
select this, the application automatically creates
performance documents for each eligible
employee.
Purge Historic Performance Eligibility Status
Data: Choose whether to permanently delete
historic performance eligibility status data to
improve system performance.
 
Purge Older Than: Purge any data older than
the specified date.
 

Migrate Performance Setup Data History Initiates the performance setup data history
migration process from E-Business Suite to
Oracle Fusion HCM.

Specify the FTP Outbox Directory.

Migrate Performance Transaction Data History Initiates the performance transaction data
history migration process from E-Business
Suite to Oracle Fusion HCM.

Specify the FTP Outbox Directory.

Performance Data Integrity Check Initiates the job to check data integrity for
Performance Management.

Action:
 

• Preview: select to preview the changes
before submitting.

• Update: select to submit the changes.

Performance Document: The document for
which this is applicable.
 
Worker Person Number: The worker person
numbers for whom the performance document
is applicable.
 

Performance Management Diagnostics Report Initiates the process for the diagnostics report
for Performance Management.

Select one of the following report types:
 

• Performance Document

• Check-In

• Performance Management Security

8
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Process Name Description Parameters

Work Person Number: The worker person
numbers for whom the performance document
is applicable.
 

Purge Historic Performance Management
Eligibility Status Data

Initiates the job to delete historic performance
management related eligibility status data.

Purge Data Older Than Date: Purge any data
older than the specified date.

Reassign Performance Documents with
Terminated Managers

Initiates the process to reassign current
performance documents when the
performance document manager is terminated,
 to the new line manager or the terminated
managers line manager depending on
configuration.

Action:
 

• Preview: select to preview the changes
before submitting.

• Update: select to submit the changes.

Select the Manager type to reassign the
documents using these options:
 

• Employee’s line manager

• Terminated manager’s manager

Review Periods: Specify whether performance
documents in specific review periods or all
review periods should be processed.
 

Send Performance Document Alert
Notifications

Sends a standard or critical notification alert
when a task in a performance document is due
to be completed according to the due date. No
parameters, submit the process.

No parameters, submit the process.

Synchronize Goal Data in Performance
Documents

Synchronizes goal data in performance
documents with the goal data in Goal
Management and Career Development.

Action:
 

• Preview: select to preview the changes
before submitting.

• Update: select to submit the changes.

Review Period: Use the review period to
help filter and find the goal plans you want to
process.
 
Goal Plans: Select the goal plans from which
data needs to be synchronized to performance
documents.
 

Synchronize Person Profile Competencies in
Performance Documents

Synchronizes competencies in performance
documents with the person profile
competencies in Profile Management.

Run this process to bring competencies that
haven’t been brought into the performance
documents automatically using the person
profile competency in a performance template.
 
Action:
 

• Preview: select to preview the changes
before submitting.

• Update: select to submit the changes.

Review Period: Use the review period to
help filter and find the goal plans you want to
process.
 

9
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Process Name Description Parameters

Performance Document Name: Select the
performance document in which competencies
need to be synchronized.
 
Worker Person Number: Specify the person
numbers of the workers to whom the
performance document is applicable.
 

Transfer Performance Documents with
Manager Change

Initiates the process to transfer current
performance documents from a manager for
an employee's assignment to the replacement
manager.

No parameters, submit the process.

Related Topics
• What are scheduled processes?

10
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2  Overview and Integrations

Overview of Define Worker Performance  
Use the Define Worker Performance activity to define and maintain the elements used to create performance document
templates. Application implementors and human resource (HR) specialists can use these templates to create the
performance documents used to rate workers.

To create and manage performance documents, the performance management business activity requires that workers
have a manager record.

For both setup and maintenance tasks, implementors and HR specialists can:

• Create document types, sections, process flows, and roles to use in performance document templates.

• Create performance document templates to define the structure and task flow of performance documents.

• Create default content and target ratings within performance templates and sections.

• Create and edit rating distributions to set the target percentages for worker overall performance ratings for
each rating level.

• Create and edit box labels for the Performance and Potential matrix.

• Manage talent eligibility profiles and eligibility batch processes to specify eligibility for performance documents.

• Manage settings for email notifications that the application sends to workers and managers to remind them of
upcoming events and tasks.

For setup tasks only, they can also:

• Configure profile options to specify the:

◦ Default rating model for Oracle Fusion Performance Management analytics and HR comparisons

◦ Number of years in the past and the future for which to display performance documents to managers
and workers based on the document end date

◦ Autosave interval to specify the number of minutes before the performance document saves
automatically

• Manage descriptive flexfields to add company-defined attributes to entities, and define validation and display
properties for them.

• Manage performance value sets for descriptive flexfields.

• Manage performance lookups, the lists of values that appear in Performance Management pages.

Use the Setup and Maintenance work area to access the tasks in the Define Worker Performance task list. You can also
use the Performance Management work area to access the maintenance tasks.

Related Topics
• Options for Performance Process Flow Setup

• Considerations for Creating Performance Template Sections

• Guidelines for Setting Up Performance Templates

11
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How Performance Document Components Work
Together  
To create a performance document you need a performance template. The performance template contains a document
type, template sections, and a process flow. Create these either when creating the performance template or select
previously-configured ones.

Document Types
Document types categorize the types of performance documents that are valid for an organization, such as annual
evaluation or semiannual evaluations, a project evaluation, and so on. You set the dates to determine the time period
that a document type is valid.

Performance Template Sections
A performance document can have several sections, such as a Summary and Evaluation Topics. The sections support
the process flow used by the template.

In the sections you configure the types of content that can be rated and the processing options for ratings. You also
determine the sources of content, and how the performance documents integrate with:

• Profiles from the profile management business process

• Performance goals from the goal management business process

• Development goals from the career development business process

Sections can also contain options for managers and workers to provide final feedback about the evaluation.

Process Flows for the Evaluation Process
Create process flows to determine which tasks workers, managers, and participants perform as part of the evaluation
process. For example, you can include tasks to set goals, let managers and participants evaluate workers, and workers
evaluate themselves. You can create as many process flows as required to correspond to the different evaluation
requirements of your enterprise.

The process flow dictates which sections are required for the performance template. For example, if the process flow
includes the task for managers to rate workers, you must set up Profile Content, Performance Goals, or Development
Goals sections where managers can rate workers on competencies or goals, or an Overall Summary section where
managers provide an overall rating.

Performance Templates
Performance templates bring together the information used to create performance documents. In the performance
template, you:

• Select the roles that can access the performance documents created from the template.

• Select existing eligibility profiles to restrict the performance documents to qualified workers.

• Specify the processing rules for the document.

12
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• Enter the periods for which the performance documents are valid.

• Select the document type, sections, and process flows to use, and any additional content on which to rate
workers. You can edit sections as required in the template.

Related Topics
• Examples of Performance Process Flows

• Considerations for Creating Performance Template Sections

• Guidelines for Setting Up Performance Templates

• Overview of Performance Documents

How Performance Documents Work with Profiles  
During a performance evaluation, the line manager or worker can evaluate the competencies in a performance
document. When the performance document is complete the worker's person profile updates to reflect competency
proficiency levels in the performance document.

This figure illustrates the sources of competencies for the performance document, and how profiles update from the
performance document.

13
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Related Topics
• Guidelines for Setting Up Performance Templates

How Competencies are Populated in Performance Documents  
Let’s look at how competencies are populated in a performance document.

Performance documents can include competencies from these sources:

• Content library

• Model profile that the employee matches

• Talent profile

• Any other specified profile

Content Library Competencies
The competencies in the content library apply to model profile competency sections. These competencies are
populated based on the job, position, or organization profile. Workers and managers can also add a specific competency
for an employee from the content library in the performance document.

Model Profile Competencies
If new competencies are added to a model profile you can update the performance document to bring the latest
changes in. You can use the update competencies action to update competencies in the performance document.

However, if you remove competencies from a model profile after a performance document is created, then you need
to manually remove them from the performance document. If weights and minimum weights are enabled in the
performance document, these default in the performance document with competencies populated from a model profile.
Changes to the weights in a model profile won’t update the weights that already exist in the performance document.

Talent Profile Competencies
Competency sections in a performance document that are populated from the employees talent profile are
automatically synchronized. This means if new competencies are added or removed from the employee’s talent profile
they are also added or removed in the performance document. Competencies are only removed if they haven't been
evaluated.

Target proficiency is populated with the model profile competencies (using the minimum proficiency) and can’t be
updated in the performance document. Use Minimum Proficiency in the model or talent profile to define the target
proficiency in the performance document.

After you’ve added the competency to the performance document, the target proficiency isn’t updated, and can’t be
edited.

If there are common competencies defined and added to a performance template for all employees at the organization
level then when you create a performance document, the performance document can inherit those competencies from
the performance template.

Competency evaluation topics are automatically populated with competencies from a model or person profile.
Competency sections are either updated from the model profiles that they’re associated with or from the employee’s
talent profile.
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How Duplicate Competencies are Removed  
When you create or update a performance document, duplicate competencies are prevented from being added to the
document.

Here’s how duplicates are eliminated when you create a performance document with competency sections:

• Any competencies added to a section in the performance template will populate the performance document
first.

• If both model profile and person profile competency sections exist, competencies in matching model profiles
(such as job, position, or organization) that haven’t already been added from the performance template section
are added.

• Finally, all competencies that exist in the employee’s matching person profile that haven’t already been added
from the performance template or model profiles are added. This process avoids having to manually remove
duplicate competencies.

You can’t manually add a duplicate competency if it already exists in a worker’s performance document. If a duplicate
competency is added to an employee’s person profile, it won’t be duplicated in their performance document.

Considerations for Adding or Removing Competencies in Talent
Profile Competency Sections  
Here are some things to consider when adding or removing competencies in talent profile competency sections.

• Competencies added by managers or employees to the performance document are added to the employee's
talent profile with the evaluator type configured in the performance template.

• Talent profile approvals aren’t triggered when adding or removing a competency directly in a performance
document person profile competency section. If you use approvals in talent profiles and don’t want these to be
bypassed in the performance document, you can use personalization to hide the add and remove buttons in
the performance document.

• Any changes made to competencies in a person profile competency section in a performance document
will update any other in-progress performance documents with person profile competency sections where
the set goals or evaluation tasks aren't complete. For example, if a new competency is added in a midyear
performance document, that competency is displayed in the employee’s talent profile and added to the end of
year performance document, if created.

• Only competencies added directly in performance documents can be deleted. Competencies in an employee's
talent profile that have come from another source, can’t be removed in performance documents, and must be
removed from the original source.

• Competencies deleted by employees won’t be removed from other in-progress performance documents if
they’ve already been evaluated by the manager.

16



Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 2
Overview and Integrations

Synchronize Person Profile Competencies in Performance
Documents  
If competencies in an employee’s Talent person profile are missing from their performance document, you can run the
Synchronize Person Profile Competencies in Performance Documents process to identify missing competencies and
add them to employee's performance documents.

When HR specialists run the Synchronize Person Profile Competencies in Performance Documents ESS process to add
missing competencies to the employee performance document, it’ll exclude adding duplicate competencies that already
exist in other competency sections in the performance document. Performance documents are updated only if the Set
Goals task and other evaluation tasks are incomplete.

• Adds only competencies from the worker's talent profile that are missing from competency sections in the
performance document populated using the person profile. Competency sections populated using a job,
organization, or position profile aren't impacted.

• Processes in progress performance documents where the Set Goals and evaluation tasks are incomplete.

• Completed and Canceled performance documents aren't processed.

• Recommended to schedule the process to run once a day to keep performance documents up to date.

If an employee performance document has multiple competency sections populated using different model profiles
which both contain the same competency (for example, organization and job), then these duplicates will populate
the performance document. Ensure your model profiles do not contain duplicate competencies to avoid these from
populating performance documents.

Update Performance Document Model Profile Competency
Sections  
You can run the Update Performance Document Model Profile Competency Sections process to update competency
sections in performance documents populated using a model profile.

You can run the process to add any new competencies that were added to job, position, or organization profiles to
performance documents that use those profiles.

The process only updates in-progress performance documents. In-progress performance documents indicate when any
of the evaluation tasks; worker self-evaluation, manager evaluation, and manage participant feedback are incomplete.

Also, the process adds only new competencies to performance documents. If performance documents include
competencies that are no longer relevant, then you need to manually remove them. Competencies that are end dated in
Profiles aren’t automatically removed from performance documents.

Update Talent Profiles  
When the performance document is complete, the application updates the worker's profile to include the changes made
in the performance document, if the performance document is configured to do so.
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Here's what's included in the updated content:

• Overall rating

• Competencies and their proficiency levels provided by the manager

• Competencies and goal section ratings

The ratings provided by the worker are included when the section in the performance document is populated using
the employee's person profile competencies from their Talent profile. After the performance document is complete, it
becomes a static document, and any changes to the job competencies aren't reflected in the performance document.

How Performance Documents Work with Performance
Goals  
This topic explains how Performance Management and Goal Management work together. You can include performance
goals in employees' performance documents. This will help you to review their performance and evaluate if they have
achieved the goals that were assigned to them.

The details of the performance goals that you see in a performance document is always synchronized with the goal
details that you see in Goal Management. How is this synchronization achieved? Review periods and the Performance
Goals section of a performance document are the components that help to integrate performance documents and
performance goals.

Review Periods
When you create a performance template, you select a review period for each document period. You also associate a
document type with the performance template.

When you create a goal plan, you select a review period and then associate performance document types with the goal
plan. Only goals from goal plans with the same review period and performance document type as the performance
template appear in a performance document when you create it based on the template.

Performance Goals Section
Use the Performance Goals section type in the performance template to create a section for performance goals. For
the Performance Goals section, you can use rating models to rate employees and use calculation rules to calculate an
overall goal section rating. Remember to enable ratings and comments so that managers, employees, and participants
can select a rating for the section and provide comments.

In the Performance Goals section, you can select these check boxes:

• Populate with Worker Performance Goals: To add goals from goal plans in Goal Management to the
performance document.

• Allow update goals action to update goal weights from goal management business process: To update
goals in performance documents with weights that are revised in Goal Management.

The image shows how the document type and review period helps to integrate performance documents with goal plans.
As you can see in the image, the same document type and review period are used in both the Standard Performance
Document Template performance document template and the FY2020 Goal Plan goal plan. When the Performance
Document 2020 document is created based on the Standard Performance Document Template document template, the
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Goal Management Goal 1 goal available in the FY 2020 Goal Plan goal plan is automatically included. You can see the
goals added in the Performance Document 2020 document in the FY 2020 Goal Plan goal plan.

Add Performance Goals to Performance Document
Add performance goals to performance documents in these ways:

• Employees and managers can add individual performance goals or library goals directly to a performance
document if the goal plan to which they add the goal allows employees or managers to add goals. Remember
that only goal plans that match the performance document configuration will be available for adding the goal.

Note:  If approvals are enabled, performance goals are included after the approval process is complete.

• Employees and managers can import performance goals from other performance documents of the employee.
Note that the ratings and evaluation comments aren't copied when you import goals.

• As you already know, you can associate goal plans in Goal Management with performance document types.
When you create any performance document based on an associated document type, the application adds the
goals in the goal plan to that performance document.
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Update Performance Goals in Performance Documents
Managers or employees can edit goals that already exist in the performance document in Goal Management. Here's
how the changes are updated in the performance documents that the goals are included in:

• When the manager or employee opens the performance document, all edits to performance goals except
weights appear in the performance document.

• Only when the manager or employee uses the Update Goals action in the performance document, goal edits
including weights appear in the document.

To populate the performance document with new performance goals from Goal Management, use the Update Goals
action.

When you edit goals in performance documents, the changes are updated in Goal Management when you save or
submit the performance document. But note that the updated weights aren't copied to Goal Management.

Goal ratings provided in performance document aren't available in Goal Management. Evaluation comments added
to performance documents don't show up in Goal Management. But you can see comments added to goals in Goal
Management in the associated performance documents.

Performance Goals in Completed Performance Document
When a performance document is completed, the performance goals in the document are updated in Goal
Management. After this you can't update the goals in the performance document. If the goals are updated in Goal
Management, the changes aren't copied to the performance document.

When you reopen a completed performance document, users can edit the performance goals included in the document.
You can see the goal changes in Goal Management.

Remove Performance Goals from Performance Documents
Only managers and employees can manually remove goals from performance documents. Note that you can't
delete goals that are included in a performance document in Goal Management. They need to be removed from the
performance documents first.

Related Topics
• Review Periods in Talent Management

• Overview of Performance Document Types

• Create a Performance Template

• Create a Performance Template Section for Performance Goals

Automate Synchronized Goals in Performance
Documents  
View consistent development and performance goal information in both Career Development and Performance
Management.
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When the HR specialist enables the synchronization of goals in performance documents, employees and managers
will see the same performance and development goals in performance documents as they do in goal management
and career development. The active performance goals in Goal Management and the active development goals in
Career Development display consistently in the performance document. Synchronized performance documents are
automatically updated with any new goals added through goal management and career development pages.

Some of the features include:

• Performance goal weights are synchronized between goal management and the performance document.

• The ability to set weights using 2 decimal places.

• Minimum weight isn't supported for synchronized goals.

• If you enable approvals for performance and development goals, then pending approvals display in the
performance document. If you make changes to goals through the performance document, then this triggers
goal approvals.

1. Enable the ORA_HRA_SYNCHRONIZED_GOALS profile option.
2. Create new evaluation types (if required) in the ORA_HRA_GOAL_PLAN_EVAL_TYPE lookup. For more information

on creating and editing lookups, see Overview of Lookups
Evaluation type is an attribute that matches a synchronized performance goal section in a performance template to a
goal plan.

3. Go to My Client Groups > Performance.
4. Select Performance Template Sections, and click Add.
5. In the Create Performance Template Section page, enter the section details and in the Section Processing region,

select Development Goals as the Section Type and select the Synchronized goals section check box.
6. Add another section in the Create Performance Template Section page, enter the section details and select

Performance Goals as the Section Type and then select the Synchronized goals section check box.
7. Go to My Client Groups > Performance.
8. Select Performance Templates, and click Add.
9. Create a performance template and ensure you select the Use synchronized goals sections check box in the

General tab.
10. In the Structure tab of the performance template, add the synchronized development goal section and the

synchronized performance goal section.
11. Select the Not ready to evaluate option if you want to give workers and managers the ability to mark goals and

competencies as not ready to evaluate.
12. Configure goal plans with the same evaluation type as the synchronized performance goal section in the

performance template.
a. After you enable the synchronized goals profile option, you can see the Evaluation Type field in the

definition of a goal plan. This also includes previously created goal plans, which means you can use them
with any new synchronized goal performance templates.

b. You can create performance documents based on the synchronized goal templates.
c. The application automatically updates the created performance documents with any goals added or

removed.
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How Performance Documents are Processed During
Legal Employer Changes  
Here’s what happens to performance documents during a local and global transfer and a mass legal employer change.

Flow Who performs this action and on
whom

What happens to performance
documents

Effective from date

Local and Global Transfer Both HR specialists and line
managers can perform this action
on one employee at a time.

There’s an option to transfer the
performance goals and documents
to the employee’s new assignment
created by the global transfer.
This transfers all the performance
documents for the employee
regardless of whether it’s a HR
specialist or a manager performing
the global transfer.
 
If the Transfer current
performance documents for
which I am the manager to
the new line manager setting
is enabled and a new manager
has been selected as part of the
global transfer and a manager
performs the global transfer, then
the performance documents are
transferred to the new assignment
and any performance documents
that the manager is responsible
for are also transferred to the new
manager.
 
For HR, the setting doesn’t apply
because they are unlikely to
be the performance document
manager for any of the employees’
performance documents.
 

Changes made on the system
date or in the past are processed
immediately. Changes dated for
the future will be processed on the
date of the global transfer.

Mass Legal Employer Change Only HR specialists can perform
this action on multiple employees
at the same time

The task copies only the
performance goals and documents
associated with the primary
assignment to the new assignment
created by the global transfer.
 

Mass legal employer changes
made on the system date or in the
past are processed immediately.
Changes dated for the future will
be processed using a scheduled
process created by the global
transfer. The Move Performance
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Flow Who performs this action and on
whom

What happens to performance
documents

Effective from date

Performance goals and documents
associated with any secondary
assignments won’t be moved
to the new assignment. You can
continue to edit, cancel, or delete
the performance documents as
needed.
 
The task doesn't change eligibility
profiles. If the eligibility profiles
used for performance goals
and documents include inactive
assignments, after the global
transfer, the inactive assignments
continue to be eligible for the same
performance goals and documents.
To prevent the same performance
goals and documents moved to the
new assignment being recreated
for the inactive assignments you
must update the eligibility profiles
to exclude inactive assignments.
 

Goals and Documents process
can’t be scheduled to run manually.
If the global transfer is canceled or
the date is changed, the scheduled
process will be canceled. The new
date will be processed depending
on the date.
 
The process is scheduled to
run on the effective date of the
global transfer. After the process
completes, the transferred workers
and their new managers can
view the performance goals and
documents that are moved to the
new assignment. The goals and
documents won’t be visible as part
of the old assignment.
 

Related Topics
• Mass Legal Employer Change

• Local and Global Transfer

How You Prevent Changes to Section Ratings During
Compensation Calibration  
You can prevent managers from changing the section ratings for employees when compensation calibration begins in
Oracle Workforce Compensation.

This requires the ORA_HRA_COMP_CALIBRATION_STATUS_ENABLED profile option to be enabled. When you enable
this profile option, this is what happens:

• If the task is Manager Evaluation and the calibration status in Compensation is either In Review or Complete,
managers see a message that conveys that the section ratings in the performance document are locked.
Managers can still adjust comments and item ratings in the performance document to align with the calibrated
ratings.
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• If the task is Share Performance Document and the calibration status in Compensation is set to In Review,
managers won’t be able to complete the share task. After the calibration status is set to Complete, managers
can continue to share their evaluation with the employee.

• Previous configuration options for locking the share task aren't available when this profile option is enabled:

◦ The Allow document sharing task to be locked for calibration configuration doesn’t display in
Performance process flows.

◦ The Lock Manager Share Task isn’t available for Document Periods in the performance template.

FAQs for Overview and Integrations  

How can I diagnose any issues with Oracle Fusion Performance
Management data?  
Run the Performance Management Integrity Validations test. In the global header of the Diagnostic Dashboard, select
Settings and Actions - Troubleshooting - Run Diagnostic Tests. The test generates a report identifying invalid rows,
which you can repair or remove.

The test validates that:

• Business groups are valid and exist.

• Foreign key attributes aren't null.

• Field level attributes match the business rules set up in Performance Management.

• Row counts on setup tables are greater than zero.

• Data in the setup tables matches the business rules set up in Performance Management.

• Data in the document tables matches the business rules set up for evaluations in performance documents.
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3  Personalization Using Transaction Design
Studio

Use Transaction Design Studio to Configure Field
Displays  
Use the Transaction Design Studio (TDS) to configure transactions and pages for responsive applications. TDS is
available within the HCM Experience Design Studio.

You can control the visibility of attributes that are displayed either as Delivered or Enabled, and the availability of fields
and sections of a transaction based on the user's role, person's business unit, or legal employer.

By default, the responsive pages display the often used attributes and hide the less often used attributes. Use Page
Composer to personalize the responsive pages and display the attributes and tabs delivered within the feature.

Here's how you start HCM Experience Design Studio:

1. Sign in to the application as Human Capital Management Application Administrator with Access HCM Page
Configurator (HRC_ACCESS_HCM_TRANSACTION_CONFIGURATOR_PRIV) privilege. This privilege provides
you access to TDS in HCM Experience Design Studio.

2. Enable a sandbox to compose data for configuring business objects. On the Home page, click the HCM
Experience Design Studio quick action under the My Client Groups tab.

3. Under Settings and Actions, click Edit Pages.
4. Select the site layer and click OK.

Related Topics
• Overview of Page Modification

How You Configure Performance Pages Using
Transaction Design Studio  
Use Transaction Design Studio (TDS) to create rules for configuring Performance pages. You can include or hide
fields as needed by your organization. Some fields aren't available to change and don't display in TDS because they're
controlled by configurations or available data.

For the Performance Document Action, you can set up a rule to apply to a specific performance document, giving you
an extra layer of control for each performance document your organization uses.

Actions
This table shows the actions that you can use to configure Performance pages and the page for which the action
applies.
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Action Page

Performance Document
 

Performance Document
 

Performance Management
 

Other Performance pages
 

Did you know that you can create multiple rules for an action?

You can select different regions in the Page Attributes section and set the visibility of the different attributes listed in the
UI.

Related Topics
• Use Transaction Design Studio to Configure Field Displays

Display Sort Options for Performance and Anytime
Documents  
You see the performance and anytime documents on the employee's spotlight page in an order determined by the sort
field.

The default is date, with the latest displaying first, to the oldest displaying last. You can change the default sort order to
any of these options:

• Date - Latest to Oldest (default)

• Date - Oldest to Latest

• Name - A to Z

• Name - Z to A

When you sort by name, use a naming convention for the performance documents that makes annual documents
appear at the top of the page. If the Sort By field isn't displaying to users, then you can make it visible using HCM
Experience Design Studio.

Before you start
Sign in to the application as Human Capital Management Application Administrator with Access HCM Page
Configurator (HRC_ACCESS_HCM_TRANSACTION_CONFIURATOR_PRIV) privilege. This privilege provides you access to
TDS in HCM Experience Design Studio.

Here's what to do

1. Enable a sandbox and then edit your page at the site level.
2. Go to My Client Groups > Quick Actions >  HCM Experience Design Studio.
3. From the Actions list, select Performance Management.
4. Click Add in the Rules section.
5. Enter the name and description in the Basic Details section. Select the Active check box to make the rule ready to

use.
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6. In the Page Attributes section, select Performance and Anytime Documents List.
7. Set the Sort By attribute to Visible.
8. Click Save and Close.
9. Go to the employee's performance spotlight page, and view the sort options.

FAQs for Personalization Using Transaction Design
Studio  

How can I provide more information to managers on the Evaluate
Performance page?  
You can display an information banner on the Evaluate Performance search page to help managers use the necessary
filters to view the performance documents they want to manage.

The banner conveys this information:

By selecting the All Evaluatees filter, managers can see surrogate performance documents when they're not the
managers on an employee's assignment. They can also use the Business Title option that appears on the top of the
Evaluate Performance page to see other performance documents they manage under other assignments.

Note:  The Business Title option appears only if a manager has multiple assignments.

You can personalize the banner text using the User Interface Text tool.

To display this information banner, follow these steps:

1. Enable a sandbox and then edit your pages at the Site level.
2. Go to My Client Groups > Quick Actions > HCM Experience Design Studio.
3. From the Action list, select Performance Management.
4. Click Add in the Rules section.
5. Enter the name and description in the Basic Details section. Select the Active check box to make the rule ready

for use.
6. In the Page Attributes section, select Evaluate Performance from the Region list.
7. Set the Page Information Banner attribute to Visible.
8. Click Save and Close.

When you go to My Team > Performance, you can view the banner.

Related Topics
• Overview of Page Personalization Tools
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How can I display additional participant categories when
managing participant feedback for a performance document?  
Enable managers and HR specialists to select participants when managing participant feedback.

They can select from these categories:

• Worker's peers

• Worker's matrix managers

• Worker's directs reports

• Suggested list of participants based on who they selected previously

To do so, configure the Add Participants page under Manage Participant Feedback.

1. Enable a sandbox and then edit your pages at the site level.
2. Go to My Client Groups > Quick Actions > HCM Experience Design Studio.
3. From the Action list, select Performance Document.
4. In the Rules section, click Add.
5. In the Basic Details section, enter a name and description for the rule.
6. Select the Active check box to make the rule ready for use.
7. Select the performance documents to which the rule applies.
8. Select Add Participants from the Region list.
9. Set the following attributes to Visible:

◦ Suggestions

◦ Peers

◦ Direct Reports

◦ Matrix Managers

10. Click Save and Close.

Can I display notes and additional information when evaluating
goals?  
You can use Transaction Design Studio to display or hide additional attributes for a goal in the Evaluate pages. You can
display the category, success criteria and comments for both performance and development goals.

You can also choose to display notes for both performance and development goals in the Show Additional Info region in
the Evaluate pages.
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4  Questionnaires

Questionnaires  
You can create questionnaires to gather information in applications that support them. For example, you can use
questionnaires to collect feedback in a performance evaluation.

A questionnaire consists of several questions, and you create questionnaires based on questionnaire templates. You can
create questions using the question library and then add the questions to questionnaire templates and questionnaires.
This topic describes aspects of questionnaire creation and maintenance.

You create and update questions, questionnaire templates, and questionnaires from the Setup and Maintenance work
area.

To access this work area, click the arrow next to your photo on the global header, open the Settings and Actions menu,
and select Setup and Maintenance.

Next, select Workforce Development from the Setup list, and select Questionnaires from the Functional Areas list.

Using these tasks, you can configure each of these sections:

• Question Library

• Questionnaire Templates

• Questionnaires

Subscriber Applications
Applications which are eligible to use questionnaires are called subscriber applications. In addition to Oracle
Performance Management, other subscriber applications include Oracle Learning, Oracle Time and Labor, Oracle
Recruiting, and many more. You must select the subscriber application for each questionnaire. When you select the
subscriber on the Questionnaires page, you can create questionnaires for the selected subscriber only. In addition, the
subscriber filters your search results to display only questionnaires created for that subscriber.

Note:  Some subscriber applications use Setup and Maintenance tasks to manage questionnaire components
while others provide their own tasks or don't allow modification of questionnaires. See the documentation for the
subscriber applications for more information.

Folders
You maintain folders to store questionnaires. For each subscriber application, you can create as many folders as
required to differentiate or identify the questionnaires.

Questionnaire Templates
All questionnaires are based on templates, which promote consistency. When creating a questionnaire, you must
select a template on which to base the questionnaire. The template can provide default settings or enforce mandatory
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requirements such as specific sections and questions that must be in all questionnaires created using the template. You
can configure templates for:

• Specific applications

• General audiences, such as an entire organization or all internal customers

• Targeted audiences, such as particular roles (managers, for example)

• Specific purposes, such as providing feedback for performance evaluation periods or rate worker potential in an
assessment for a talent review

You can create questionnaires only from templates that were created for the same subscriber as the questionnaire.

Questionnaire Presentation
You can specify how the questionnaire appears in the subscriber application. For example, you can:

• Add sections to group questions by type or other classification.

• Define the question order to appear in the sequence defined or in random order in a section.

• Mark questions as required.

When a section is defined for Random question order, you can specify the sample size that isn't less than the required
number of questions and more than the number of questions in the section.

Note:  Conditional questions aren't included in the random sample questions.

Questionnaire and Question Scoring
For subscriber applications that support scoring, you can configure questions that score the responses provided by
respondents. You can configure questionnaires to calculate the cumulative total of responses (Sum), the average score,
or the percentage based on the maximum available score.

Tip:  You can define a high score for a question that can be more than 3 digits. This facilitates to have higher number
of questions with each of these questions having higher scores in a questionnaire. Thus, the high score can result into
an overall high score too.

You can define the score for question answers directly in each questionnaire. For questions that are reused across
multiple questionnaires, you can define a different score for the question in each questionnaire. If you don't change the
question score in the questionnaire, the default score from the question is used.

Questionnaire and Template Access
You can control access to questionnaires and templates by setting privacy options. If you set the Privacy option to
Private, only the named owner can edit the questionnaire or template. Otherwise, anyone with access can edit the
questionnaire or template.
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How You Create Questions  
When creating a question, you specify the question type, additional instructions about the question, images and
attachments, if any, response type for the question, scoring options, and more.

You create questions in the question library. To create, review, or edit questions, select these in the Setup and
Maintenance work area:

• Setup: Workforce Development

• Functional Area: Questionnaires

• Task: Question Library

Follow these steps to create a question, for example:

1. After selecting the options mentioned above, select the subscriber from the Questions page.
2. Click the Create icon. The Create Questions page appears.
3. Select the folder, status, and privacy options, as required. The Question Code and Question Version Number are

generated automatically.
4. In the Question Text field, type the question that you want to ask. For example, “How many states are there in

the US?”
5. In the Image field, click the Manage Attachments icon to add an accompanying image to the question. For

example, if your question reads, "What does this sign mean?", add the image of a sign in this field.
6. In the Instructions text box, include additional information or provide additional context about the question.

You can format the information that you add by using the toolbar. You can also add an URL using the Add Link
icon on the toolbar.

Note:  The URL that you add here will open in the same window as the questionnaire. You may want to add a
note in the Instructions text box to let the respondents know that they must open the URL in a new window
to avoid losing any unsaved changes.

7. Select the question type. Options are Text, Single Choice, Multiple Choice, and No Response.
8. Select the Display the question conditionally check box if you want to display the question based on a specific

response that’s provided to another question called the controlling question. For example, if respondents
answer “No” to a controlling question such as, “Are you happy with the learning module?”, you can configure a
text question to appear conditionally, asking them to provide more details. For more information, refer to the
Conditional Questions section in this topic.

9. For Single-Choice and Multiple-Choice question types, you can provide scoring options by selecting the Score
Question check box.

For more information, refer to the Response Scoring section in this topic.
10. Select the type of response that a respondent must provide to the question. Each question type has a list of

response types that you can choose from.
11. To allow respondents to upload attachments with their responses, select the Allow Attachments check box.

For example, you have the question, "Provide proof of the right to work in this country". The respondent can
upload an attachment to show proof of the right to work.

Note:  Respondents can add attachments for all types of questions, including No Response questions.

12. Select the Allow Additional Comments check box, if you’d like respondents to provide additional comments or
reasons for their responses. This option is available only for Date responses of the Text question type and for
all responses of the Single Choice and Multiple Choice question types.
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Note:  When you create a new version of a question or copy a question that has additional comments
enabled, this option is available in the new question as well. However, it’s not available for existing questions
that are already published. This option may not be available in certain run-time and setup pages in Oracle
Recruiting, Oracle Health and Safety Incidents, Wellness, and Journeys.

13. In the Minimum Length and Maximum Length fields, specify the length of text responses, or the start and
end dates of date responses.

14. Click Save and Close.

Question Types
Four types of questions are available in the Question Type list:

• Text

• Single choice

• Multiple choice

• No response

For each question type, you also configure responses and select a presentation method. For example, for single-choice
questions, you can specify that the possible responses appear either in a list or as radio buttons.

This table describes the types of questions and their response types.

Type Description Sample Question Response Type Sample Response Notes

Text
 

Respondents can
either enter free-form
text as the answer to
the question, or they
can enter a date using
a date picker.
 

How can we improve
this class?
 

• Date

• Plain Text Box

• Rich Text Box

The class is too long
and should be broken
into 2 half-day classes.
 

For text responses,
 you can specify
the minimum and
maximum number of
characters. You can
also allow rich text that
uses formatting, such
as bold and underline.
 
For date responses,
 you can set the
minimum or
maximum dates, or
both. Respondents
must choose a date
on or before the
maximum date and on
or after the minimum
date. For example,
 if respondents have
to enter their date
of joining between
12/01/2021 and
12/31/2021, set these
as the minimum and
maximum dates.
 

Single Choice
 

Respondent chooses
only one correct
answer.
 

Is Performance
Management a
subscriber application
for questionnaires?
 

• Single Choice
from List

• Radio Button List

Yes
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Type Description Sample Question Response Type Sample Response Notes

• Radio Button
with Image

• Single Choice
– Horizontal
Buttons
(applicable only
for Touchpoints
and Journeys
Surveys
subscribers)

Multiple Choice
 

Respondent can
choose more than one
answer.
 

Which applications are
subscriber applications
for questionnaires?
 

• Check Multiple
Choices

• Check Box with
Image

• Multiple Choices
from List

• Multiple Choice
– Horizontal
Buttons
(applicable only
for Touchpoints
and Journeys
Surveys
subscribers)

Oracle Performance
Management, Oracle
Learning, Oracle
Health and Safety,
 Oracle Recruiting
 

No Response
 

Instructional text
only; no response is
allowed.
 

Attach any supporting
documentation that
relates to this person's
performance for this
period.
 

Subscriber Applications
Subscriber applications are applications that can use questionnaires, for example, Oracle Performance Management.
When creating a question, you must select a subscriber application for the question and a folder in which to include
it. You can create folders for each subscriber application to store questions for the subscriber. For example, folders for
Oracle Recruiting might be named for locations, where the organization has offices, such as San Francisco, Austin, Los
Angeles, Tokyo, Bangalore, and Shanghai. A question is only available to questionnaires with the same subscriber.

Conditional Questions
When you select the Display the question conditionally check box, you need to specify the controlling question code
and response. When the respondent answers the controlling question with the controlling response, the conditional
question appears.

For example, for a controlling question such as, Did you receive assistance with this form?, if the controlling response
is Yes, then you can display the conditional question, Which type of assistance did you receive?

Note:  Add both the conditional question and the controlling question to the same section of the questionnaire.
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You can also add response feedback visible to respondents to display a targeted message to their response, if the
subscribing application uses response feedback.

Tip:  You can assign your own response codes to the responses that you create in choice-based questions. The
application provides the response code by default. But you can remove the response code and enter a code of your
choice so that it's meaningful and helpful in organizing your setup.  If you enter a response code, please note the code
must be unique for the entire set of responses across all questions and not just for a specific question. For example,
you can only have one response code, “Yes” across all your questions.

Single-Choice and Multiple-Choice Questions
For single-choice questions, respondents select one response from several. You specify whether the responses appear
in a list or as radio buttons. An example of a single-choice question is, "Have you completed a similar class?" Only one
response for the options is expected, Yes or No.

You can select a rating model to quickly provide consistent responses. When you select a rating model, the rating levels
appear as responses. For example, you create the questions "How do you rate your performance in this performance
period?" and you associate the Performance Rating Model, which has 5 rating levels defined as Outstanding, Exceeds
Expectations, Meets Expectations, Inconsistent, and Unsatisfactory. These 5 rating levels are automatically added as
the response choices for the questions. You can add, remove, or edit the responses. If you change the rating model, for
example, to the Language Rating Model, which has 3 ratings (High, Moderate, Low), the response choices will change,
but the text for the question stays the same unless you edit it.

You can add feedback to display messages to users reviewing a completed questionnaire if the subscribing application
has enabled this feature. The response feedback appears when the respondent submits the questionnaire.

When you configure a single-choice question as a radio button and specify that it isn't required, the No opinion
response appears automatically as a response. This option allows respondents to change their responses to no opinion
if they already selected a response that they can't deselect.

For multiple-choice questions, respondents can provide one or more answers. Specify whether the responses are
presented as check boxes or a choice list. You can set both a minimum and maximum number of required responses.
As with single-choice questions, you can associate a rating model with the response type. You can add responses
to multiple-choice questions, as with single-choice questions. An example of a multiple-choice question is "Indicate
which of the following grades you have taught. Select all that apply." A respondent can check grade levels, such as
Kindergarten, first, second, third and so on.

Tip:  You can assign your own response codes to the responses that you create in choice-based questions, single-
choice or multiple-choice. You can assign meaningful identifiers to the questions by using your own question codes. If
you don't want to, you can use the application-generated codes.

For choice-based question responses, you can add images when defining the response. To do this, enable one of these
options in the Allow Response Types section of the questionnaire template:

• Check box with image

• Radio button with image

Outside the questionnaire, when defining an independent question, you can add an image to any type of question. For
responses to choice-based questions, ensure that you select one of these options for Response Type.

• Check box with image
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• Radio button with image

Response Scoring
You can configure single- and multiple-choice questions to be scored. To score the responses, you can either set them
up to use user-defined scoring or select a rating model to use the predefined numeric rating. Responses using rating
models are only scored when the question is configured for scoring. The application uses the score from the responses
to calculate the score of questionnaires that are configured to be scored. With the rating models, you can edit the short
description and the score.

Note:  For the Touchpoints subscriber, scoring is enabled by default as pulse scores can be computed and displayed
as graphs in Oracle Touchpoints only if it's enabled.

Editing a Question
When you edit a question, you can either create a new version or update it. You can see the version number when you
edit a question. However, the version number is incremented only when you create a new version of the question and
not when you update an existing version.

When you create a new version of the question, it won't be automatically included in a questionnaire that's in use
and referencing an older version of the question. To include the new version, you need to create a new version of the
questionnaire and add the question.

Randomized Questions and Answers
Just as questions can be randomized in a questionnaire section, the answer choices can be randomized. Randomized
questions and answers help prevent users from copying answers from others or memorizing questions and answers to
share with others.

You can have two kinds of randomization:

• Position Randomization - This refers to the sequence of response choices for a given question. If 5 choices are
available (a, b, c, d, e), the order in which these are shown to the respondent is randomized. For example, the
choices can appear in the order e, d, c, b, a for one respondent. For another respondent, the choices can appear
in the order a, c, b, e, d.

• Selection Randomization - This refers to randomizing the response choices shown to the respondent from an
available list of choices. For example, you set up a question that has a sample of 10 answer choices. You can
show 5 random choices from the list of 10. The correct answer or answers are always included in the selection
shown to the respondent.

You can set up single- and multiple-choice responses in random response order.

In addition to randomization in questions and answers, you can randomize the order of sections in a questionnaire.

Put Your Sections, Questions, and Answers in Random Order (Position
Randomization)
This shows how to put sections and questions in random order. Optionally you can also put answers in random order.

1. Go to the Settings and Actions menu.
2. In the Administration area, select Setup and Maintenance.
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3. From Setup, select Workforce Development > Questionnaires.
4. Search for or create a questionnaire. Note that you can't edit a questionnaire if it's in Active status.
5. Select the Subscriber, for example, Performance 360.
6. If needed, edit the Basic information and click Next.
7. For the Section Order, select Random.
8. In the Sections area, under the Question Order column, select Random.

Note:   You can achieve position randomization for answers when you select Random for the Response Order in the
Sections area.

Put Your Answers in Random Order (Position Randomization)
This shows how to make the answers for a single question appear in random order.

1. Go to the Settings and Actions menu.
2. In the Administration area, select Setup and Maintenance.
3. From Setup, select Workforce Development > Questionnaires.
4. On the right side of the page, click Question Library.
5. Select the Subscriber, for example, Performance 360. If you have multiple libraries, select a specific library.
6. Search for or create a question. Note that you can't edit a question if it's in Active status.
7. In the Response area, select Random for the Response Order .
8. Enter a Sample Size that matches the number of answer choices that you define for the question. Sample size

determines the number of answer choices shown to the respondent.
9. Enter the possible answers in the table by clicking the Add icon. Make sure that you enter the correct answers in

the table and indicate they're correct by selecting Yes in the Correct Response column.

When the sample size matches, position randomization is enabled.

Create a Question with Randomized Answers (Selection Randomization)
This shows how to enable a higher level of randomization by randomizing the answer choices shown for a question.

1. Go to the Settings and Actions menu.
2. In the Administration area, select Setup and Maintenance.
3. From Setup, select Workforce Development > Questionnaires.
4. On the right size of the page, click Question Library.
5. Select the Subscriber, for example, Performance 360. If you have multiple libraries, select the library.
6. Search for or create a question. Note that you can't edit a question if it's in Active status.
7. For the Question Type, select Multiple Choice or Single Choice.
8. For the Response order, select Random.
9. Enter the Sample Size for the answers. Sample size determines the number of answer choices shown to the

respondent.
10. Enter a number in the Minimum Number of Selections, for example, 1. The minimum number of selections

determines how many choices the respondent must select at the minimum.
11. Enter a number in the Maximum Number of Selections, for example, 2. The maximum number of selections

determines the number of correct responses that will be shown to the respondent in the choices presented.
12. Enter the possible answers in the table by clicking the Add icon. Make sure that you enter the correct answers in

the table and indicate they're correct by selecting Yes in the Correct Response column.

Example of a Question with Randomized Answers
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Question Details Notes Sample Information

Question text
 

Which of these countries is in Asia?
 

Question type
 

Multiple Choice
 

Response order
 

Random
 

Sample size
 

Number of choices shown to the respondent
 

6
 

Minimum number of selections
 

Number of choices the respondent must select
 

1
 

Maximum number of selections
 

Number of correct responses that will be shown
to the respondent
 

2
 

Number of correct answers
 

2
 

In the answer table, you enter the responses and indicate which are the correct ones.

Short Description Correct Response

India
 

Yes
 

South Korea
 

Yes
 

France
 

No
 

Columbia
 

No
 

Zimbabwe
 

No
 

Lebanon
 

No
 

Canada
 

No
 

New Zealand
 

No
 

Ethiopia
 

No
 

Greenland
 

No
 

Because you set the sample size as 6, the respondent will see 6 possible answers.
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Which of these countries is in Asia?

1. France
2. South Korea
3. Zimbabwe
4. India
5. Greenland
6. Ethiopia

Because you set up selection randomization, another respondent might see the question with different responses, such
as:

Which of these countries is in Asia?

1. Lebanon
2. India
3. New Zealand
4. France
5. Columbia
6. South Korea

How You Configure Questionnaire Templates  
This topic describes how questionnaire template options determine the features of questionnaires. After creating a
questionnaire from a template, you can override or change some of these options in the questionnaire.

To create a questionnaire, go to the Setup and Maintenance work area, and select these options:

• Setup: Workforce Development

• Functional Area: Questionnaires

• Task: Questionnaire Templates

Click Create in the Questionnaire Templates page that appears.

Questionnaire Scoring and Calculation Rules
You can select Score Questionnaire to configure the questionnaire to calculate scores based on responses.
Questionnaires made from the template can then be scored. However, it's not always necessary that a questionnaire
created from a scored template has to be scored. To score a questionnaire, you must also select the overall score
calculation rule that specifies the formula used to calculate scores.

Note:  Scoring only applies to subscriber applications that allow scoring. For the Touchpoints subscriber, scoring is
enabled by default as pulse scores need to be computed and displayed as graphs in Oracle Touchpoints.

If you edit the template and deselect Score Questionnaire, existing questionnaires created from the template aren't
affected. Only questionnaires created in the future from the template aren't scored.

Section Presentation and Order
A questionnaire has at least one section. You can use sections to group questions by type or category, for example.
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The Section Presentation option controls how the questionnaire uses sections. This table describes the Section
Presentation values.

Value Description

No Sections
 

One section appears that contains all questions.
 

Stack Regions
 

Multiple sections appear as specified on the Section Order option.
 

The Section Order option controls section order. This table describes the Section Order values.

Value Description

Sequential
 

One section appears that contains all questions.
 

Random
 

Each respondent views the sections in a different order. Reviewers view the sections in sequential
order to provide consistency when reviewing responses.
 

You can specify whether questionnaires based on this template can override these values.

Allowed Response Types
The Allowed Response Types controls the types of questions that are included in a questionnaire template. However,
this doesn't limit users from adding questions with other response types to a questionnaire created from this template.

Sections
The Allow Additional Questions option controls whether authorized users can add questions in the subscriber
application. For example, for performance documents, that could be managers or workers.

If you select the Required option, then respondents must answer all questions in the section.

Question and Response Order
The Question Order and Response Order values control the order that questions and possible responses appear
to a respondent. Response order only applies to single-choice and multiple-choice questions, which contain a list of
responses.

This table describes the Question Order and Response Order values.

Value Description

Vertical
 

Questions appear in the specified order.
 

Random
 

Each respondent views the questions in a different order. Reviewers view the questions in sequential
order to provide consistency when reviewing responses.
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You can override the default values of these options for individual sections. You can also specify whether questionnaires
based on this template can override these values.

Questions and Responses in Sections
In the Questions section, you manage questions for a selected section. You can:

• Add questions from the question library. You can change the response type for these questions after adding
them to the template.

• Create questions, either those that are scored, or aren't. Questions you create become part of the question
library. You must also add the question to the section after creating it from the section.

• Edit questions. Your edits are also reflected in the question library.

• Remove questions.

• Change question order by dragging them in the section. Questions appear in this order in the questionnaire if
question order is Vertical for the section

If the section itself isn't required, then you can mark individual questions as required. Otherwise, respondents must
answer all questions.

Note:  You can't change the response type to Plain Text or Rich Text for questions that were originally created to
accept date responses. Similarly, you can't change the response type to Date for questions that were originally created
to accept text responses.

Review
As the final step, you can review the sections, questions, responses, response feedback, and test scoring, before saving
the questionnaire template.

Note:  Once a questionnaire is created from a template, you can’t delete the template. But you can inactivate the
template.

How You Create a Questionnaire  
This topic explains how to create a questionnaire for incidents by selecting a questionnaire template and specifying
relevant information in the questionnaire. It also lists the points to consider while editing a questionnaire. Note that for
inspections, you can also create a basic questionnaire from the Inspection Items page. For more information, see the
Manage Inspection Items topic.

Select the Questionnaire Template
In the Setup and Maintenance work area, select these options:

• Setup: Workforce Development

• Functional Area: Questionnaires

• Task: Questionnaires

40



Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 4
Questionnaires

If you use Performance Management, you can also go to My Client Groups > Performance > Questionnaires.

1. In the Folders section of the Questionnaires page, select the subscriber application for the questionnaire, for
example Performance 360, Recruiting, or Learning Assessments.

2. In the Search Results section, click Create.
3. Enter Questionnaire Template ID or Name values, if available. Alternatively, click Search to list all available

templates.
4. In the Search Results section, select a template and click OK.

Enter Questionnaire Basic Information
1. A unique numeric questionnaire ID appears automatically. You can change this value.
2. If this is a scored questionnaire, an overall score calculation rule appears. You can select a different rule.
3. Enter a Name and select a Folder. Use folders to organize questionnaires by type or purpose.
4. Leave the Owner field blank and the Privacy value set to Public if anyone who can access the questionnaire

can edit it. Otherwise, select an owner and set Privacy to Private.
5. Leave the Status value set to Draft until the questionnaire is ready.
6. For the Touchpoints and Journey Surveys subscribers, select a pagination option from the Display Format list.

Note:  When you display one section per page, section instructions, if any, appear below the section title.
When you display all questions on a single page, questionnaire instructions and section instructions appear
below the respective titles.

7. In the Instructions and Help Materials section, enter and format any instructions for questionnaire users. This
text appears at the top of page one of the questionnaire.

8. Add file or URL attachments, if appropriate. Links appear at the top of the questionnaire and beneath any
instruction text.

9. Click Next.

Enter Questionnaire Contents
The Section Order and Section Presentation values are as specified in the questionnaire template, for example,
Sequential as the Section Order and Stack Regions as the Section Presentation. Depending on template settings,
you may be able to change these values. Depending on template settings, you can edit some or all section settings. You
can also delete predefined sections and create additional sections.

1. Select the first section to view its questions in the Questions section. You can delete a question or change its
response type and Required setting.

2. If you create additional sections, you add questions to them. In the Questions section, click Add. Search for
a question, select it, and click OK. The question is added below the question that appears highlighted in the
Questions section. You can reorder the questions by dragging them by the expandable arrow that appears in
the first column and dropping them in another row.

Note:  You can view the version number of the question in the Search Results section. If this column doesn't
appear, click the View menu and select Columns > Question Version Number.

3. You can also create questions for a section. Select a section, and in the Questions section, click Create.
4. Select the Folder, and enter question and response details, and click Save and Close. The question becomes

available in the question library as well. Add the question to the section using the instruction in step 2.
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5. Edit questions as required. Select a question and click Edit. Enter question and response details, and click Save
and Close. The question is updated in the questionnaire and the question library.

Note:  Although you can override the response types for questions while defining a questionnaire, you can't
change the response type to text for questions that accept date responses or change the response type to
date for questions that accept text responses.

6. When all sections and questions are complete, click Next.
7. Click Preview to preview the questionnaire. For scored questionnaires, click Test to verify the scoring.

Note:

◦ When you click Reset after testing, the previously filled responses are retained in the
questionnaire. This allows you to modify specific responses as per your needs and test the
behavior of the questionnaire again.

◦ The questions in a section are displayed in the order specified in the Section Order field.

◦ Questionnaire surveys that are created for both Touchpoints and Journey Surveys subscribers
are distributed to respondents using the Journeys application. So, when you preview the
questionnaire survey in ADF-based pages, the response options appear in a drop-down list.
However, when you view the survey in the Journeys application, you can see the horizontal
button responses and the question display format that you’ve chosen.

8. Click OK and then click Save.

Note:  If a questionnaire isn't in use, you can still add new questions that accept date response types, or create a new
version of the questionnaire to add such questions. When you edit the response type for a question in a questionnaire
that isn't in use, the updated response type is reflected in the questionnaire definition.

Editing a Questionnaire
To edit a questionnaire, go to the Questionnaires setup page, and select a questionnaire from the Search Results
section and click Edit.

A few points about editing a questionnaire:

Set the questionnaire Status value to Active when the questionnaire is ready for use.

If a questionnaire isn't in use, you can still add new questions that accept date response types, or create a new version
of the questionnaire to add such questions. When you edit the response type for a question in a questionnaire that isn't
in use, the updated response type is reflected in the questionnaire definition.

You no longer need to go into the edit mode to preview a questionnaire. You can preview it from the Search Results
section of the Questionnaires setup page. You can preview draft, active, and inactive questionnaires.

Related Topics
• What happens if I edit a questionnaire that's in use?
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Question Scoring Setup Options  
For eligible subscriber applications, you can configure questions to calculate a score based on responses. This topic
describes aspects of creating questions that can be used to score questionnaires.

Use the Question Library task in the Setup and Maintenance work area for this task.

Eligible Question Types
Two question types are eligible for scoring:

• Single choice

• Multiple choice

If you select single choice, the question score is the value of the selected response. For multiple-choice questions, the
total value of all selected responses is the question score.

Score Question
To score the question, select Score Question. Scored questionnaires use scored questions to determine the
questionnaire score. You set the default calculation rule in the template, but this can be overridden in the questionnaire.

If a question is in use, you can't change whether it's scored or not. To create a scored question, create a new question or
copy an existing question.

You can add scored questions to questionnaires that aren't scored. In questionnaires that aren't scored, response scores
aren't available.

Tip:  Use the Preview feature to ensure that the scoring works as you anticipated.

Minimum and Maximum Calculated Scores
For multiple-choice questions you can define either, or both, minimum and maximum calculated scores. These are the
maximum and minimum scores the question can attain, regardless of how many responses the respondent selects, or
the score of the responses.

You can define the maximum and minimum calculated scores to keep them within a range that aligns with your
business process. For example, you can set maximum and minimum scores to ensure that:

• Questions in a questionnaire have consistent maximum and minimum values

• Questions aren't weighted too heavily with either too high a positive or too low a negative score

If you don't define the maximum calculated score or maximum number of responses, the maximum possible score is
the sum of all responses. When you update the score of a question, the maximum possible score of the questionnaires
that include this question are automatically updated, provided they aren't in use. However, if you have the scores
overridden for these questions at the questionnaire level or if the questionnaire is in use, then these scores will remain
unaffected by your updates to the question score.
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Response Configuration
To provide responses for users to select, you must add responses. You can then specify additional configuration for the
responses.

Minimum and Maximum Number of Selections
For multiple-choice questions, you can optionally define the minimum and maximum number of selections that
respondents make to the question. If respondents don't select the specified number of responses, an error message
appears.

Short Description
When you add responses, you can define the score for the response. You must enter a short description, which appears
to respondents. You can enter any score for the response and as many responses as your business process requires.

The scores can be the same or varied. For example, you can have five responses with 5 as the score for each. Or, you
can have five responses with values of 1, 2, 3, 4, and 5.

Tip:  After adding responses, use the Preview feature in the questionnaire to ensure that the list of responses isn't to
long for respondents to view effectively.

Rating Model
You can select a rating model to provide a predefined short description and score. However, you can edit both the short
descriptions and scores.

Response Feedback
You can add feedback to display messages associated with the responses selected by the respondent. This feedback
may appear to the respondent or to a reviewer depending upon configuration in the subscribing application.

Preview
Use the Preview feature in the Questionnaire to review the questions and responses in the questionnaire. Select
answers and click Test to see the resulting score and any response feedback. Click Reset to clear the scores and test
again.

Related Topics
• How You Configure Questionnaires for Questionnaire Scoring
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How You Use Translation Editor with Questionnaires and
Questions  
You can translate questionnaire templates, questionnaires, and questions using the translation editor. With the
translation editor, you can review and translate text for more than one language at a time without signing out of your
current session.

For each translatable field, the translation editor helps to ensure your data is translated the way you intend. The
translations appear wherever the questionnaire templates, questionnaires and questions appear.

Eligible Languages
The languages that you can translate are those that are that are installed and active in the application. The translated
text appears in the application for the respective language a user selects when signing in.

Text that Can Be Translated
Using the translation editor, you can translate any text fields that you can edit in questionnaire templates,
questionnaires, or questions. For questionnaires and templates, you can translate:

• Name, description, and introduction

• Section title, description, and introduction

For questions, you can translate:

• Question text

• Question response short description

• Question response feedback

Translation Editor Usage
Click the Translation Editor icon to edit the translatable text in a questionnaire, questionnaire template, or question.
The icon appears on the pages and sections where the fields you can appear. In the Edit Translation dialog box that
appears, you can enter text for any available language for each field. The translated text appears in the application
for the respective language a user selects when signing in. For example, if you translate a question from English to
Spanish, a Spanish-speaking user sees the Spanish translation. If the translated text is in a language that's the same as
the language of your current session, you can see the translation apply to the UI immediately.

When you create a new questionnaire, template, or question, you must first save it before using the translation editor.
Once the object is saved to the database, the translation editor becomes available.

Translation Inheritance
Questionnaires inherit translations from the template. You can edit the translations to change them. Question
translations that you configure are also inherited by that question if it's used later in another questionnaire or template.
You can edit the translation either in the Question Library, or in the questionnaire or template in which it's used.
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How You Use Questionnaires in Performance Documents
 
Create questionnaires to add to performance documents. These questionnaires gather feedback about workers from
participants other than direct managers. Managers can use such feedback to help them evaluate workers.

Here's what you use questionnaires in performance documents for:

• Capture feedback in performance documents

• Collect information on a worker other than competencies and goals

• Configure questions for specific audiences and periods

To create questionnaires, go to My Client Groups > Performance > Questionnaires. From there you can also create
Questions and Questionnaire Templates.

Instead of writing your own questions, you may want to see what questions have already been created. To go to the
Question Library task, go to the Setup and Maintenance work area from the Settings and Actions menu:

• Offering: Workforce Development

• Functional area: Questionnaires

• Task: Question Library

Capture Feedback in Performance Documents
Using questionnaires allows your organization to get feedback from multiple sources. Such sources are the worker
being evaluated, the worker's manager, peers, colleagues, other managers, internal customers, or any other role in
the organization. This helps you get a wider view of a worker's performance. Managers can't use participant feedback
captured in a performance document to rate workers in the performance document, but managers can use it to help
determine how to rate workers.

Managers, workers, or both, manage participant feedback to select participants and assign them roles. Those roles
determine which questionnaires the participants respond to.

Score Questionnaires Used in Performance Documents
You can enable scoring for a questionnaire when configuring a performance template. If you choose a questionnaire,
use these options to configure the scoring on the Performance Template page:

• Use the Processing by Role section to select the roles that can view the scores. When you enable scoring for a
role, persons having the role can see the scores and section weight in the questionnaire. The scores display to
the user when they save or after they've submitted their evaluation.

• Select Enable section weights in the Weighting section to enable a section weight for the questionnaire
section. Assign a section weight to be applied against the total score if it’s considered in the overall summary
rating calculation. You can assign a minimum section weight that the section weight can't be set lower than in
the performance document.

• Select Include total score in overall summary calculation in the Scoring section to include the total score in
the calculation of the overall summary rating.
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Collect Information on a Worker Other than Competencies and Goals
You can use questionnaires to gather data about workers that isn't specifically about competencies and goals, thus
increasing the range of information concerning the worker's performance and development.

For example, you can ask the manager or worker to do these actions:

• Identify strengths of the worker, or areas that require more development.

• Describe the top three achievements of the worker during the previous year.

• Discuss the worker's satisfaction in the current role.

Set up Questions for Specific Audiences and Periods
You can set up questionnaires to target general audiences, or specific groups, such as managers, workers, peers or
other roles. You must associate questionnaires with performance template periods, and assign the roles that respond to
the questionnaire. This enables you to create questionnaires that concentrate on specific periods, or can be used over
multiple periods.

How Performance Documents Work with Questionnaires 

You can add questionnaires to performance documents to enable participants to provide feedback during a
performance evaluation.

To add questionnaires to performance documents, you must first create questionnaire templates and questionnaires,
and configure the elements that make up a performance template to include questionnaires.

This figure illustrates the steps required to add questionnaires to performance documents and track feedback.
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You manage questionnaire templates and questionnaires, questions, roles, process flow performance template sections
and performance templates in the Setup Maintenance and Performance work areas. You manage participant feedback
in performance documents in the Performance work area.

Go to My Client Groups > Performance to access these tasks:

• Questionnaire templates

• Questionnaires

• Questions

• Performance roles

• Performance process flows

• Performance templates

• Performance template sections

• Participant feedback

Except for Participant Feedback, these tasks are also available in the Setup and Maintenance work area:

• Offering: Workforce Development

• Functional Area: Questionnaires or Worker Performance

Questionnaire Template
Create a questionnaire template from which to create a questionnaire and assign Performance 360 as a subscriber
application to make it available in performance documents. In the template, you can format the layout and questions to
include in the questionnaires made from it. You can create as many questionnaire templates as needed.
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Questionnaire
Create the questionnaire from an available template. Create as many questionnaires as required for your business
process. For example, if your organization requires feedback from multiple roles, such as other managers, peers, or
internal customers, you may need a different questionnaire for each role. You may also require different questionnaires
for each performance evaluation period, or that cover all periods. You can edit questionnaires created from the template
as required.

Roles
You must create all the roles that will access questionnaires in a performance document, with the exception of manager
and worker, which are default roles. You associate roles with the questionnaire in the performance template to make
them available to the role. Managers, workers, or both, select the roles that apply to each participant when managing
participant feedback to determine which questionnaire a participant uses.

Section
Create a Questionnaire section to include in the performance document. The Questionnaire section is the only section
type that can contain questionnaires. The questionnaire appears as a tab in the performance document. Add all the
roles that will access the questionnaire to the section.

Process Flow
To make participant feedback available in a performance document, you must create a process flow that includes the
Manage Participant Feedback task. Specify whether managers, workers or both, can manage and track participant
feedback.

Performance Template
In the performance template you add the roles, process flow, and Questionnaire section that you created for the
questionnaire. To the document periods you add the roles that you want to be able to access the questionnaire,
and specify the questionnaire to associate with each role. Managers and workers can also be requested to answer
questionnaires. To do so, you must add them to the document period.

In the template, you can also specify the minimum number of participants required to answer the questionnaire for
each role, and a total minimum number of participants for each document. These settings are guidelines and aren't
enforced.

Performance Document and Participant Feedback
After the performance document is created, the manager, worker, or both, can select participants, send requests for
feedback, and manage the feedback. Depending on the settings in the questionnaire, managers or workers can add
additional questions to the questionnaire. The ability to manage participant feedback is determined by the process flow
settings.

Participants, other than workers and managers, can access the Questionnaire section of the performance document.
Depending on how the performance template and process flow are configured:

• Participants can provide comments that appear in the Overall Summary section for managers and workers to
review

• Workers and managers can access the Questionnaire section to view participant feedback
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When the manager submits the performance document, the participant feedback is locked and participants can't
add or edit feedback. Any feedback participants didn't submit before the document is locked won't be included in the
performance document.

Export and Import of Questionnaire Data  
Streamline the mass upload of Questions, Questionnaire Templates, and Questionnaires by using HCM Data Loader and
HCM Spreadsheet Data Loader. Import any type of questions within the questionnaire, including the response choices
in choice-based questions.

Note:  You can import images for questions and responses and import attachments for questionnaire information
using HCM Data Loader.

You can create questionnaire objects or manage the existing ones. You can load data for Questions and Question
Answer Responses by using the Question data file. You can create questionnaire templates and questionnaires
including the sections, questions, and answers that are a part of the questionnaire.

You can load the translation data of these business objects by using the translation data files. To use HCM Spreadsheet
Data Loader in the Data Exchange work area, you need to first create a spreadsheet template, then upload it using the
Load Spreadsheet Data task.

Related Topics
• Overview of Loading Questions, Questionnaire Templates, and Questionnaires

• Guidelines for Loading Questions, Questionnaire Templates, and Questionnaires

• Examples of Loading Questionnaires

• Examples of Loading Questionnaire Templates

• Examples of Loading Questions

What happens if I edit a questionnaire that's in use?  
When you edit a questionnaire that's in use, you're prompted to either create a new version of the questionnaire or
update the existing version.

When you update the questionnaire, the existing responses could become invalid. So it might be better to create a new
version of the questionnaire.

Here's what happens when you update an existing questionnaire:

• If respondents answered questions and saved the questionnaire before the update, their saved responses
continue to appear when they reopen the questionnaire after the update.

• The status remains Active.

• The questionnaire version remains the same.

• The In Use status is Yes.
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Note:  You can edit the questionnaire as needed, but it's best to limit the edits to those that have a minimal impact,
such as changing text. Adding questions, marking questions as required, or changing responses to choice-based
questions can result in issues for questionnaires that are already completed. This applies to questionnaires used in
performance documents, anytime performance documents, requested feedback, and check-ins.

You can update these attributes in a questionnaire that's In Use:

• Name of the questionnaire

• Folder (category) of the questionnaire

• Owner

• Status

• Privacy

• Description

• Instructions

• Attachment for questionnaire

• Section order (if allowed from base questionnaire template)

• Section presentation (if allowed from base questionnaire template)

• Response order (positional randomization for answers)

• Name, description, and instruction text of section (if allowed from base questionnaire template)

• Position of questions (drag and drop feature is allowed)

The changes take effect as soon as you save the questionnaire. Respondents see the changed version in these
scenarios:

• Creating a new performance document that includes a questionnaire

• Editing a questionnaire in a performance document that's in progress

• Reopening a previously completed performance document to edit the questionnaire

• Check-in documents always refer to the latest version of the questionnaire referenced in the check-in template.
If you need a new version of a questionnaire for new check-in documents, it's recommended you create a
new check-in template that includes a new questionnaire, instead of creating a new version of the existing
questionnaire. This helps you preserve the questionnaire responses in existing check-in documents.

Here's what happens when you create a new version of a questionnaire:

• The previous version isn't affected.

• The status of the new version is set to Draft.

• The questionnaire version number increases by one.

• The In Use status is set to Prior Version.

When a questionnaire is completed using this version, the In Use status changes to Yes. The changes take effect when
you set the status to Active and save the questionnaire. Respondents see the new version in these scenarios:

• Creating a new performance document that includes a questionnaire

• Editing a questionnaire in a performance document that's in progress:

◦ If respondents answered questions and saved the questionnaire prior to the new version, their saved
responses don't appear when they reopen the new version. Instead, they see the new version of the
questionnaire.
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• Reopening a previously completed performance document to edit the questionnaire.

◦ The questionnaire version you see for completed performance documents before reopening is the
version in which it was completed.

• Creating a new check-in document

• Opening an existing check-in document to edit the questionnaire

• Creating a new requested feedback

• Editing a questionnaire in requested feedback that's in progress:

◦ If respondents answered questions and saved the questionnaire prior to the new version, their saved
responses don't appear when they reopen the new version. Instead, they see the new version of the
questionnaire.

What happens if I edit a question that's in use?
Editing questions when responses already exist can invalidate responses. It's recommended that you copy the question
over to a new questionnaire and then make the changes you want.
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5  Descriptive Flexfields

Descriptive Flexfields for Performance Management  
You can use descriptive flexfields to add company-defined attributes for a Performance Management entity, and define
validation and display properties for them.

For example, you can create a descriptive flexfield for a performance document to ask employees if they’re willing to
be a mentor. For more information on using flexfields for company-defined attributes, see the Oracle Fusion Cloud
Applications Configuring and Extending Applications guide.

There are five descriptive flexfields available in Performance Management as listed in the table below.

Descriptive Flexfield Code Description

HRA_DOC_TYPES_B
 

Additional fields for document type displayed on the Performance Document Type pages.
 

HRA_TMPL_DEFNS_B
 

Additional fields for performance templates displayed in General details on the Performance Template
page.
 

HRA_EVALUATIONS
 

Additional fields for evaluation displayed in the Additional Info region of a performance document.
 

HRA_SECTION_DEFNS_B
 

Additional fields for sections displayed in the Performance Template Section page.
 

HRA_TMPL_SECTIONS
 

Additional fields for performance template section details displayed on the Structure tab in the
additional information region of the Performance Template page.
 

HRA_EVAL_ITEMS Not in use.

HRA_EVAL_RATINGS Not in use.

Activate Descriptive Flexfields
To activate a descriptive flexfield, you must also define lookup codes and value sets along with the descriptive flexfield
segment.

Related Topics
• Overview of Descriptive Flexfields

• Overview of Flexfields
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6  Profile Options

Performance Management Profile Options  
Set profile options to define the auto save interval, and automatically transfer performance documents to new
managers.

You can change these options only at the site level.

Follow these steps to manage profile options using the Setup and Maintenance work area:

1. Open the Settings and Actions menu from your photo on the global header, and select Setup and
Maintenance.

2. Select Workforce Development from the Setup  list.
3. Click the Tasks icon and select Search from the list that appears.
4. Search for the Manage Administrator Profile Values task and select it from the search results area.
5. Search for the profile option code that you want to change. The profile option code and value appear in the

search results area.
6. Edit the profile value as described in the following sections.
7. Specify the level at which the profile value is to be set. If the profile value applies to the entire site, select Site.
8. Click Save and Close.

Performance Autosave Interval
This table shows the profile option code and value that determine the auto save interval in performance documents.

Profile Option Code Profile Display Name Effect Default

HRA_PERF_AUTOSAVE_INTERVAL
 

Performance Autosave Interval
 

Indicates the number of minutes
before the performance document
saves automatically.
 

10
 

Transfer Performance Documents Automatically
You can enable the transfer of performance documents from an employee's previous manager to the new manager. You
can do this by configuring the profile option and selecting the manager type that should be transferred.

To enable automatic transfer, you need to perform these steps:

1. Set the Auto Transfer Performance Documents to New Manager profile option value to Yes. When enabled,
the profile option enables you to select No transfer, Transfer for any manager type change, Line manager, or a
custom manager type.

2. If an employee's manager with a selected type changes, any open performance documents that manager was
the evaluator for are transferred to the new manager for the employee. If there’s a manager change this is what
happens:

◦ If there are multiple manager changes on the same day it checks for who the manager is at the time of
processing. It doesn’t process all previous manager records on the same day.

◦ If the employee has any performance documents that aren’t started, or in-progress. It doesn’t process the
performance documents if the status is completed or cancelled.
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◦ If the previous manager was the performance document manager.

3. Set the HRC_Disable_HCM_Events_Processing profile option to N. An event is triggered only if you change the
manager, it isn’t triggered if you delete the manager and add a new one.

4. Schedule the Transfer Performance Documents with Manager Change process. When run daily, the process
determines if there are any manager changes with an effective date today or earlier which haven't been
processed. It then transfers performance documents for those manager changes from the previous manager
to the new manager according to the configured manager type. Notifications are sent for each performance
document that’s transferred to the new manager, if enabled.

Note:  The application purges any data older than 180 days that's saved as a result of HCM Events.

Related Topics
• Autosave Performance Documents

• Overview of Profile Options
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7  Performance Roles

Performance Roles  
Create roles to expand the scope of the performance evaluation to include feedback from participants other than the
worker and the worker's manager. To implement multiparticipant feedback, you must first define the roles that can
participate in the process.

To create performance roles, go to My Client Groups > Performance > Setup Maintenance > Performance Roles.

To make roles eligible to provide feedback, you must:

• Define performance roles.

• Provide a description for the role.

• Make roles available for the performance document.

• Associate questionnaires to the roles when using questionnaires.

Define Performance Roles
You can create as many roles as required for the evaluation process that your organization employs. For example, you
might have participant roles such as peer or mentor, or participant roles to facilitate a matrix management review.
You may have additional manager roles used in performance templates where the default manager type isn't the line
manager, such as, for project performance documents where the default manager is a project manager.

1. From the Performance Roles page, click Create.
2. Select the Role Type, either Manager or Participant.
3. If the Role Type is Manager, select Default Manager Type.
4. Enter the name of the Role, for example, Matrix Project Manager or Peer.
5. (Optional) Enter a description of the role.
6. Specify the From Date and To Date.

These dates have to overlap with the template dates to be valid for use in that template. For example, the role
From Date can be before the template date, as long as the role To Date isn't before the template From Date.
The role To Date can also be after the template To Date, as long as the role From Date isn't after the template
To Date.

7. Select a status. The default is Active.
8. (Optional) If you want the role to be able to view worker and manager evaluations, click the check box Allow

role to view worker and manager evaluations.

Participants with this role can view the ratings, comments, and questionnaires submitted by other roles that are
also visible to the manager when they open the performance document from the My Feedback Requests page.

9. Click Save.

The seeded manager and worker roles are required; you can't delete or edit them. But you can create performance
templates that don't require either the manager or worker role to answer a questionnaire or rate workers. In this case,
you must add the role names to the template to permit the manager or worker to view feedback.

For example, you might create a performance template that includes the manager and participant roles only to gather
feedback not visible to the worker. If you don't want the manager or worker to provide feedback, but do want them to
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view feedback provided by others, you must still add the role names to the sections in the template to permit them to
view the other feedback.

Provide a Role Description
Along with the role name, you can add a description for the role. The description appears on the Manage Participant
Feedback pages.

Make Roles Available to Access the Performance Document
The participant roles you create, along with the manager and worker roles, are eligible to access the performance
document to provide ratings and comments on content and feedback on questionnaires. You must select the roles in
the performance template to enable them to access the performance document.

Associate Questionnaires with Roles
Each role is eligible to respond to only one questionnaire for each performance document within a review period. But
you can assign more than one role to participants so they can complete more than one questionnaire. You associate
roles with the questionnaires that the role uses in the performance template.

Participant Feedback  
The Manage Participant Feedback task enables individuals other than the line manager and worker to provide direct
feedback into the worker's performance document. Additional roles providing feedback might include peers, mentors,
customers, and other managers, such as matrix managers.

The additional roles providing feedback are called participants. Participants can evaluate workers on content items by
providing ratings, comments, or both, and respond to a questionnaire to provide a 360-degree evaluation. Participant
feedback is recorded as part of the official performance evaluation. By including a variety of participants who have
worked with the worker, the manager can get a broader view of the worker's performance to help in the evaluation.

The Participant Feedback process provides the ability to:

• Specify who can request and track participant feedback.

• Provide multiparticipant feedback according to role.

• Use questionnaires to provide feedback.

• View participant names, roles, and feedback.

• Submit feedback and complete the Participant Feedback process.

• Print feedback.

This figure shows the steps for gathering participant feedback.
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Add a Participant to a Performance Document
The HR specialist must have the appropriate security privilege and data role to add participants to a performance
document.

In this example, the HR specialist adds a participant to Meg Smith's performance document.

1. Click Directory.
2. Find the person whose performance document that you want to add a participant, for example, Meg Smith.
3. Click the person's name.
4. Click Show More.
5. Click Performance.
6. Select the review period. The performance documents for Meg Smith appear.
7. Find the performance document that you want to add the participant to.
8. Click the participant status link for that performance document. If there are no participants yet, the link may

say No participants. Alternatively select the row level Actions option (shown as three dots) and select Manage
Participant Feedback.
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9. In the Participants area, click Add.
10. Select the person you want to add as a participant to Meg Smith's performance document.
11. Select the Role for the participant.
12. Click Save.

Specify Who Can Request and Track Participant Feedback
The human resource (HR) specialist configures the process flow to specify whether managers, workers, or both, can
select participants to provide feedback, add questions to the questionnaire, and track feedback request and completion
status. Managers and workers use their respective versions of the Manage Participant Feedback page to perform the
participant feedback tasks.

When the manager or worker requests feedback, participants receive workflow notifications of the request. Participants
access the performance document on the My Feedback Request for Others page or from links on their worklist.

Managers and workers can track participant feedback to monitor its status to see whether it's started, in progress, or
completed. Depending on configuration, workers can also see the feedback itself and the names of the participants who
provided the feedback.

Managers and workers can remove a participant from a performance evaluation, or change the role (for example,
change a mentor to a peer), provided the participant hasn't yet provided feedback.

Provide Multiparticipant Feedback by Role
HR specialists create the participant roles that can rate worker competencies, goals, overall performance, and answer
questionnaires. They can configure a role that allows participants also to view ratings, comments, and questionnaires
provided by the worker, other managers, and participants. In the performance template, the HR specialist selects the
roles that can provide feedback in the Profile Content (Competencies), Performance Goals, Development Goals, and
Overall Summary sections. The HR specialist can associate separate questionnaire templates, with different questions,
to each role.

Managers and workers, if permitted, can select participants of varying roles to provide feedback and notify them
to provide feedback. The managers and workers can add the same participant more than once to a performance
document. They can select the same role or a different one for the participant. The participant responds to the
questionnaires associated with the roles, even if the questionnaires are the same.

Participants can't add or edit content, such as competencies or goals in the performance document, unlike managers
and workers.

Use Questionnaires to Provide Feedback
Participants, as well as managers and workers, provide feedback by answering questions about the worker on
a questionnaire that the HR specialist adds to the performance document in the performance template. The
questionnaire is a performance template section, and appears as a tab in the performance document, just as do other
sections, such as the Performance Goals, Development Goals, or Overall Summary sections.

The manager and worker, if allowed, can add questions they create to the questionnaire that's provided for the
performance document. They can add questions only to the questionnaires that are associated with the participant
roles they select. You must also configure the questionnaire to allow them to add additional questions.

The HR specialist creates questionnaires using the Questionnaire Templates and Questionnaires tasks in the Setup
Maintenance area under My Client Groups > Performance.
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View Participant Names, Roles, and Feedback
Line managers, matrix managers, and workers, if allowed, can view the names and roles of the requested participants,
along with the ratings, comments, and feedback they provided. You can configure the performance template so that
participants can provide overall comments about the worker instead of answering questions on the questionnaire.
Participants can't view ratings, comments, or questionnaire responses provided by the worker, manager, or other
participants.

Submit Feedback and Completing the Participant Feedback Process
Line managers, matrix managers, and workers if allowed, can view ratings, comments and feedback when the
participant submits the performance document and questionnaire. Participants can continue to provide feedback until
the manager either locks the feedback process or completes the Manager Evaluation of Workers task and submits the
performance document to continue the performance evaluation process.

Print Feedback
Managers and workers can print participant feedback, as they can with other performance document content. They
can, however, only print the content that their role is configured to see. For example, if the performance process flow is
configured so the worker can't view participant feedback, the worker can't print it.
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8  Matrix Management

How You Use Matrix Management with Performance
Evaluations  
Matrix management functionality in Performance Management allows managers other than the employee's line
manager to evaluate the employee, and view submitted ratings and comments.

Matrix Manager's Role
A matrix manager is an additional manager other than the line manager (for example, a project manager, a team
manager, or a functional manager).

In a performance evaluation, matrix managers are participants with a specific, configured performance role that gives
them the added ability to view ratings and comments submitted by others. To create a performance role, use the
Performance Roles task in the Setup and Maintenance work area or on the administrator's Performance page.

Actions Matrix Managers Can Do
Matrix managers can access the performance documents that they need to evaluate in the Participant Feedback for
Others section of their Performance page.

During a performance evaluation, matrix managers can do these actions:

• Evaluate the employee by providing ratings and comments

• Review the submitted ratings, comments, and questionnaire responses provided by the employee, other
managers, and other participants

Note that matrix managers can only provide and view ratings and comments in sections to which they're granted
access in the performance template. They can't add or remove content items, such as competencies or goals, from a
performance document.

Matrix Manager's Notification
When an employee submits a completed self-evaluation, matrix managers receive a notification, if the Worker
completes self-evaluation notification option is enabled. You use the Talent Notifications task in the Setup and
Maintenance work area or the administrator's Performance page to set up the Performance Management notifications.
You can also set up the notifications by navigating to My Client Groups > Performance > Setup > Talent Notifications
> Performance Management tab.

Matrix Manager as Review Participants
Line managers and employees can add matrix managers as review participants to any performance document that they
have access to.

1. Open the Performance page of the employee.
2. Select the review period of the performance document.
3. From the Actions menu of the performance document, select Manage Participant Feedback.
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4. Click Add in the Participants section of the Manage Participant Feedback page.

You can see the matrix managers of the employee in the Matrix Managers section, if enabled, or when you
search for them.

5. Select the matrix managers and click Send Request.

Note:  Matrix managers can view the ratings and comments provided by the employee, performance
document manager, and other participants only if they're assigned a participant role for which the Allow role
to view worker and manager evaluations check box is selected for their assigned participant role on the
Performance Roles page.

Line managers can also remove matrix managers from the Manage Participant Feedback page, even if they were
automatically assigned.

Related Topics
• Configure Matrix Management for Performance Documents

• Matrix Manager for an Assignment

Configure Matrix Management for Performance
Documents  
This topic describes how administrators can configure performance roles, process flows, and templates to use matrix
management in performance documents.

Matrix managers can then access performance documents that they need to evaluate in the Participant Feedback for
Others section of their Performance page.

Matrix managers are additional managers who aren't defined as the employee's line manager.

Before You Begin
Create at least one of these sections using the Performance Template Sections task. They are required when the
Manage Participant Feedback task is included in the Performance Process Flow task, which is described later in this
topic:

• Profile Content (Competencies)

• Performance Goals

• Development Goals

• Questionnaire

• Overall Summary

Create a Matrix Manager Participant Role
A matrix manager must have a participant role to be able to evaluate an employee's performance documents.
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Here's how you create a participant role:

1. In the Setup and Maintenance work area, select the Performance Roles task.
2. In the Search Results section of the Manage Performance Roles page, click Create. You see the Create

Performance Role page.
3. Select a role type of Participant and enter the role name. The role name can be of the additional managers'

type who are expected to review employees, or any other name. You can include this role in the performance
template.

4. Enter a description. Descriptions appear on the Manage Participant Feedback pages to assist users in
determining which role to assign to each participant.

5. Enter the From Date and To Date. These dates must be the same as or extend beyond the date range of the
performance templates in which they're used.

6. Set the Status value to Inactive until the role is ready.
7. To enable the matrix manager participant role to view evaluations performed by the employee and other

managers, select the Allow role to view worker and manager evaluations check box.
8. Click Save and Close.

Create a Performance Process Flow
You must add the Manage Participant Feedback task to the performance process flow so that matrix managers can do
these tasks:

• Add ratings and comments.

• View ratings and comment submitted by the employee and line manager.

Use the Performance Process Flows task in the Setup and Maintenance work area.

1. In the Setup and Maintenance work area, search for and then select the Performance Process Flows task.
2. In the Search Results section of the Manage Performance Process Flows page, click Create. You see the Create

Process Flow page.
3. Enter a name and optionally, a description.
4. Enter the From Date and To Date. These dates must be the same as or extend beyond the date range of the

performance templates in which they're used.
5. Set the Status value to Inactive until the process flow is ready.
6. In the Worker Self-Evaluation and Manager Evaluation section, select these check boxes:

◦ Include worker self-evaluation task: To let employees evaluate themselves

◦ Include manager evaluation of worker task: To let line managers evaluate their direct reports

7. In the Participant Feedback section, select these check boxes:

◦ Include manage participant feedback task: To enable participants to access the performance
document

◦ Manager can select participant: To let managers select review participants

◦ Worker can select participant: To let employees select review participants

◦ Manager can track participants: To enable managers to see the status of the feedback request sent to
the participant

8. Select other options as required by your business process.
9. In the Approval, Review and Meetings sections, select the options required for your business process.

10. Click the Task Names tab.
11. Enter the sequence numbers and names for the tasks.
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12. Click Save and Close.

Configure the Performance Template's General Tab
You must add all roles, including the matrix manager participant roles you created, to the performance template in
the Participation section of the General tab, and to the sections on which you rate employees so they can view and
provide ratings and comments. Use the Performance Templates task in the Setup and Maintenance work area or the
administrator's Performance page.

1. In the Setup and Maintenance work area, select the Performance Templates task.
2. In the Search Results section of the Performance Templates page, click Create. You see the Create Performance

Template page.
3. On the General tab, enter a name and optionally, comments.
4. Enter the From Date and To Date. The From Date must be the same or later than, and the To Date the same

as or earlier than the From Date and To Date range of the performance document type, process flow, roles, and
sections used in the template.

5. Set the Status value to Inactive until the role is ready.
6. Select a document type.
7. In the Eligibility Profile section, add eligibility profiles to limit the performance documents to eligible employees,

if required by your business process.
8. Optionally, in the Participation section, to warn managers and employees when they don't select the minimum

numbers of participants, do these actions:

◦ Select the Set the minimum number for each participant role check box.

◦ In the Total minimum number of participants required in the document field, enter the minimum
participant number for the entire performance document.

9. In the Participation section, click the Add icon.
10. In the Role column, select the Manager role.
11. Repeat steps 9 and 10, for the Worker role, the participant roles you created for matrix managers, and any other

participants who use performance documents created from the template.
12. For each participant role, enter the minimum number of participants required per role if you specified that

participant feedback is required.
13. Click Save.
14. Click the Process tab.

Configure the Performance Template's Process Tab
On the Process tab, you add the process flow and configure participation options for matrix management.

You configure participation options to do these:

• Prevent employees and managers from assigning participants a matrix manager role incorrectly.

• Control which participants have access to employees and managers ratings and comments and which
participants can provide feedback only.

• Auto-populate specific matrix managers of a certain manager type only.

• Prevent matrix managers that aren't required from being included in an employee's performance review.

Here's how you configure the Process tab:

1. In the Process Flow field, select a process flow that contains the Manage Participant Feedback task.
2. Configure the Alerts, Calculation Rules, and Processing Options sections as required for your business process.
3. In the Participant Options section, select the options to achieve the wanted results as shown in the table.
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Note:  The options in the table are available only if you add a matrix manager participant role to the
Participation section of the General tab.

Option Impact

Participant feedback is required
 

Requires managers to send at least one feedback request to a participant.
 

Worker can view the participants added
by manager or HR
 

Employees can see participants' names in the performance document, if configured on the
Structure tab of the template.
 

Auto-populate matrix managers of the
worker as participants
 

Matrix managers appear automatically on the participant list in the Manage Participant
Feedback task, and line managers don't have to manually select matrix managers as
participants.
 

Default participant role
 

Assigns the selected role to auto-populated matrix managers.
 

Manager Type
 

Available when you select the Auto-populate matrix managers of the worker as participants
check box. You can select all or specific matrix managers.
 

Allow matrix managers to access
worker document automatically
 

Matrix managers can access the document as soon as it's created in the Participant Feedback
for Others region of their Performance page. If this option isn't selected, then the line manager
must send a notification manually on the Participant Feedback page.
 

Employee can assign participant roles
that can view worker and manager
evaluations
 

Available only if a participant role is added to a performance template that's configured to
'Allow role to view worker and manager evaluations'.
 
If selected, employees can assign any role to a participant in the Manage Participant Feedback
page.
 
If not selected, any participant roles configured in this template aren't available for employees
to select in the Manage Participant Feedback page.
 

Manager can assign participant roles
that can view worker and manager
evaluations
 

Available only if a participant role is added to a performance template that's configured to
'Allow role to view worker and manager evaluations'.
 
If selected, managers can assign any role to a participant in the Manage Participant Feedback
page.
 
If not selected, any participant roles configured in this template aren't available for managers to
select in the Manage Participant Feedback page.
 

4. Click Save.
5. Click the Structure tab.

67



Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 8
Matrix Management

Configure the Performance Template's Structure Tab
On the Structure tab, you add and configure the sections required by the process flow. You add and configure roles in
the Processing by Role section.

1. In the Sections section, add a profile content section. You may have named it with a different name.
2. Configure the Section Processing, Item Processing, and Section Content sections as required to conform to

your business process.
3. In the Processing by Role section, click the Add icon.
4. In the Role column, select Manager to grant access to the section.
5. Complete the fields as wanted for the manager as shown in this table. For all other processing options, leave

the default values, or select others as wanted. Repeat steps 3 through 5 for granting access to employees,
matrix managers, and other participants. Complete the fields, as shown in this table.

Role Share Ratings Share Comments Participant Name Can
Be Viewed by the Role

Participant Role Can Be
Viewed by the Role

Manager
 

Yes, to share ratings with
employee
 

Yes, to share comments
with employee
 

◦ Yes: To let manager
view participant
name

◦ No: To display
participants only as
Participant

◦ Yes: To let manager
view participant role

◦ No: To display
participant roles as
Participant

Worker
 

By default, this is Yes.
You can't change this
value.
 

By default, this is Yes.
You can't change this
value.
 

◦ Yes: To let employee
view participant
name

◦ No: To display
participants only as
Participant

◦ Yes: To let employee
view participant
name

◦ No: To display
participants only as
Participant

Matrix Manager
 

Yes, to share ratings with
employee
 

Yes, to share comments
with employee
 

Inherits Manager setting
 

Inherits Manager setting
 

Participants
 

Yes, to share ratings with
employee
 

Yes, to share comments
with employee
 

Not available
 

Not available
 

6. Click Save.
7. Click the Content tab.

Configure the Performance Template Content, Document Periods, and
Summary Tabs
Complete the performance template by configuring the Content, Document Periods, and Summary tabs. On the
Document Periods tab, you can add questionnaires and assign roles to access them.

1. Add content to the Profile Content, Performance Goals, and Development Goals sections as required for your
business process.

Tip:  Click Load Items from Section to add the default content items of the section to the template.

2. Click the Document Periods tab.
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3. Add periods as required for your business process.

Note:  The document period end date must be earlier than or equal to the end date of the performance
template.

4. In the Eligibility Profile for the Period section, add eligibility profiles if required by your business process.
5. In the Due Dates section, enter task due dates.
6. In the Questionnaires for the Period section, click the Add icon. Questionnaires are optional to provide

participant feedback.
7. In the Role field, select a role that can access the questionnaire.
8. In the Questionnaire field, select an existing questionnaire.

Note:  The employee's line manager can select a different questionnaire for the role in the Manage
Participant Feedback task.

9. Repeat steps 6 through 8 to add additional roles and questionnaires.
10. Click the Summary tab.
11. Review your selections and click Save and Close.

Related Topics
• How You Use Matrix Management with Performance Evaluations
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9  Eligibility Profiles

How You Use Eligibility Profiles with Performance
Documents  
You can use eligibility profiles to restrict availability of performance documents to a specific population based on criteria
you set up.

If you don't associate eligibility profiles with a performance document, the document can be created for everyone in the
organization.

This figure shows the steps required to set up and use eligibility profiles for performance documents.

Creating Eligibility Profiles
You create eligibility profiles to match the business requirements for your performance evaluation business process. For
example, you can create eligibility profiles to evaluate workers in a specific department, job, location, or other criteria.
You can also combine criteria. For example, you can create a performance document to evaluate every person in the
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Sales department who's a manager level 3 and located in California. You can either create one eligibility profile with
those three criteria, or create three separate profiles with each criterion. You create eligibility profiles using the Eligibility
Profiles task in the Setup Maintenance work area.

When creating an eligibility profile for performance documents, you can select any profile usage. However, because
eligibility for a performance document is determined by assignment, you must select Specific assignment as the
assignment to use. Specific assignment is automatically selected if you first select Performance as the profile
usage. Then, when the eligibility process is run, it evaluates every assignment for a worker to determine which, if any,
performance documents the worker is eligible to use for each assignment.

Associating Eligibility Profiles with Performance Templates
You select eligibility profiles to associate with performance templates at the template level and for performance
document periods. When you select eligibility profiles, the performance documents made from the template are
available only to the workers who meet the criteria.

You can associate eligibility profiles for any profile usage to a performance template. However, only those with the
assignment set to Specific assignment are available to associate with performance templates.

Eligibility profiles can either be required, or not required, and can be used in combination so that workers must match
some or all criteria.

Running the Eligibility Process
To determine which workers are eligible for performance documents that use eligibility profiles, you must run the
eligibility process. You can run a batch process to analyze a large worker population to determine who's eligible for
performance documents based on the parameters you enter. To run the batch process, use the Eligibility Batch Process
task in the Setup Maintenance work area.

Accessing the Performance Documents
HR Specialists are responsible for creating standard performance documents for employees.

When performance documents are created, they show to employees on Me > Career and Performance >
Performance. Managers can view and process the performance documents they manage on My Team > Evaluate
Performance. The Goals and Performance Overview page also shows a summary of the performance documents for
their direct or indirect reports, including performance documents managed by someone else such as a matrix manager.

Employees, managers and HR Specialists can create anytime documents from the employees Performance page.
Managers can also create them from the Goals and Performance Overview page. HR Specialists can also create them
from the administration page Performance Documents.

If a performance document is created for an employee and the eligibility process is run again, but now the worker is
ineligible, it doesn't delete the created performance document and it can continue to be accessed.

However, if a performance document wasn't created and the eligibility process is run again, making the worker no
longer eligible for the document, that document can't be created for the employee whether a standard or anytime
document.

Related Topics
• Eligibility Profiles
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Examples of Using Eligibility Profiles with Performance
Documents  
With eligibility profiles, you can use performance documents to evaluate a specific population of workers. These
scenarios illustrate how human resource (HR) administrators can create eligibility profiles and run the eligibility process
to make the documents available to workers and managers.

Create Eligibility Profiles and Run a Batch Process for an Organization
The organization wants to create a performance document to compare how the sales force performs across
all departments in the US. The HR administrator creates an eligibility profile, called US Sales Team, and selects
Performance for the profile usage. The assignment to use value automatically becomes Specific assignment. The HR
administrator selects these criteria for all active workers:

• Active, not on leave

• Located in the US

• Employed in the Sales job family

The HR administrator or implementor completes these steps:

1. Create a performance template, with a performance document period for the current evaluation period named
US Sales Annual Evaluation.

2. Add the US Sales Team eligibility profile to the document period.
3. Run the eligibility batch process to find all eligible salespeople to make the US Sales Annual Evaluation

performance document available to them and their managers to start the evaluations.

You run the eligibility batch process using the Eligibility Batch Process task in the Setup Maintenance area.

Remember that the Performance Eligibility responsive page doesn't run the eligibility batch process and you can only
change eligibility that's been processed. So make sure you run the process for a performance document before you try
and make any changes to an employee's eligibility using the Performance Eligibility page.

Check Eligibility when a Worker Transfers to an Organization
You hire a new worker, Lee Smith, in the Sales department under a manager, John Hing, after the batch process is run
and performance documents are created for the Sales team. Lee isn't initially eligible for the US Sales Annual Evaluation
period document, but should be, since he joined Sales midway through the evaluation period.

As an HR administrator, complete these steps to create his performance document:

1. Go to My Client Groups > Performance, scroll down to the Setup Maintenance section, and click Eligibility
Batch Process.

2. Run the process for the US Sales Annual Evaluation performance document.

If the performance document isn't created for Lee Smith, then follow these steps to see why he's not eligible:

1. Go to My Client Groups > Performance, and click Performance Eligibility in the Administration section.
2. Search for Lee Smith and select his name.
3. Click Check Eligibility located in the page header.
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4. Change the effective date and review period, as required.
5. Select the US Sales Annual Evaluation performance document. Lee Smith's eligibility status appears in the

Result area. If he's eligible, then he and his manager John can access the performance document when it's
created and begin the evaluation.

Force Eligibility when a Worker Transfers from another Organization
Taylor Wong transfers from the US Sales department to the Hong Kong Sales department midway through the period
covered by the US Sales Annual Evaluation performance document. The HR administrator has run the batch eligibility
process for the last time after Taylor transferred, making Taylor ineligible to use the US Sales Annual Evaluation
performance document. However, the organization process requires that Taylor be evaluated using performance
documents for both his old and new locations.

The HR administrator completes these steps:

1. Navigate to the Performance Document Eligibility page, search and select Taylor Wong.
2. On the Performance Document Eligibility page, click Add, select the US Sales Annual Evaluation performance

documents, and specify to force it eligible.

Even though Taylor no longer meets the eligibility criteria, he and his new manager can access the performance
document to perform the evaluation.

Related Topics
• Eligibility Profiles
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10  Eligibility Batch Process

How You Manage Eligibility for Performance Documents
and Check-In Templates  
You can view and manage an employee's eligibility for performance documents or check-in templates on the
Performance Eligibility page.

This page displays performance documents and check-in templates that an employee is automatically eligible for,
forced to be eligible for, or forced to be ineligible for based on eligibility profiles. It doesn't display performance
documents or check-in templates that an employee is automatically ineligible for.

If a performance document or check-in template hasn't been processed for eligibility yet, you can check if the employee
is eligible for it. If they're ineligible, you can see which criteria caused the ineligibility. You can also process the eligibility
for that performance document or check-in template without running the eligibility batch process.

Note:  The review period on the Performance Eligibility page is used to filter the display of information. It isn't used to
determine eligibility. If a check-in template is associated with multiple review periods, the check-in template displays
when any of those review periods are selected. If the employee is made eligible or ineligible for the check-in template,
that eligibility is enforced when any of the review periods are selected.

If you want to exclude certain employees’ eligibility for performance documents, you can use HCM Data Loader.
Using the Performance Document Eligibility business object, you can process eligibility for specific employee
assignments, instead of all assignments. This way excluded assignments won’t be processed, and you can change
eligible assignments to ineligible or vice versa.

View Performance Document and Check-In Template
Eligibility  
This topic includes the procedure to view an employee's eligibility for performance documents and check-in templates.

To view an employee’s eligibility for performance documents or check-in templates, follow these steps:

1. Go to My Client Groups > Quick Actions > Show More > Talent > Performance Eligibility.
2. Search for the employee whose eligibility you want to view.
3. Click the employee's name in the search results.

Note:  The Performance Eligibility page displays all the performance documents and check-in templates that
match the person's eligibility.

4. (Optional) Click Check Eligibility to check for all performance documents and check-in templates listed.
5. (Optional) Click Add in the Performance Eligibility section to force employee eligibility for a performance document

they are ineligible for based on the eligibility batch process.
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6. (Optional) Click Add in the Check-In Template Eligibility to force employee eligibility for a check-in document they
are ineligible for based on the eligibility batch process.

7. (Optional) Click Edit to manually change the employee’s eligibility status. Options include:

◦ Keep Eligible—Force employee to remain eligible for performance documents they may become ineligible
for. This option is available only if the status is Eligible.

◦ Force Eligible—Force employee eligibility for performance documents they are forced ineligible for. This
option is available only if the status is Force Ineligible.

◦ Force Ineligible—Force employee ineligibility for performance documents they may become eligible for.
This option is available only if the status is Eligible or Forced.

Eligibility Batch Process for Performance Documents and
Check-In Templates  
You can run the Eligibility Batch Process to determine which standard and anytime performance documents a
population of workers is eligible to use for their performance evaluation.

You can also run the eligibility batch process to determine which population of employees are eligible to use check-in
templates for creating check-in documents.

Use the batch process to process eligibility for a specific performance document for all workers in an organization. Once
you run this process to determine employee eligibility, this is what happens:

• Eligible employees can have standard performance documents created for them by HR specialists. You can
create standard performance documents at the time of running the eligibility process or later.

• Anytime performance documents are available and can be created for eligible employees.

• Check-in documents are available and can be created for eligible employees.

Only employees who have access to the Scheduled Processes work area can run batch processes.

How the Batch Process Works  
The batch process evaluates the worker population for a specific performance document or check-in template and
selects those workers who are eligible based on the eligibility profile criteria.

The eligibility batch process determines eligibility for active as well as suspended assignments of the entire worker
population. Workers with more than one assignment can be eligible for a different performance document or check-in
template for each assignment.

The eligibility profiles used to determine eligibility for a performance document are those associated with the
performance document period in the performance template.

When the eligibility process is complete, standard performance documents, if configured, will be created for eligible
employees or can be created by HR specialists. Anytime performance documents and check-in templates are available
to workers, managers, and HR specialists to create documents for eligible employees.
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Eligibility Batch Process Parameters for Performance
Documents and Check-In Templates  
This table lists the parameters available to select for the eligibility batch process for performance documents and check-
in templates.

Parameter Description

Effective as of Date
 

This is a mandatory parameter. It determines when a worker population is eligible for performance
documents and check-in templates. If you set a future date, documents can only be created for eligible
employees from that date.
 
For scheduled processes, select Current Date to use the system date every time the process runs.
 

Review Period
 

This is a mandatory parameter. Using this, you can find a performance document or check-in template
that matches the selected review period.
 
By default, this displays the latest review period, but you can change it to find the performance
document or check-in template that you want to process.
 

Note:  If a check-in template is associated with multiple review periods, the eligibility for the check-
in template is the same regardless of which review period is selected.

Performance Document Name
 

This is a mandatory parameter when the batch process type is to assign performance documents.
Select the name of the performance document that you want to process.
 

Check-In Template Name This is a mandatory parameter when the batch process type is to assign check-in templates. Select the
name of the check-in template that you want to process.

Create Eligible Performance Document
 

If you select this, the application automatically creates performance documents for each eligible
employee.
 
This field only applies when running the eligibility process for performance documents:
 
The Maximum Number of Concurrent Threads for Performance Document Creation  option lets
you process multiple performance documents at the same time depending on the number of threads
allowed. The more threads allowed, the quicker the process will run but this in turn could affect system
resources being used for other processes. By default, 8 is recommended. When configuring this option,
 you should consider the impact on resources.
 

Purge Historic Performance Management
Eligibility Status Data
 

Choose whether to permanently delete the results of historic performance eligibility batch processes to
improve system performance.
 

Purge Data Older Than
 

Purge any results data older than the specified date.
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When to Run the Batch Process  
You can run the eligibility batch process on demand or schedule it to run at a later time or on a recurring interval.

Here are times when you run the batch process:

• A new review or evaluation period begins.

• You hire new employees.

• You add or remove eligibility profiles from a performance or check-in template.

• An eligibility profile associated with a performance or check-in template is changed.

• Worker status changes are made for criteria that are part of the eligibility profile, such as job, or location.

Run the Eligibility Batch Process  
When you run the batch process, you find performance documents or check-in templates based on the associated
review period that you can assign to eligible workers.

1. Go to My Client Groups > Performance.
2. Select the Eligibility Batch Process task in the Setup Maintenance area.
3. Select the type from the Batch Process Type list.

◦ Assign Performance Document

◦ Assign Check-In Template

4. (Optional) Choose to be notified when the process ends. Enable notifications beforehand to receive this notification.
5. (Optional) In Submission Notes, enter any information that helps identify this batch process.
6. Enter values for the parameters. For details, see Eligibility Batch Process Parameters for Performance Documents and

Check-In Templates.
7. Click Advanced to set up scheduling and notification preferences:

◦ Click the Schedule tab to either run this process as soon as possible or schedule it later. To schedule this
process, you can set up the frequency and choose a start date.

◦ Click the Create Notification icon in the Notification tab to notify recipients when the batch process
completes successfully, displays a warning, or errors out.

8. Click Process Options to specify your language, territory, time zone, and other preferences.
9. Click Submit.
10. (Optional) Click the Monitor Process button to monitor the status of the eligibility process.
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How can I improve the performance of the Performance
Management application?  
You can potentially improve the performance of your application and free up storage by permanently deleting
unnecessary data.

When you run the Manage Eligibility Batch process, there's an option for you to purge historic performance
management eligibility status data. You can even specify to purge data older than a specific date. Just remember that
you can't recover the data after you purge it.
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11  Performance Process Flows

Options for Performance Process Flow Setup  
Set up the process flow to include the tasks, and their sequence, used by the performance template for performance
evaluations.

You can create as many templates as you need, and each template supports an evaluation type, such as annual,
semiannual, and project evaluations. Your decisions determine the:

• Tasks and subtasks to include

• Task sequence

• Task names

You manage process flows using the Performance Process Flows task in the:

• Setup and Maintenance work area, Workforce Development offering, Worker Performance functional area.

• Setup Maintenance area

Tasks and Subtasks
A process flow can contain up to 9 tasks. Some of the tasks contain subtasks. The following table shows the tasks, along
with whether the task includes a subtask, which roles can perform the tasks, and a description of the task function.

Task Subtask Role that Performs Task Task Function

Set Goals
 

N/A
 

Worker, manager, or both
 

Add content to rate, such as
competencies, performance
goals, and development goals
to the performance document.
Include this task to let workers and
managers determine the content
the worker is evaluated on, and
expectations for the worker, for
example, at the beginning of an
evaluation period. If this task isn't
included, managers and workers
can still add content in the Worker
Self-Evaluation and Manager
Evaluation of Worker tasks.
 
You can select whether to allow
workers, managers, or both, to
complete the task. When they
complete the task, they can use the
Share action to allow the other role
to review the new content.
 

Worker Self-Evaluation
 

Subtask 1: Track Worker Self-
Evaluation
 
Subtask 2: Worker Self-Evaluation
 

Subtask 1: Manager
 
Subtask 2: Worker
 

Worker evaluates self. Worker can
also add content to be rated to
the performance document. The
manager:
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Task Subtask Role that Performs Task Task Function

• Can track the worker self-
evaluation to view any
changes the worker makes to
the performance document

• Can't view the ratings and
comments the worker
provides until the worker
completes the subtask

Manager Evaluation of Worker
 

N/A
 

Manager
 

Manager evaluates worker.
Manager can also add content
to be rated to the performance
document.
 
Select Do not allow additional
edit of manager evaluation
task when completed to prevent
managers from updating ratings
and comments once they submit
the task.
 

Participant Feedback
 

N/A
 

Manager, worker, or both
 

Select participants to provide 360-
degree feedback in a performance
evaluation by providing ratings,
comments, or both and completing
questionnaires. Send requests to
the participants, add questions
to questionnaires, and track
participant feedback to monitor the
status of the request and feedback.
 

First Approval
 

N/A
 

Manager
 

First task for the approver
to approve the performance
document of the worker at one
stage of the evaluation.
 
Select Automatically submit
approvals when preceding
task is completed to submit
the performance document for
approval automatically when
the previous task is completed.
The automatic submission for
approvals also applies when using
the Update Performance Tasks task
to move tasks forward or back to
a task that precedes an approval
task. The setting applies to both
the First Approval and Second
Approval tasks
 

Second Approval
 

N/A
 

Manager
 

Second task for the approver
to approve the performance
document of the worker at a later
stage of the evaluation.
 

Share Performance Document
 

Subtask 1: Share Performance
Document

Subtask 1: Manager
 

The manager shares the document
so the employee can view the
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Task Subtask Role that Performs Task Task Function

 
Subtask 2: Acknowledge Document
 

Subtask 2: Employee
 

manager's ratings and comments
and acknowledge it.
 
Managers can do any of these
actions:
 

• Share the document with the
employee while continuing to
edit it.

• Release the document to the
employee and no longer edit
it.

HR specialists can choose not
to allow managers to share the
document with employees during
the calibration period. When they
lock the document for sharing,
 managers see a banner explaining
that they can't share it when it's
locked.
 
The settings in the performance
template determine which of the
manager's ratings and comments
an employee can see on the shared
performance document.
 

Confirm Review Meeting Held
 

Subtask 1: Conduct Meeting
 
Subtask 2: Acknowledge Review
Meeting
 

Subtask 1: Manager
 
Subtask 2: Worker
 

After the worker and manager
meet to discuss the evaluation,
 the manager indicates that the
meeting was conducted, then the
worker acknowledges that the
meeting took place.
 

Provide Final Feedback
 

Subtask 1: Worker Provides Final
Feedback
 
Subtask 2: Manager Provides Final
Feedback
 

Subtask 1: Worker
 
Subtask 2: Manager
 

The worker, but not the manager,
 can provide final comments
about the evaluation in the Worker
Provides Final Feedback subtask.
The manager, but not the worker,
 can provide final comments in the
Manager Provides Final Feedback
subtask.
 
The Include digital signature
processing option is available
to compel workers to verify that
they're the people submitting
the performance document. The
option is available only in the
Worker Provides Final Feedback
subtask, so the task must be
included in the process flow to
activate it. If the option is selected,
 the signature is required from the
worker.
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Task Sequence
After you select the tasks to include as part of the process flow, you can change the task sequence. Some tasks are
logical in sequence. For example, it's likely that you would place the Set Goals task before the Worker Self-Evaluation
and Manager Evaluation of Worker tasks, and those before the First Approval task. However, you may decide not to use
all of those tasks. Your enterprise may not require the Set Goals task, and lets workers and managers add performance
goals, development goals, and competencies to the performance document as part of the evaluation tasks.

Other tasks have more flexibility. For example, you may want to schedule the Share Document task either before, or
after, the First Approval task, depending on when you prefer to let workers see the manager ratings.

During the performance evaluation, all tasks must be completed by the role that performs the task before the next task
can be started, even if the same role performs both tasks.

This rule doesn't apply to these tasks:

• Set Goals

• Participant Feedback

• Worker Self-Evaluation

• Evaluate Worker

You can perform the Set Goals task at the same time as the Participant Feedback task, but make sure you complete it
before other tasks.

You can configure the process flow to allow workers to perform the Worker Self-Evaluation and managers the Evaluate
Worker tasks concurrently. When you do so, managers and workers can perform their respective worker evaluation
tasks simultaneously or at different times. To use concurrent Worker Self-Evaluation and Evaluate Worker tasks, select
Evaluation tasks can be performed concurrently and consider the following:

• With the exception of two tasks, you must also specify the two tasks to be consecutive in the process flow so
there are no tasks between them.

• The Participant Feedback task can appear between the Worker Self-Evaluation and Evaluate Worker tasks.

• When you configure the sequence, remember to specify that one task or the other is completed first.

• Start the process flow with either the concurrent evaluations task or the Participant Feedback task, even if it's
not designated as the first in the sequence.

• Managers and workers can provide ratings and comments, and add additional content to the performance
document concurrently until they complete and submit the document.

• The task that's designated as the first must be completed first.

• When the role that performs the first worker evaluation task (typically the worker) submits the document after
completing the task, the other role can see the ratings and comments provided by the other.

• Workers can perform the Participant Feedback and Worker Self-Evaluation tasks concurrently, but only after the
Set Goals task is complete, if it's part of the process flow.

• Managers can perform the Participant feedback at the same time as the worker does the self-evaluation, or
when performing the Evaluate Worker task.

Task Names
You can configure the task and subtask names for both the manager and worker roles. The names you configure appear
on the application pages. You must configure task names separately for each process flow you set up.
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Related Topics
• Actions for Performance Document Approvals

Examples of Performance Process Flows  
You create process flows that are referenced by performance templates to create specific evaluations.

These examples show how to use process flows for some common review situations.

Creating a Process Flow for an Annual Review
Big Computers Company has an annual evaluation for all employees. Company policy requires these items for
performance evaluation:

• Employees and managers collaborate on adding content to the performance document.

• Both workers and managers are required to rate the worker.

• Managers are required to request and receive participant feedback from at least two sources to evaluate the
worker as part of the 360-degree evaluation.

When the manager and worker complete the evaluation, company policy requires this sequence of events:

1. The manager must seek approval for the completed performance document.
2. After the document is approved, managers must conduct a formal meeting with the worker to discuss the

evaluation, which the worker must acknowledge.
3. After the meeting, the worker can comment on the performance evaluation or the process, which the manager

can then reply to.

Big Computers Company plans to change the default names of the tasks and subtasks to reflect the company's terms.

The tasks and subtasks in this table show the process flow Big Computers Company uses to create the performance
documents for their annual review.

Task Order Default Task Name New Task Name Default Subtask
Name

New Subtask Name Roles

10
 

Set Goals
 

Set Competencies and
Goals
 

N/A
 

N/A
 

Worker
 
Manager
 

20
 

Worker Self-Evaluation
 

N/A
 

Subtask 1: Track
Worker Self-Evaluation
 
Subtask 2: Worker
Self-Evaluation
 

Subtask 1: Track
Employee Evaluation
 
Subtask 2: Evaluate
Yourself
 

Subtask 1: Manager
 
Subtask 2: Worker
 

30
 

Manager Evaluates
Worker
 

Evaluate Employee
 

N/A
 

N/A
 

Manager
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Task Order Default Task Name New Task Name Default Subtask
Name

New Subtask Name Roles

40
 

Manage Participant
Feedback
 

Request Feedback
 

N/A
 

N/A
 

Manager
 

50
 

First Approval
 

Approve Evaluation
 

N/A
 

N/A
 

Manager
 

60
 

Confirm Review
Meeting Held
 

N/A
 

Subtask 1: Conduct
Meeting
 
Subtask 2: Worker
Acknowledges Review
Meeting
 

Subtask 1: Confirm
Meeting
 
Subtask 2:
Acknowledge Meeting
 

Subtask 1: Manager
 
Subtask 2: Worker
 

70
 

Provide Final
Feedback
 

N/A
 

Subtask 1: Worker
Provides Final
Feedback
 
Subtask 2: Manager
Provides Final
Feedback
 

Subtask 1: Provide
Feedback to Manager
 
Subtask 2: Provide
Final Feedback
 

Subtask 1: Worker
 
Subtask 2: Manager
 

Create a Process Flow for a Project Review
The company has a special project for a group of workers to deliver a new module within six months for their existing
mobile application to beat a competitor. Big Computers Company wants to perform a simplified review of the workers
who worked on this important project. The workers are also subject to the annual performance evaluation in a few
months.

For the project review, these guidelines apply:

• Managers provide all the goals and the reviews as part of the Manager Evaluates Worker task.

• Workers aren't required to provide any goals or perform a self-evaluation on the project. The company wants
workers to focus on their work responsibilities, not the evaluation process.

• Manager evaluations must be approved.

• Managers must share the documents with the workers because the workers are required to acknowledge that
they reviewed the manager ratings.

• No meetings are required, since those can be combined with the meetings following the annual review.

• Big Computers Company keeps the default names of the tasks and subtasks.

The following table shows the tasks, along with who performs them, and the order that's required to create the process
flow.

Task Order Task Subtask Roles

10
 

Manager Evaluates Worker
 

N/A
 

Manager
 

20
 

First Approval
 

N/A
 

Manager
 

86



Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 11
Performance Process Flows

Task Order Task Subtask Roles

30
 

Share Performance Document
 

Subtask 1: Share Performance
Document
 
Subtask 2: Worker Acknowledges
Document
 

Subtask 1: Manager
 
Subtask 2: Worker
 

Concurrent Worker Evaluation Tasks  
The manager and worker can evaluate the worker concurrently during the performance evaluation when the
performance document is configured to allow it. With concurrent evaluations, managers and workers can perform their
respective worker evaluation tasks at the same time or at different times.

In either case, the managers and workers can provide ratings and comments and add additional content to the
performance document until they complete and submit the document. This allows managers to start working on the
evaluation before the workers complete it.

Configure Evaluation Tasks for Concurrent Evaluations
The performance document must be configured to allow concurrent evaluations to use the feature. Even though
evaluations can be performed concurrently, the document is structured so the worker must complete the self-evaluation
task first, or the manager must complete the evaluate worker task first. Typically, performance documents require the
worker to complete the self-evaluation task first.

The HR specialist configures the process flow to allow concurrent evaluations and the task order on Performance
Process Flows. Go to My Client Groups > Performance. In the Setup Maintenance area, select Performance Process
Flows. You can add a new performance process flow or search for an existing flow and edit it.

Add, Remove, and Update Content
Both the manager and worker can add performance goals, development goals, and competencies to the performance
document even while the other person is actively reviewing the worker. They can update goal details only when the
other role isn't currently performing the evaluation task.

These rules apply to removing content:

• The manager can remove content items during the evaluation, even if the worker has provided ratings or
comments for them.

• Workers are restricted to removing content items that they added and for which their managers haven't
provided ratings or comments.

• Neither the worker nor the manager can remove content items when they're performing their respective
evaluation tasks at the same time or after the manager submits the document.

View Added Competencies and Goals
Here's what happens after the worker or manager adds goals or competencies:

• They're available to the other role in the performance document immediately.
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• The content is visible when the performance document is opened.

• If both the worker and manager are performing the evaluation tasks at the same time, they can see the added
content when the section it was added to is refreshed.

For example, if a manager adds a goal to a performance document, the workers sees it when they select the tab for
the section containing goals. If the worker is already on the goals section, the worker must select another tab in the
document and return to the goals section to see the goal.

View Ratings and Comments
Ratings and comments aren't visible to the person who performs the final evaluation task until the other role submits
the performance document. For example, if the employee is required to complete a self-evaluation first, the manager
can only view the ratings and comments provided by the employee after the employee submits it. The manager ratings
and comments are visible to the employee after the manager submits the manager evaluation, or when there is an
approval after the manager evaluation and the approval is completed, or when the manager shares the document (if the
Share Performance Document task is enabled).

Note:  The manager can't share the performance document with the employee if it's locked for sharing during the
calibration period. This setting is enabled as part of the Document Periods section in the Performance Template page,
which is configured in the Setup and Maintenance work area.

Participant Feedback Task Options  
The HR specialist can include the Manage Participant Feedback task as part of the process flow to let participants
evaluate workers by providing ratings and comments.

Managers, workers, and participants can also supply feedback on a questionnaire as part of a multiparticipant
evaluation. You can set up the Manage Participant Feedback task so that managers, workers, or both, can:

• Select participants

• Request feedback

• Add questions to the questionnaire

• Track participants

HR can set this up without any special configuration, just by checking a box. You set up the process flows from My
Client Groups > Performance > Performance Process Flow (under the Setup Maintenance area). To create a new
performance process flow, click Add. You can also search for an existing performance process flow.

Include the Manage Participant Feedback Task
When you include this task, you enable others, such as peers, colleagues, matrix managers and other managers to
evaluate workers by providing ratings, comments, or both, on competencies, goals, and overall performance. You also
allow the manager, worker, and invited participants to answer a questionnaire in the performance document to gather
feedback to help the manager evaluate a worker. You create questionnaires using the template in the Questionnaires
feature of the Oracle Fusion Profile Management business process and add the questionnaire to the performance
template as a section.

To include participant ratings, you add the participant roles to the Profile Content, Performance Goals, Development
Goals, and Overall Summary sections in the performance template. To gather feedback on a questionnaire, you add the
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participant roles to the Questionnaire section. You configure performance templates using the Performance Templates
task in the Setup and Maintenance area.

Select Participants
You can specify whether managers, workers, or both, can select participants to provide ratings, comments, and
questionnaire feedback. When using questionnaires, managers or workers select the participant role, which determines
which questionnaire is available to the participant. Questionnaires are associated with particular roles in the
performance template.

Send Feedback
Managers can always request feedback by sending a request directly to a participant, who's notified by email of the
request. You can also specify whether to permit workers to request feedback directly to a participant without manager
approval. If you don't select the Worker can request feedback option, the worker can still add a participant to the list
of potential participants. But when the worker sends the request, the manager receives notification that the worker has
added a participant. The manager can then send the request directly to the participant if the manager supports the
request.

Add Questions to the Questionnaire
Specify whether to enable managers, workers, or both, to add questions they create to the questionnaire. The
questionnaire must also be configured to enable managers and workers to add questions. They can add questions only
to the section of the questionnaire that's configured to enable questions to be added.

Track Participants
You can specify whether managers, workers, or both, can track the status of participant feedback to see whether
a request was sent, the participants replied to the request, or they completed the feedback. The Worker can
view feedback before manager evaluation is visible option determines when workers can view feedback in the
performance document. If you don't select the option, a worker can see the participant feedback only after the Manager
Evaluation task is shared with the worker.

Reopen Participant Feedback
HR administrators can help participants who want to provide some more information in a worker's performance
document by allowing them to reopen feedback that's already been submitted.

You can select a check box for workers, managers, HR specialists, and participants to enable to reopen submitted
feedback in the Participant Feedback region in the Process Flow page in the Setup Maintenance area. A few things to
note:

• You can only reopen the submitted feedback if the Manage Participant Feedback task isn't complete.

• You won't be able to use the Worker can reopen submitted feedback check box if the process flow is in use.

• If you decide to use these options, then it doesn't affect when the Manage Participant Feedback task is
complete, but it means that feedback can't be provided and actions can't be performed.
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Options for Configuring Performance Documents to
Display Performance Ratings to Employees  
You can configure a performance document to make performance ratings and comments available to employees at
different points of a performance evaluation, or not at all.

The availability of performance ratings and comments to employees depend on configurations you make to these
Performance Management components:

• Process flow

• Sections in the performance template

Configure the Process Flow
When employees can see performance ratings and comments depends on the inclusion and order in the process flow
you configure for these tasks:

• Manager Evaluation of Workers

• Share Performance Document

• First Approval

You must include the Manager Evaluation of Workers task to the sections in which managers can rate and provide
comments on employee performance. Performance ratings and comments are available in four sections in the
performance document: Overall Summary (overall rating) Profile Content (competencies), Performance Goals, and
Development Goals. You configure process flows using the Performance Process Flows task in the Setup and
Maintenance work area or on the administrator's Performance page.

The table shows when the ratings and comments are available to employees depending on the tasks you added to the
process flow, and the order of the tasks.

Task Scenario Impact

Share Performance Document task is
included in process flow
 

Employees can view performance ratings and comments when the manager clicks either of these
buttons:
 

• Share and Edit

• Share and Release

First Approval and Manager Evaluation
of Workers tasks are included in process
flow; Share Performance Document task
isn't included
 

• If you place the First Approval task after the Manager Evaluation of Workers task, employees
can view performance ratings and comments when the approval task is completed.

• If you place the First Approval task before the Manager Evaluation of Workers task, employees
can view performance ratings and comments when the Manager Evaluation of Workers task is
completed.

Manager Evaluation of Workers task
is included in process flow; Share
Performance Document and First
Approval tasks aren't included
 

Employees can view performance ratings and comments when the Manager Evaluation of Workers
task is completed.
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Configure Sections in the Performance Template
Add and configure the Overall Summary, Profile Content, Performance Goals, and Development Goals sections in
the performance template. This lets managers share the ratings and comments and allows employees to access the
sections. Note these points when you configure the sections:

• You can add any, or all of the sections when the Manager Evaluation of Workers task is included in the
process flow.

• You configure the sections on the Structure tab of the performance template.

• You create and edit performance templates using the Performance Templates task in the Setup and
Maintenance work area or on the administrator's Performance page.

On the Structure tab, for the section you're configuring, do these actions:

1. In the Processing by Role section, add a row and select Manager.
2. In the Manager row, select Yes in these columns:

◦ Share Ratings: To share ratings with the employee

◦ Share Comments: To share comments with the employee

Note:  The default setting for both columns is No.

3. To make the section visible to the employee, add another row and select Worker. The Share Ratings and Share
Comments settings for the Worker row are set to Yes and you can't change their value because managers can
always view the employee ratings and comments.

How Performance Document Completion Status Is
Determined  
You define the tasks and subtasks that are included in a performance document in the process flow. The process flow is
used by a performance template to create performance documents.

The status of tasks and subtasks determines the completion status of the entire performance document.

Settings That Affect Performance Document Completion Status
Each task and subtask has a status. For example, the Set Goals task can be not started, in progress, or completed. When
a task has subtasks, its status derives from the status of its subtasks. The status of a performance document derives
from the status of all tasks in the document's process flow.

The following table shows the task statuses.

Task Roles Valid Statuses Has Subtasks?

Set Goals
 

Worker
 
Manager
 

Not started
 
In progress
 

No
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Task Roles Valid Statuses Has Subtasks?

Completed
 

Worker Self-Evaluation
 

Worker
 

Not started
 
In progress
 
Completed
 

No
 

Manager Evaluation of Worker
 

Manager
 

Not started
 
In progress
 
Completed
 

No
 

Manage Participant Feedback
 

Worker
 
Manager
 

Not started
 
In progress
 
Completed
 

Yes
 

First Approval
 

Manager as Requester
 

Not started
 
Approved
 

No
 

Second Approval
 

Manager as Requester
 

Not started
 
Approved
 

No
 

Share Performance Document
 

Worker
 
Manager
 

Not started
 
In progress
 
Completed
 

Yes
 

Conduct Meeting
 

Worker
 
Manager
 

Not started
 
In progress (visible only to the
manager after sharing the
document with the worker, before
the worker acknowledges the
meeting)
 
Completed
 

Yes
 

Final Feedback
 

Worker
 
Manager
 

Not started
 
In progress
 
Completed
 

Yes
 

Set Next Period Goals
 

Worker
 
Manager
 

Not started
 
In progress
 

No
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Task Roles Valid Statuses Has Subtasks?

Completed
 

Note:  The Manage Participant Feedback Task can be performed concurrently with the Worker Self-Evaluation and
Manager Evaluation of Worker tasks. It's completed when the manager submits the performance document or locks
the feedback to prevent any participants from providing additional feedback. The application permits the Manage
Participation Feedback task to be completed whether or not any participants submitted feedback.

In addition, two statuses appear for tasks in the performance evaluation business process that don't factor in the
completion status calculation:

• Ready indicates that the task is ready to be started and the status of the previous task in the process flow is
Completed. Not Started, by contrast, indicates the task hasn't been started and isn't ready to be started as the
status of the previous status isn't Completed.

• Missing indicates that a performance document hasn't been created. This status doesn't really exist in the same
way as other performance document statuses; it appears in the analytic Task Completion Status.

For subtasks, the status changes from Not started to In progress when the person performing the subtask saves a
performance document. When that person submits the performance document, or uses an equivalent action, such as
sharing or acknowledging the performance document, the subtask status changes to Completed. The following table
shows a summary of the possible subtask statuses.

Task Subtask Roles Valid Statuses

Share Performance Document
 

Share Performance Document
 

Manager
 

Not started
 
In progress
 
Completed
 

Share Performance Document
 

Share Performance Document
 

Worker
 

Not started
 
Completed
 

Conduct Meeting
 

Confirm Review Meeting Held
 

Manager
 

Not started
 
Completed
 

Conduct Meeting
 

Confirm Review Meeting Held
 

Worker
 

Not started
 
Completed
 

Final Feedback
 

Provide Final Feedback
 

Worker
 

Not started
 
In progress
 
Completed
 

Final Feedback
 

Provide Final Feedback
 

Manager
 

Not started
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Task Subtask Roles Valid Statuses

In progress
 
Completed
 

How Completion Status Is Calculated
The performance document status is derived from the task status, which is derived from the status of any subtasks
within the task. For tasks that have subtasks, the status is Completed when all the subtasks within the task are
completed.

The performance document statuses and the condition leading to each status for all available tasks are shown in the
following table.

Document Status What the Status Means

Not started
 

No tasks are started
 

In progress
 

At least one of the following tasks are in progress or completed: Set Goals, Worker Self-Evaluation,
Manager Evaluation of Worker, Manage Participant Feedback
 

Submitted
 

Manager submitted the performance document for approval
 

Approved
 

Approver approved the performance document
 

Document shared with worker
 

Manager completed the Share Performance Document subtask
 

Document acknowledged
 

Worker completed the Share Performance Document subtask
 

Review meeting held
 

Manager completed the Confirm Review Meeting Held subtask
 

Review meeting acknowledged
 

Worker completed the Confirm Review Meeting Held subtask
 

Worker final feedback provided
 

Worker submitted final feedback
 

Manager final feedback provided
 

Manager submitted final feedback
 

Completed
 

All tasks and subtasks are completed, excluding Set Next Period Goals
 

Canceled
 

Human Resource (HR) specialist or the manager canceled the performance document
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Relationship of Subtask Status to Task Status for One Subtask
If the process flow includes a task that has subtasks but only one subtask is configured, then the task status is the same
as the subtask status.

Relationship of Subtask Status to Task Status for Two Subtasks
The process flow definition includes the Final Feedback task. Both subtasks are configured: Worker Final Feedback
and Manager Final Feedback. The Manager Final Feedback subtask can't begin until the Worker Final Feedback task is
completed.

Subtask Status: Worker Final Feedback Subtask Status: Manager Final Feedback Task Status: Final Feedback

Not started
 

Not started
 

Not started
 

In progress
 

Not started
 

In progress
 

Completed
 

Not started
 

In progress
 

Completed
 

In progress
 

In progress
 

Completed
 

Completed
 

Completed
 

Performance Document Approvals  

Configure Performance Approvals  
You can set up approvals for performance documents to include multiple approval tasks, and a hierarchy of approvers.

When the manager or worker submits the document for approval, approvers receive notification that the document is
ready for approval, and they can approve or reject the document in multiple locations.

Configuring Approval Tasks in the Process Flow
To use approvals, you must configure the process flow to include an approval task. You set up process flows using the
Performance Process Flows task in the Setup Maintenance work area. You can set up process flows to require one,
two, or no approval tasks. If you include approval tasks, you can place them in whatever order your business process
requires. For example, you might want to create a process flow with the First Approval task after the Manager Performs
Worker Evaluation task, and the Second Approval after the Final Feedback task.

When each approval task is reached, the manager must submit the performance document for approval, even if the
worker performs the task before the approval task. The document goes through the entire approval process so all
required approvers must approve the document before the evaluation continues.

You can configure performance process flows to skip the action of submitting performance documents for approval.
By enabling auto-submit for approval tasks, when the preceding task is completed, the approval task submits
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automatically. You can select auto-submit on the Performance Process Flows page, in the Approval, Review and
Meetings section. This setting applies to both the First Approval and the Second Approval task.

Configuring Approval Hierarchy and Notifications
The predefined approval chain includes the manager of the manager of the worker being evaluated. However, you can
add additional levels of approvers and other roles, such as HR specialist. Other roles must have the correct privilege for
approvals and a data security profile that lets that includes access to the worker whose performance document they're
asked to approve. You set up approvals and the associated notifications using the Define Approval Management for
Human Capital Management task. To add the HR specialist as an approver, you must also add an area of responsibility
for the HR specialist using the Areas of Responsibility task in My Client Groups > Quick Actions > Show More > Areas of
Responsibility.

Configuring Approval Rules
HR specialists can configure an approval rule for performance documents to use the current assignment hierarchy
instead of the primary assignment in a hierarchy. So if they submit a performance document on an employee's
nonprimary assignment for approval, it's routed using the nonprimary assignment hierarchy.

You can set up multiple level approvals for performance documents using the manager's current or primary
assignments. If a performance document has multiple levels of approvals and the approvers have multiple assignments,
then you can route approvals using the assignment hierarchy of the employee, or route them using the manager's
primary assignments.

If multiple approval rules exist, HR specialists can use parallel approvals in an approval rule to send approval requests to
multiple participants at the same time. Only the first person to respond needs to process the approval.

Notifications
When you activate notifications, each approver receives worklist and email notification that a document was submitted
for approval. The notification contains a link to the performance document so the approver can view it. When all
approvers have approved or rejected the document, the worker's manager receives notification whether the document
was approved or rejected. The approval process is repeated if a manager resubmits a document after rejection, or
a second approval task is configured in the process flow. If the performance document is approved, the next task in
the process flow becomes available or if the approval is the last task, the performance document is completed. If the
approval is rejected, then the previous task in the process flow becomes the current task so any requested changes can
be made before the approval task is resubmitted.

Actions for Performance Document Approvals  
When a manager submits a performance document for approval, this action starts the transactional approval task.

Let's discuss what happens after this event and the impact of other approval actions on the status of the performance
tasks. Approvers receive notification that the document is ready for approval. They can approve or reject the document
in multiple locations. They can also perform other actions, such as requesting more information, or reassigning or
delegating the approval to someone else.

If a second approval task is required for a document, the normal process applies. For example, you can have two
approval tasks connected by the same performance document with separate approval transactions. In this case, the
approval tasks could be an approval to review what to evaluate, and another approval to review the evaluation and
discuss ratings.
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Approval Actions
As part of the approval process, approvers can take a number of actions on a performance document. These actions
include:

• Approve

• Reject

• Request Information

• Reassign

• Delegate

• Suspend

• Resume

The locations where approvers can perform approval process actions are shown in the table.

Location Details

Worklist, email notifications, and
performance document
 

Use the Actions menu to approve or reject the document, or perform other approval process actions.
Not all actions are supported in the email notifications. You approve or reject the approval once only.
Use the worklist, email, or a link in the performance document.
 
Select the Approve or Reject buttons on the performance document. No other approval process
actions are available on the performance document.
 

Transaction Console
 

HR specialists use the Transaction Console to perform approval process actions, such as: reject,
 terminate, and so on.
 

Task Status After Rejection
If a performance document is rejected, the Manager Evaluation of Workers task is set to In progress so the manager
can update the document. If you need to change the status of other tasks before resubmitting the manager evaluation,
the HR specialist can use the Performance Documents task.

Reassign and Delegate
Approvers can either reassign or delegate approval to another manager. Reassignment and delegation are valid only for
one approval task.

Bypass
Bypass the Performance Approval task to separate it from the transactional approval task. Continue the evaluation
process when approvers are unable to approve the performance document. For example, if they're on leave. Bypassing
the performance approval task automatically aborts the transactional approval task. The HR specialist can advance the
performance document to the next task using the Performance Documents task.

Terminate
If the transactional approval task is terminated, then HR specialists can bypass the performance approval task to move it
to the next task.
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Related Topics
• Options for Performance Process Flow Setup

• How You Define Approvals for Human Capital Management

• Approval Management Configuration Options for Oracle Fusion Human Capital Management

• Manage Workflow Transactions

• How You Manage HCM Approval Transactions

Performance Payload Attributes  
You can use the performance payload attributes listed in the following table when defining approval conditions in the
Transaction Console.

Condition Attribute Value to Enable Manual Approval Description

attribute1 User defined value. Performance document name.

attribute2 User defined value. Primary line manager sign in or username.

attribute3 User defined value. Workers display name.

attribute4 System generated value, sequence. Evaluation ID.

attribute5 System generated value, sequence. Worker ID.

attribute6 System generated value, sequence. Manager ID.

attribute7 User defined value. Primary approval manager sign in or username.

attribute8 System generated value, sequence. Worker assignment ID.

attribute10 User defined value. Performance template name.

attribute11 User defined value. Performance process flow name.

attribute12 User defined value. Performance document type name.

AttributeNumber1 User entered value. Manager overall summary numeric rating.

AttributeNumber2 Dynamic value. Manager overall summary calculated score.
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12  Performance Template Sections

Considerations for Creating Performance Template
Sections  
You must create a section for each task that requires a section used in the process flow. You create sections using the
Performance Template Sections task in the Setup and Maintenance work area.

When you create a section, remember to specify the type. Depending on the type, you can also set these items:

• Whether the section is rated or weighted

• Which calculation method to use to determine worker ratings, if using calculated ratings

• Which rating model to use to rate workers

• Content item processing options

• Content items to include

After you create the sections, they're available for you to use in the performance template. In the performance template,
you can create sections or select and edit previously-created sections.

Section Types
The section types are:

• Profile Content, to rate worker competencies

• Performance Goals, to rate worker performance goals

• Development Goals, to rate worker development goals

• Questionnaire, to allow managers, workers, and participants to provide feedback about the worker

• Overall Summary, to provide the overall rating of the worker

• Worker Final Feedback

• Manager Final Feedback

Note:  Note that competency sections with a text field type aren't supported in performance documents.

You must define a section for the tasks that appear in the process flow that require a section. Each section corresponds
to an evaluation topic or section in the performance document.

Did you know that you can include multiple competency type sections? Use them to evaluate different groups
of competencies separately. For example, configure a competency section to populate with competencies for an
employee's job profile. Configure another to populate with the organization's competencies.

Note:  To add multiple competency type sections, you must first enable Enhanced Talent Profile Management. For
information about how to upgrade to the Enhanced Talent Profile Management, see Upgrading Oracle Cloud HCM
Profile Management on My Oracle Support (Doc ID 2421964.1). Then you can define competency sections using the
Competencies Template in Enhanced Talent Profile Management.
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The tasks that require a section, and the sections that you need to include are in the table.

Task Required Section

Set Goals
 

At least one of:
 

• Profile Content (for Competencies)

• Performance Goals

• Development Goals

Worker Self-Evaluation
 
Manager Evaluations of Workers
 

At least one of:
 

• Profile Content (for Competencies)

• Performance Goals

• Development Goals

• Overall Summary

Manage Participant Feedback
 

At least one of:
 

• Profile Content (for Competencies)

• Performance Goals

• Development Goals

• Overall Summary

• Questionnaire

Worker Provides Final Feedback
 

Worker Final Feedback
 

Manager Provides Final Feedback
 

Manager Final Feedback
 

Section Ratings and Weighting
For the Profile Content (for Competencies), Performance Goals, Development Goals, and Overall Summary sections,
you can select whether to enable section ratings, comments, or both. When you enable section ratings and comments,
managers, workers, and participants can select a rating for the section and provide comments. For the Profile Content
(for Competencies), Performance Goals, and Development Goals sections, they can rate the section separately from
the individual content items contained within the section. For the Profile Content section, the content items are
competencies. The Performance Goals section contains performance goal items. The Development Goals section
contains development goal items.

Managers, workers, participants, and matrix managers can use the calculated ratings as a guide to manually select their
ratings. For the Profile Content, Performance Goals, and Developments Goals sections, the application calculates ratings
based on ratings on individual items in the section. For the Overall Summary section, the application calculates ratings
using the section ratings from the Profile Content, Performance Goals, and Development Goals sections

You can select to weight a section, or items, in a section to place more or less importance on the section or item. The
application can use the weights to calculate section and overall ratings.
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If you have multiple competency sections, you can configure them differently to determine who sees it and whether it's
rated. If you have additional competency sections which are rated, then the application considers them in the overall
rating if it's calculated, and their weights if configured.

Calculation Rules
You can have the application calculate the employee's performance rating in addition to having workers and managers
manually enter ratings in these sections:

• Overall Summary

• Profile Content

• Performance Goals

• Development Goals

For the Overall Summary section, the application uses the calculation rule you select to determine overall ratings
for performance based on the calculations for the Profile Content (for Competencies), Performance Goals, and
Development Goals sections. Select one of these calculation methods for the sections:

• Average

• Sum

• Band

• Fast formula

For the calculation rules, you must also specify these items:

• Fast formula (if used)

• Decimal places

• Decimal rounding rule

• Mapping metric

• Mapping method

Rating Models
In the Overall Summary, Profile Content (for Competencies), Performance Goals, and Development Goals sections, you
use rating models to rate the workers. You set up rating models in the profile management business process using the
Profile Rating Models task in the Setup and Maintenance work area. If you use a particular rating model to rate the items
in a section, you can do one of these actions:

• Use the same rating model to rate the section itself

• Select a different model to rate the section

Content Item Processing
For the Profile Content, Performance Goals, and Development Goals sections, you select the ratings and calculation
rules to use to determine rating scores for the content items, goals, and competencies, if your organization uses
calculated ratings. If you use performance rating types for the section, you can select different rating models to rate
individual items in the section. The calculation rules are applied to each item, then combined using the calculation rule
you selected for the section to determine the section rating. To use this feature for the Profile Content (Competency)
sections, you can select Proficiency, Performance, or Proficiency and Performance as the rating type. For the
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Performance Goals and Development Goals sections, the Performance rating type applies automatically. Only items
added directly to the template are eligible for separate rating models. Items added to the performance document by
managers or workers use the performance rating model specified for the section.

Section Content
In the Section Content section, you specify the source of content items. You can also designate additional items to
appear in the section.

Information Sources for Profile Content Section
For the Profile Content section, you can select to populate competencies from the model profile related to the worker's
job, job family, position or organization. You can also select a specific profile from which to populate competencies.
Profiles are maintained in profile management business process. When you create the performance template you can
also add competencies directly to it. Weights and minimum weights associated with competencies from a model profile
are also populated in the performance document.

Workers and managers can use the update action in the performance document to include new competencies added to
the profiles configured for the section. The document updates to include additional content added to the model profiles
since the performance document was created or last updated. The weight and minimum weight are only populated in
the performance document when the competency is added to the performance document. Subsequent changes to the
competency weight and minimum weight in the model profile don't update the weights for competencies that already
exist in the performance document.

Writing Assistant
In the Profile Content section, you can select Enable the writing assistant for manager to assist managers in writing
useful comments about worker competencies in the performance document. The writing assistant feature provides
suggestions for comments that are associated with competencies and their correlated proficiency levels.

Information Source for Performance Goals Section
For the Performance Goals section, select Populate with Worker Goals to add goals from goal plans in the goal
management business process to the performance document. To update goals in performance documents with weights
that are revised in the goal management business process, select Allow update goals action to update goal weights
from goal management business process.

The Evaluation Type which is configured in the Performance Goal template section determines how a goal plan is
evaluated in a performance document.

If employees have more than one goal plan that needs to be evaluated in a performance document, that can be
configured differently in the performance template section. For example, a person goal plan could be configured to
provide ratings and comments at the goal level and an organization goal plan configured to only provide a section
rating and comment. The evaluation type determines which goal section the goal plan maps to and how it will be
evaluated. When you create a performance document, goal plans that have the same evaluation type as performance
goal sections defined in the performance template are automatically added as evaluation topics.

When managers or workers edit the worker's goals in the goal management business process that already exist in the
performance document, the changes are updated in the document using two methods:

• When the manager or worker opens the performance document, all edits to performance goals, except weights,
are reflected in the performance document.
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• When the manager or worker uses the Update Goals action in the performance document, goal edits, including
weights appear in the document.

To populate the performance document with new performance goals from the goal management business process they
must use the Update Goals action.

Information Source for Development Goals Section
To add goals from the career development business process, select Populate with workers development goals
covering any part of evaluation period in the Development Goals section for the relevant time period. You can select
additional options to determine which development goals appear in the performance document:

• Include future development goals starting after evaluation period

• Exclude inactive development goals

When managers or workers edit the worker's existing goals in the career development business process, the changes
are reflected in the performance document when it's opened. To populate the performance document with new
development goals from the career development business process, they must use the Update Goals action in the
performance document.

Content Items
You can add content items to the Profile Content, Performance Goals, and Development Goals section definitions. When
you use those sections in the performance template select the Load Items from Section action on the Content tab to
add the items to the template. The content items in the template appear in the performance documents created from
the template.

Related Topics
• Profile Types

How can I create multiple competency type sections?  
Create multiple competency type sections to evaluate different groups of competencies separately.

Here's a list of configuration options:

• Configure a competency section to populate with competencies for an employee's job profile.

• Configure a competency section to populate with the organization's competencies.

• For multiple competency sections, you can configure them differently to determine who sees it and whether it's
rated.

• If you have additional competency sections which are rated, then the application considers them in the overall
rating if it's calculated, including the section weights.

To add multiple competency type sections, you must first enable the Enhanced Talent Profile Management. For
information about how to upgrade to the Enhanced Talent Profile Management, see Upgrading Oracle Cloud HCM
Profile Management on My Oracle Support (Doc ID 2421964.1).Then you can define competency sections using the
Competencies Template in Enhanced Talent Profile Management.

1. Go to My Client Groups >  Performance. Select Performance Template in the Setup Maintenance region.
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2. Select the Structure tab in the Performance Template page. In the Section Processing region, select the
profile content as the Section Type.

3. Select the profile competency section name. This is based on the Competencies Template you defined in
Enhanced Talent Profile Management.

4. Repeat steps 2 and 3 to add more competency sections to the performance template.

Employees and managers can select the multiple competency sections from Evaluation Topics on the
Performance Document page.

After you enable Enhanced Talent Profile Management, the performance template doesn't support the configuration
Use specific profile. Instead you can create an additional competency section in the performance template. For
example, if you use the Use specific profile for organization competencies with Classic Profile Management enabled,
then in Enhanced Talent Profile Management, you can define a new Profiles Competency Section to include the
organization competencies as the specific profile.

Considerations for Adding or Removing Competencies in
Talent Profile Competency Sections  
Here are some things to consider when adding or removing competencies in talent profile competency sections.

• Competencies added by managers or employees to the performance document are added to the employee's
talent profile with the evaluator type configured in the performance template.

• Talent profile approvals aren’t triggered when adding or removing a competency directly in a performance
document person profile competency section. If you use approvals in talent profiles and don’t want these to be
bypassed in the performance document, you can use personalization to hide the add and remove buttons in
the performance document.

• Any changes made to competencies in a person profile competency section in a performance document
will update any other in-progress performance documents with person profile competency sections where
the set goals or evaluation tasks aren't complete. For example, if a new competency is added in a midyear
performance document, that competency is displayed in the employee’s talent profile and added to the end of
year performance document, if created.

• Only competencies added directly in performance documents can be deleted. Competencies in an employee's
talent profile that have come from another source, can’t be removed in performance documents, and must be
removed from the original source.

• Competencies deleted by employees won’t be removed from other in-progress performance documents if
they’ve already been evaluated by the manager.

Update Performance Document Model Profile
Competency Sections  
You can run the Update Performance Document Model Profile Competency Sections process to update competency
sections in performance documents populated using a model profile.
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You can run the process to add any new competencies that were added to job, position, or organization profiles to
performance documents that use those profiles.

The process only updates in-progress performance documents. In-progress performance documents indicate when any
of the evaluation tasks; worker self-evaluation, manager evaluation, and manage participant feedback are incomplete.

Also, the process adds only new competencies to performance documents. If performance documents include
competencies that are no longer relevant, then you need to manually remove them. Competencies that are end dated in
Profiles aren’t automatically removed from performance documents.

Populate Performance Documents With Person Profile
Competencies  
You can configure a competencies section in a performance template so that it populates the competencies from the
employee's Talent person profiles in their performance documents.

This gives employees the opportunity to be evaluated on other individual competencies that aren't populated based on
their job, position, or organization.

Before you start

• Set the ORA_HRA_PERSON_PROFILE_COMP_SECTION_ENABLED profile option to Yes.

Here's what to do

1. Navigate to My Client Groups > Performance Templates.
2. Create a performance template.
3. In the Structure tab, create a section to include a Competencies section type.
4. Select the competencies section type from the Section Name drop-down list. This lists the competency sections

defined in Profile Management.
a. The competency section defined in Profile Management must be associated with an Item Value Set and

have at least one Evaluator Type configured that is visible to both employees and managers.
b. The competency section defined in Profile Management must be associated with an Item Value Set and

have at least one Evaluator Type configured that is visible to both employees and managers.
5. In the Section Content, select Populate with competencies using profile and then select Person as the Profile Type.

This validates if the Competencies Section Name defined in Profile Management has at least one Evaluator Type
configured that's visible to both employees and managers.

6. Complete details in the Processing By Role section.
7. Save the performance template.

Here are some things to consider when adding or removing competencies:

◦ When you add or remove a competency from an employee's person profile, any in progress performance
documents are automatically updated. There's no need to manually update the performance document.

◦ You can exclude competencies that don’t need evaluating by marking them as not ready to evaluate, rather
than removing them from the performance document.

◦ If a competency is removed from an employee’s Talent person profile but has been evaluated in a
performance document and has ratings or comments from a contributor (worker, manager, or participant)
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then it won’t be removed from the performance document. If the ratings or comments are removed and the
performance document is updated, then the competency is removed from the performance document.

Calculated Ratings  
You can set up calculated ratings to automatically calculate ratings in performance documents. The application can
calculate the overall performance rating in the Overall Summary section, and section ratings in the Profile Content,
Performance Goals, and Development Goals sections.

The calculated rating derives from a score calculated from ratings provided by workers, managers, and participants
using the calculation rules defined in the sections. The application maps the calculated score to the actual calculated
rating based on the rating model used for the section.

In the performance template and performance template section, you can set up performance documents to:

• Calculate and display the ratings provided by workers, managers, matrix managers, and other participants.

• Display calculated ratings along with, or instead of, manual ratings.

• Use the provided calculation rules or company-defined fast formulas to calculate ratings.

Where Calculated Ratings Appear
Calculated ratings appear at the top of the section for which they apply. To view calculated ratings, all roles must click
the calculator icon that appears at the top of the section. Everybody who rates the worker can see their own calculated
ratings, if configured to do so. Managers and matrix managers can view calculated ratings provided by the worker and
participants.

The calculated rating appears as stars when star ratings are configured. The rating level description for the calculated
rating appears when star ratings are not configured. In both cases the calculated score appears in parentheses after the
ratings. The calculated rating is rounded to the closest rating level value as determined by the rounding and mapping
settings.

Calculated Ratings and Compensation Management
Calculated overall ratings, along with overall ratings provided by managers, can be used by Oracle Fusion Compensation
Management. The settings to determine whether they appear there are available in the Compensation Management
business process. The calculated ratings that appear in Compensation Management are the calculated scores.

Calculated Ratings Roll Up
You can set up the template so that any or all of the sections use calculated ratings. When you enable calculated ratings
in the Profile Content, Performance Goals, or Development Goals sections, the application:

• Uses the ratings that managers, workers, and matrix managers and other participants provide on individual
items in the section

• Performs roll-up calculations to determine the rating for the respective section automatically

• Uses the calculated ratings for the Profile Content, Performance Goals, and Development Goals sections to
determine the overall calculated rating in the Overall Summary section
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How You Use Fast Formulas in Performance Documents  
You can configure fast formulas to calculate section ratings for workers in a performance document.

Fast Formulas and Database Items
Fast formulas contain the items and rules used to calculate the section rating, and can be based on ratings provided
on the items by workers, managers, and participants. You create the fast formulas using the Performance Rating
Calculation type. To the fast formula you add Database Items (DBI). These items can calculate ratings on attributes
besides the overall item rating. For example, you can use DBIs to rate other attributes on a goal, such as the
measurement attributes, rather than the overall goal. You create fast formulas using the Manage Fast Formulas task in
the Setup and Maintenance work area.

For more information, see the Complete List of HRA Database Items for Calculated Ratings (Doc ID 2444793.1) on My
Oracle Support at http://support.oracle.com.

Calculated Rating Setup in the Performance Template Section and
Performance Template
You configure the sections of the performance document to use fast formulas. Fast formulas can calculate ratings for
the Overall Summary, Profile Content (Competencies), Performance Goals, and Development Goals sections. You can set
up any, or all, these sections in a performance document to calculate ratings.

In the section, you must select the fast formula calculation rule. In addition, you select the fast formula rule. To use
calculated ratings, you must also select the option to use calculated ratings on the Process tab of the performance
template. You also must select which roles can see calculated ratings.

Guidelines for Setting Up Calculated Ratings in
Performance Templates and Sections  
You can use calculated ratings to automatically calculate a worker's overall performance rating in the Overall Summary
section, and section ratings in the Profile Content, Performance Goals, and Development Goals sections.

To configure calculated ratings, you select from the following options:

• Calculated ratings activation and display options

• Section rating model and calculation rules

• Decimal places

• Decimal rounding rule

• Mapping metric

• Mapping method
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You configure calculated ratings for the template on the Process and Structure tabs of the performance template. To
configure a template, use the Performance Templates task in the Setup and Maintenance work area. Go to My Client
Groups > Performance > Setup Maintenance > Performance Templates.

You can also configure sections using the Manage Performance Template Sections task. Go to My Client Groups >
Performance > Setup Maintenance > Performance Template Sections.

Calculated Ratings Activation and Display Options
On the Process tab of the performance template, select Calculate ratings to enable the application to calculate section
ratings. When you select this option, all sections for which ratings are enabled, use calculated ratings. The overall
summary rating is always calculated using the calculated section ratings, not the manually entered section ratings.

You select from the following options to display the ratings, which apply to all sections:

• Display calculated ratings to worker

• Display calculated ratings to manager

• Display calculated ratings to participants

• Display calculated ratings to matrix managers

Calculated ratings of matrix managers and other participants display to both managers and workers if they're allowed to
see manually entered ratings.

If you select Use calculated ratings only, the following applies:

• Only calculated ratings appear and managers, workers and participants can't enter ratings manually.

• Calculated ratings become the official section ratings.

• Although only the calculated section ratings display in the performance document, both calculated and manual
section ratings are populated in the database. When the performance document is complete, the ratings are
passed to Profiles.

Section Rating Model and Calculation Rules
To enable calculated ratings in a section, you must select a rating model for the section, for example Performance
Rating Model, Language Rating Model, or Proficiency Rating Model.

In addition, you must select the type of calculation rules to use for rating the section. The options are: Fast formula,
Average, Sum, and Band. You can specify the calculation rules either using the Manage Performance Template Sections
task, or on the Structure tab of the performance template.

You can select different calculation rules for each section within a performance template. The application uses the
calculation rules for the Overall Summary section to determine the calculated overall rating.

For the Average, Sum, and Band methods you can weight sections and items within the sections. Weights let you place
more or less importance on particular sections and items.

Decimal Places
You can select the number of decimal places, up to a maximum of two, that appear in the performance document
or Compensation Management pages for the calculated numeric score used to determine the calculated rating. The
default value is 2.
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Decimal Rounding Rule
In the performance section, you select the rounding rules to determine how the calculated numeric score is rounded to
the final value. The rounding is applied to the rounding decimal, which is the last decimal set in the Decimal Places field.
For example, if you set the Decimal Places value at 2, the rounding is applied to the second decimal. The default value is
Standard.

The table shows the available rounding rules, the effects of selecting each rule, and examples of how the rules are used
to determine calculated ratings.

Rounding Rule Effect Example

Standard
 

Rounds up when the rounding decimal is 5 or
greater, and down when the rounding decimal
is 4 or less.
 

If the calculated rating is 3.4867, and the
decimal place setting is 2, the final calculated
rating is 3.49. If the calculated rating is 3.4849,
 and the decimal places setting is 2, the final
calculated rating is 3.48.
 

Up
 

The value always rounds up.
 

If the calculated rating is 3.4940 or 3.4960
and the decimal place setting is 2, the final
calculated rating is 3.50. If the calculated rating
is 3.49 and the decimal place setting is 2, the
final calculated rating is 3.50.
 

Down
 

The value always rounds down.
 

If the calculated rating is 3.4940 or 3.4960
and the decimal place setting is 2, the final
calculated rating is 3.49.
 

Mapping Metric
The mapping metric determines how to map the calculated numeric score to a rating level in the rating model. You can
select either of these attributes of the rating model to map the calculated score of the section to the rating level:

• Numeric rating--Maps the calculated numeric score to the single-value numeric rating, and the corresponding
rating level. Numeric rating is the default for the Average and Fast formula calculation rules for the section.

• Points range--Maps the calculated numeric score to the points range and the corresponding rating level. Points
range is the default for the Band calculation rule for the section.

Mapping Method
The mapping method determines the rating when no exact match exists between the calculated rating and a rating level
from the rating model used in the section. When rounding rules are used, the calculated rating value is mapped after
the rounding rule is applied.

The table shows the available mapping methods and the effects of selecting each one.

Mapping Method Effect for Numeric Rating Mapping Metric Effect for Points Range Mapping Metric

Highest
 

Uses the next numeric rating greater than the
calculated average.
 

Uses the next review point greater than the
calculated average.
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Mapping Method Effect for Numeric Rating Mapping Metric Effect for Points Range Mapping Metric

Lowest
 

Uses the next numeric rating less than the
calculated average.
 

Uses the next review point less than the
calculated average.
 

Nearest
 

Uses the numeric rating closest to the
calculated average.
 

Uses the review point closest to the calculated
average.
 

Using the numeric rating for metric mapping, for example, assume the rating model has the following entries for
numeric rating and short description:

• 1-Weak

• 2-Poor

• 3-Average

• 4-Good

• 5-Excellent

If the application calculates a rating of 3.2 (between Good and Average, but closer to Average), the mapping method
determines which entry the application uses:

• Highest yields the next numerically highest rating--in this case 4, or Good.

• Lowest yields the next numerically lowest rating--in this case 3, or Average.

• Nearest yields the numerically closest rating--in this case 3, or Average.

If the calculated rating falls exactly halfway between two ratings in the rating model, the application assigns the
numerically higher of the two ratings.

Related Topics
• Overview of Using Fast Formulas

Considerations for Using Performance Template Section
Calculation Rules  
To use calculated ratings, you must select the type of calculation rules to use for rating Profile Content, Performance
Goals, Development Goals, and Overall Summary performance template sections.

You can change the calculation rule for the section selected in the performance template where the section is used. The
options are:

• Average

• Sum

• Band

• Fast Formula
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Each of these settings has a default mapping metric to help determine the final numeric level to assign to the rating.
However, you can change the mapping metric from the default to another. The mapping metric options are:

• Numeric rating

• Points range

To use numeric ratings, the rating model configured to rate the section and items in the section must have the numeric
rating attributes defined for the rating levels. To use the points range, the rating model must have defined review points
as well as point ranges (from points and to points).

Average Method
To use this method, the rating models associated with the section and its content items must define numeric ratings
that correspond to the rating descriptions. The application first calculates the average of the item ratings to determine
the section rating. Then the application calculates the average of the section ratings to determine the overall rating. The
application uses the numeric ratings to calculate a weighted average if weights are configured to be used; otherwise,
it calculates a straight average. It then converts this average back to a performance document rating, using the rating
model.

For the points range mapping metric, the application:

• Calculates the total numeric score using the numeric ratings defined in the rating model

• Converts this total into the corresponding review rating for the section by mapping the total numeric score to
the points range

Sum Method
To use this method, the rating models associated with the section and the items in the section must also use numeric
ratings. The application:

• Uses the numeric ratings as defined in the rating model

• Calculates the total numeric score

• Converts this total into the corresponding review rating for the section by mapping the total numeric score to a
rating level

• Ignores items without ratings

When using the sum method for the overall rating, section rating calculation rules can be sum or average only.

For points range metric mapping, the application:

• Uses the numeric ratings as defined in the rating model

• Calculates the total numeric score

• Converts this total into the corresponding review rating for the section by mapping the total numeric score to
the points range

• Ignores items without ratings

Band Method
This method is similar to the sum method, but is available only for the Overall Summary section of a performance
document. The Profile Content, Performance Goals, and Development Goals sections, however, use the average or sum
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method. To use the band method, the rating model that is associated with the Overall Summary section must define
review points as well as point ranges (from points and to points).

During the calculation process, the application:

• Calculates the total numeric score across all sections

• Maps this total into the equivalent rating level using the points range

For numeric rating metric mapping, the application:

• Calculates the total numeric score across all sections

• Converts this total into the corresponding review rating for the section by mapping the total numeric score to a
rating level

Fast Formula Method
Fast formulas are formulas you create from Performance database items. By default, these use numeric ratings metric
mapping. For numeric ratings, the application:

• Calculates the total numeric score based on the fast formula

• Maps the score to the rating level

For the points range mapping metric, the application:

• Calculates the total numeric score based on the fast formula

• Maps this total into the equivalent rating level using the points range

You can't configure weights to be applied to the results of a fast formula. However, you can build weights into the fast
formula.

Related Topics
• Overview of Using Fast Formulas

Options for Item Processing in a Performance Template
Section  
When you enable content items for a section, you specify the rating type, item calculation, and properties.

You configure item processing on a section using the Performance Template Sections task in the Setup Maintenance
work area.

Rating Type
Rating types determine the rating models that are available for workers and managers to use to select the content item
ratings in the performance document and to calculate the item ratings.
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Let's look at the available rating types for Profile Content sections:

• Proficiency: Workers and managers can select the proficiency level for items on the performance document.

• Performance: Workers and managers can select the performance rating on the performance document.

• Proficiency and performance: Workers and managers can select both a proficiency level and a performance
rating on the performance document.

For the Performance Goals and Development Goals sections, only the Performance rating type is available.

When you select either Performance or Proficiency and performance rating types, you can use the same rating model
for content items that the section uses, or select another. You can also select different performance rating models
for individual content items. This enables your organization to rate some performance goals that may be specific to a
department using a different rating model than that used for organization-wide goals, for example.

Check out the proficiency levels in the Oracle Fusion Profile Management when the performance document is
completed. Performance ratings for competencies and goals aren't published to Profile Management.

Item Calculation
The item calculation method determines how the item is rated.

When the rating type is Proficiency and performance, you can select:

• Proficiency: Proficiency ratings calculate the score for a specific item.

• Performance: Performance ratings calculate the score for a specific item.

• Proficiency multiplied by performance: The application multiples the proficiency point value by the
performance point value to calculate the score for a specific item.

You can't change the default values for the item calculation method if the rating type is either Proficiency or
Performance.

Properties
Select the attributes you want to make available for items.

The effects of selecting the properties are shown in the table.

Property Effect

Target Proficiency Level
 

Target proficiency levels appear for the items in the performance document. The target proficiency
level that appears is the minimum proficiency level for the competency set in the profile type used to
populate the performance document. For example, you select job profile as the profile type used by the
section. The target proficiency levels in the performance document is the minimum proficiency level
for the competencies belonging to the worker's job profile.
 

Target Performance Rating
 

You can select target performance ratings for the items you add to the section or the performance
template. In the performance document, workers can select target performance ratings for items
they add to the document. Managers can select target performance ratings for items that they, or the
workers, add.
 

Weight
 

You can enter weights for items in the section and the performance template to determine the relative
importance of the items within the section. In the performance document, managers and workers can
change weights for:
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Property Effect

 
• Items they add to the document

• Performance goals added from the goal management business process

• Development goals added from the career development business process

When using calculated ratings, the weights are used only when you select the Average calculation rule
for the section.
 

Minimum Weight
 

You can enter minimum weights for items in the performance template.
 
You can't enter minimum weights into the performance document. The minimum weights you enter
for competencies and performance or the development goals you add in performance template display
in the performance document. The minimum weights you enter for competencies in model profiles
which are used to populate the performance document also display.
 

Required
 

In the performance template section or the performance template, select the Required check box to
prevent workers and managers from editing or deleting the item in the performance template from the
performance document.
 

How Performance Ratings Using the Average Method
Are Calculated  
The application can calculate ratings for each section and the overall rating using the average calculation rule. You can
use the average rule to calculate ratings using various rating models and apply weighting, when weighting is selected.

You select calculation rules for sections using the Performance Template Sections task in the Setup and Maintenance
area or Performance pages.

Settings That Affect Average Rating Calculations
The factors that determine average rating calculations are the:

• Rating models that are selected for each section and content item

• Weighting, which is optional, and can vary between sections and content items

How Performance Ratings Are Calculated
In the average method, the application first calculates the average of the content item ratings to work out the section
rating. The application then calculates the average of the section ratings to determine the overall rating. The application
calculates ratings using precise values throughout the calculation process, and applies rounding at the end. Rounded
values can appear in the performance document for the sections and overall ratings. The number of decimals displayed
is determined in the performance template section.

114



Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 12
Performance Template Sections

Example: Average Method Without Weighting
ABC Company uses the same rating model for the Competencies, Performance Goals, and Overall Summary sections,
with no weighting. The performance document contains no Development Goals section. The rating model has five
levels in the scale, and the numeric values are 1, 2, 3, 4 and 5. Assume that all content items use the same rating model.
The performance template is set up to use the standard rounding rule, and the overall rating is set to display to two
decimal places. The mapping method is Nearest.

Assume the following performance template section configurations:

• Decimal rounding rule is Standard

• Decimal display is 2

• Mapping metric is Numeric Rating

• Mapping method is Nearest

The following table shows the ratings for the Competencies section.

Competency Item Numeric Rating Maximum Numeric Rating from
Rating Model

Decimal Score (Item Rating/
Maximum Rating)

Teamwork
 

4
 

5
 

0.8
 

Leadership
 

3
 

5
 

0.6
 

Communication
 

2
 

5
 

0.4
 

Analytical Skills
 

4
 

5
 

0.8
 

Ethics
 

5
 

5
 

1.0
 

Conceptual Thinking
 

4
 

5
 

0.8
 

The sum of the decimal scores is 4.4, from a possible maximum of 6.0. The 4.4 must be converted to a value on the
rating model for the section. The section maximum numeric rating is 5, so the formula to calculate the section rating is:

(Total Decimal Score) / (Total Maximum Decimal Score) x (Maximum Numeric Rating from Section Rating Model), or in
this example: (4.4 / 6) x 5 = 3.67.

In this example the calculated section rating for competencies is 3.67 out of 5, which maps to a numeric rating of 4.

The following table shows the ratings for the Performance Goals section.

Goal Item Numeric Rating Maximum Numeric Rating from
Rating Model

Decimal Score (Item Rating /
Maximum Rating)

Increase sales revenue
 

5
 

5
 

1.0
 

Cut expenses 3 5 0.6
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Goal Item Numeric Rating Maximum Numeric Rating from
Rating Model

Decimal Score (Item Rating /
Maximum Rating)

    

Grow business in Asia
 

5
 

5
 

1.0
 

Participate in mentoring
 

5
 

5
 

1.0
 

The sum of the decimal scores is 3.6, from a possible maximum of 4.0. The 3.6 must be converted to a value on the
rating model for the section, just as for the Competencies section. The section maximum numeric rating is 5, so using
the same formula to calculate the section rating as for competencies, the section rating is: (3.6 / 4) x 5 = 4.5.

In this example the calculated section rating for goals is 4.5 out of 5, which maps to a numeric rating of 5.

To determine the overall rating, the application calculates the average numeric rating for the two sections. The overall
rating calculation is: (4.0 + 5.0) / 2 = 4.5. The calculated overall rating maps to a numeric rating of 5.

Example: Average Method with Weighting
The following year, ABC Company uses the same rating model for the Competencies, Performance Goals, and Overall
Summary sections as in the previous example. But, the company applies weights to the sections and individual content
items. The weights determine the relative value of one section compared to another section, or content items to one
another. Any content items that don't have weights are ignored in the calculations. The application validates that the:

• Sum of the weights for content items within a section is 100.

• Sum of the sections that contain content items (the Competencies and Performance Goals sections) within a
performance document is also 100.

The following table shows the ratings for the Competencies section.

Competency Item Numeric Rating Maximum Numeric
Rating from Rating
Model

Decimal Score (Item
Rating / Maximum
Rating)

Weight Weighted Score
(Decimal Score x
Weight)

Teamwork
 

4
 

5
 

0.8
 

35
 

28.0
 

Leadership
 

3
 

5
 

0.6
 

5
 

3.0
 

Communication
 

2
 

5
 

0.4
 

10
 

4.0
 

Analytical Skills
 

4
 

5
 

0.8
 

20
 

16.0
 

Ethics
 

5
 

5
 

1.0
 

10
 

10.0
 

Conceptual Thinking
 

4
 

5
 

0.8
 

20
 

16.0
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The sum of the weighted scores is 77.0, from a possible maximum of 100.0. The 77.0 must be converted to a value on
the rating model for the section. The section maximum numeric rating is 5, so the formula to calculate the section rating
is:

(Weighted Score) / (Total Maximum Weighted Score) x (Maximum Numeric Rating from Section Rating Model), or in this
example: (77.0 / 100.0) x 5 = 3.85.

In this example the calculated section rating for competencies is 3.85 out of 5, which maps to a numeric rating of 4.

The following table shows the ratings for the Performance Goals section.

Goal Item Numeric Rating Maximum Numeric
Rating from Rating
Model

Decimal Score (Item
Rating / Maximum
Rating)

Weight Weighted Score
(Decimal Score x
Weight)

Increase sales revenue
 

5
 

5
 

1.0
 

30
 

30.0
 

Cut expenses
 

3
 

5
 

0.6
 

30
 

18.0
 

Grow business in Asia
 

5
 

5
 

1.0
 

25
 

25.0
 

Participate in
mentoring
 

5
 

5
 

1.0
 

15
 

15.0
 

The sum of the weighted scores is 88.0, from a possible maximum of 100.0. The 88.0 must be converted to a value on
the rating model for the section, just as for the Competencies section. The section maximum numeric rating is 5, so
using the same formula to calculate the section rating as for competencies, the section rating is: (88.0 / 100.0) x 5 =
4.40.

In this example the calculated section rating for performance goals is 4.40 out of 5, which maps to a numeric rating of 4.

To determine the overall rating, the application calculates the sum of the numeric ratings for the two weighted
sections, then converts the score to the rating model scale. ABC sets the Competencies section weight to 40, and the
Performance Goals section weight to 60. First, the application calculates the decimal scores of the weighted sections:

• Competencies: 4 / 5 = 0.8

• Performance Goals: 4 / 5 = 0.8

The application then calculates the weighted scores for each section, and adds them together. The total weighted scores
are out of a possible 100.0 points:

• Competencies: 0.8 x 40 = 32.0

• Performance Goals: 0.8 x 60 = 48.0

• Total Competencies and Performance Goals: 32.0 + 48.0 = 80.0

The application converts the scores to the rating model scale to determine the overall rating: (80.0 / 100.0) x 5 = 4.0,
which maps to a numeric rating of 4.
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Example: Average Method with Weighting and Rating Model Variations
For a performance evaluation for a specific project, ABC Company uses various rating models for the Competencies,
Performance Goals, and Overall Summary sections. The performance document contains no Development Goals
section. The application applies the maximum numeric rating from each rating model to calculate the scores. Different
weights are also applied to the content items. Section weights are also applied. The performance template is set up to
use the standard rounding rule, and the overall rating is set to display to two decimal places. The mapping method is
Nearest.

Assume the following performance template section configurations:

• Section weights are applied

• Different weights are applied to the content items

• Decimal rounding rule is Standard

• Decimal display is 2

• Mapping metric is Numeric Rating

• Mapping method is Nearest

The following table shows the ratings for the Competencies section, which uses different rating models with different
maximum ratings for the individual competencies. The section rating model differs from those used for the individual
competencies, and the rating model maximum numeric rating is 7.

Competency Item Numeric Rating Maximum Numeric
Rating from Rating
Model

Decimal Score (Item
Rating / Maximum
Rating)

Weight Weighted Score
(Decimal Score x
Weight)

Teamwork
 

4
 

5
 

0.8
 

35
 

28.0
 

Leadership
 

3
 

3
 

1.0
 

5
 

5.0
 

Communication
 

2
 

4
 

0.5
 

10
 

5.0
 

Analytical Skills
 

4
 

5
 

0.8
 

20
 

16.0
 

Ethics
 

5
 

5
 

1.0
 

10
 

10.0
 

Conceptual Thinking
 

4
 

4
 

1.0
 

20
 

16.0
 

The sum of the weighted scores is 84.0, from a possible maximum of 100.0. The 84.0 must be converted to a value on
the rating model for the section. The section maximum numeric rating is 7, so the formula to calculate the section rating
is:

(Weighted Score) / (Total Maximum Weighted Score) x (Maximum Numeric Rating from Section Rating Model), or in this
example: (84.0 / 100.0) x 7 = 5.88.

In this example the calculated section rating for competencies is 5.88 out of 7, which maps to the numeric rating 6.
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The following table shows the ratings for the Performance Goals section. The Performance Goals section itself uses a
rating model with a maximum rating of 6.

Goal Item Numeric Rating Maximum Numeric
Rating from Rating
Model

Decimal Score (Item
Rating / Maximum
Rating)

Weight Weighted Score
(Decimal Score x
Weight)

Increase sales revenue
 

5
 

5
 

1.00
 

30
 

30.0
 

Cut expenses
 

3
 

5
 

0.60
 

30
 

18.0
 

Grow business in Asia
 

4
 

5
 

0.80
 

25
 

20.0
 

Participate in
mentoring
 

4
 

5
 

0.80
 

15
 

10.0
 

The sum of the weighted scores is 78.0, from a possible maximum of 100.0. Because the maximum for the section
rating model is 6, the section rating is: (78.0 / 100.0) x 6 = 4.68, which maps to the numeric rating of 5.

To determine the overall rating, the application calculates the sum of the numeric ratings for the two weighted
sections, then converts the score to the rating model scale. ABC sets the Competencies section weight to 40, and the
Performance Goals section weight to 60. The overall summary section uses a rating model with a maximum score of 9.

First, the application calculates the decimal scores of the weighted sections:

• Competencies: 6 / 7 = 0.85

• Performance Goals: 5 / 6 = 0.83

The application then calculates the weighted scores for each section, then adds them together. The section weight for
the Competencies section is 40, and for the Performance Goals section it's 60. The total weighted scores are out of a
possible 100.0 points:

• Competencies: 0.85 x 40 = 34.0

• Performance Goals: 0.83 x 60 = 49.8

• Total Competencies and Performance Goals: 34.0 + 49.8 = 83.8

The application converts the scores to the rating model scale to determine the overall rating: (83.8 / 100.0) x 9 = 7.542.
When the rounding rules and decimal places are applied, overall rating is 7.54, which maps to the section numeric rating
8.

How Performance Ratings Using the Sum and Band
Methods Are Calculated  
The application can calculate ratings for each section and the overall rating using the sum method. You can use the sum
method to calculate ratings using any rating model.
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You can also use it to calculate the overall rating when at least one of the Profile Content, Performance Goals, or
Development Goals sections uses the average method, and the others use the sum method.

Settings That Affect Sum and Band Rating Calculations
The factors that determine sum and band rating calculations are the:

• Rating models that are selected for each section and content item

• Numeric ratings and points ranges assigned to each rating level

Items without ratings aren't counted when calculating the ratings. For the band method, the numeric ratings must be
associated with a points range. The rounding rules, mapping metric, and mapping methods must also be set in the
performance template sections.

How Performance Ratings Are Calculated
In the sum method, the section rating is the sum of the numeric rating from the rating level for each content item. The
overall rating is the sum of the numeric ratings for the section ratings.

For the band method, as in the sum method, the application calculates the sum of the section rating. For the overall
rating, the application converts the numeric rating total from the sections to the points range associated with a rating
level.

Example 1: Sum Method with Sum Sections
ABC Company uses the same rating model for the Competencies, and Performance Goals content items. The
performance document contains no Development Goals section. The following table shows the rating levels and the
numeric ratings assigned to each level.

Rating Level Numeric Rating

1-Weak
 

1
 

2-Poor
 

2
 

3-Average
 

3
 

4-Good
 

4
 

5-Excellent
 

5
 

The following table shows the rating model used for the Competencies and Performance Goals sections, and the rating
levels and numeric ratings assigned to each level.

Rating Level Numeric Rating

1-Weak
 

5
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Rating Level Numeric Rating

2-Poor
 

10
 

3-Average
 

15
 

4-Good
 

20
 

5-Excellent
 

25
 

The following table shows the rating model for the Overall Summary section and the rating levels and numeric ratings
assigned to each level.

Rating Level Numeric Rating

1-Weak
 

10
 

2-Poor
 

20
 

3-Average
 

30
 

4-Good
 

40
 

5-Excellent
 

50
 

The following table shows the ratings for the Competencies section.

Competency Item Numeric Rating

Teamwork
 

4
 

Leadership
 

3
 

Communication
 

2
 

Analytical Skills
 

4
 

Ethics
 

5
 

Conceptual Thinking
 

4
 

The score for the Competencies section is: 4 + 3 + 2 + 4 + 5 + 4 = 22, which maps to the section numeric rating 4-Good.
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The following table shows the ratings for the Performance Goals section.

Goal Item Numeric Rating

Increase sales revenue
 

5
 

Cut expenses
 

3
 

Grow business in Asia
 

4
 

Participate in mentoring
 

4
 

The score for the Performance Goals section is: 5 + 3 + 4 + 4 = 16, which maps to the section numeric rating 3-Average.

To determine the overall rating, the application adds the Competencies and Performance Goals sections: 22 + 16 = 38,
which maps to the section numeric rating 4-Good.

Example 2: Sum Method with Average and Sum Sections
For a performance evaluation for a specific project, ABC Company sets up a performance template that uses the sum
method for the Overall Summary and Competencies sections, but the Performance Goals section uses the average
method. In the Competencies section, the content items use a rating model different than that of the section itself. The
section uses the same rating as the Overall Summary section. The Performance Goals section uses the same rating
model for content items as the Performance Goals section itself.

The following table shows the rating levels and the numeric ratings assigned to each level for the individual content
items in the Competencies section.

Rating Level Numeric Rating

1-Weak
 

1
 

2-Poor
 

2
 

3-Average
 

3
 

4-Good
 

4
 

5-Excellent
 

5
 

The following table shows the rating levels and the numeric rating assigned to each level for the Competencies section
itself.

122



Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 12
Performance Template Sections

Rating Level Numeric Rating

1-Weak
 

10
 

2-Poor
 

20
 

3-Average
 

30
 

4-Good
 

40
 

5-Excellent
 

50
 

The following table shows the worker ratings for the Competencies section.

Competency Item Numeric Rating

Teamwork
 

4
 

Leadership
 

3
 

Communication
 

2
 

Analytical Skills
 

4
 

Ethics
 

5
 

Conceptual Thinking
 

4
 

The application calculates the sum of the item rating scores: 4 + 3 + 2 + 4 + 5 + 4 = 22. To determine the section rating,
the application uses the mapping rules for the rating model assigned in the performance template. In this example, the
mapping rule is Nearest, which assigns the section a rating level of 2.

The following table shows the ratings for the Performance Goals section, which uses the average method.

Goal Item Numeric Rating Maximum Rating from Rating
Model

Decimal Score (Item Rating /
Maximum Rating

Increase sales revenue
 

5
 

5
 

1.0
 

Cut expenses
 

3
 

5
 

0.6
 

Grow business in Asia
 

2
 

5
 

0.4
 

Participate in mentoring 4 5 0.8
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Goal Item Numeric Rating Maximum Rating from Rating
Model

Decimal Score (Item Rating /
Maximum Rating

    

The sum of the decimal scores is 2.8, from a possible maximum of 4.0. The 2.8 must be converted to a value on the
rating model for the section. The section maximum numeric rating is 5, so the Performance Goals section calculated
rating is: (2.8 / 4) x 5 = 3.5.

To determine the Performance Goals final section rating, the application uses the mapping rules for the rating model
assigned in the performance template. In this example, the mapping rule is Nearest and the calculated section rating for
goals is 3.5 out of 5, which maps to a numeric rating of 4.

To determine the overall rating, the application calculates the sum of the numeric ratings for the Competencies and
Performance Goals sections: 20 + 4 = 24, which maps to the section numeric rating 20.

Example 3: Band Method
ABC Company sets up a performance template in which the section ratings are calculated using exactly the same
parameters as in the previous example, but the band method is used for the Overall Summary section to calculate the
overall rating.

The following table shows the review point ranges set up for the Overall Section rating model to assign the rating level
for the overall rating.

Rating Level From Points To Points

1-Weak
 

0
 

5
 

2-Poor
 

6
 

10
 

3-Average
 

11
 

25
 

4-Good
 

26
 

40
 

5-Excellent
 

41
 

50
 

To determine the overall rating, add the section numeric ratings from the previous example. The Competencies numeric
rating is 20; the Performance Goals section numeric rating is 4. The total is: 20 + 4 = 24. Using the total numeric rating
and applying the point ranges shown in the table, the total score of 24 for the sections lies in the range of 11 to 25. The
worker's overall rating is 3-Average.
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How Managers Can Justify Difference in Manual and
Calculated Ratings  
If there’s a difference in the calculated and manual section or overall ratings for an employee, managers can justify the
difference by providing their comments.

They can provide the justification in the Manager Justification for Difference in Manual and Calculated Ratings field.
This displays only if the configuration setting is enabled in Section Processing on the Structure tab of a performance
template. If the manual rating changes or if calculated ratings are regenerated, the difference in ratings are processed
again.

The manager entered justification is visible to these people:

• To the manager hierarchy and HR specialists with access to the performance document.

• To a matrix manager participant (if the participant role is configured with Allow role to view worker, manager
and participant ratings, comments and questionnaires selected).

The justification isn’t visible to the employee. And it’s available to managers in the printable performance document.

The justification is enforced if you use the evaluate as manager task. It isn’t enforced when updating performance
documents using HCM Data Loader (HDL).

How You Set the Minimum and Maximum Character
Limits for Evaluation Comments  
You can specify the maximum and minimum number of characters that users should enter when they provide
comments to support their evaluation.

You can use the setting in the Process tab of a performance template to set this limit. Based on whether comments for
each section are configured to be optional with or without warning, or required, the application determines if these
limits are required or a guide for the comments being entered.

The minimum and maximum character limit is only applicable to evaluation comments included in the worker self-
evaluation, manager evaluation, or the participant feedback task. The count of the characters includes letters, numbers,
and HTML tags.

Note:  The character limit isn’t enforced when updating a performance document using HDL.
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Writing Assistant  
Writing Assistant is a tool that provides suggestions for a manager when writing comments or feedback for a worker's
competency or rating level during performance evaluation.

Writing Assistant suggests statements associated with competencies and proficiency levels within those competencies,
to help describe a worker's observed and wanted actions. The Writing Assistant data is displayed in the form of
feedback suggestions and development tips. Use Actions > Open Writing Assistant Excel Template on the Item
Catalogs page in the Profiles work area to generate the spreadsheet for uploading writing assistant data.

Requirements for Using Writing Assistant Data
Here's how you use the Writing Assistant tool:

• HR specialists upload data associated with a competency using an application-generated spreadsheet

• Managers select a proficiency level for a competency

• Managers view suggested comments for the selected proficiency level or for the competency as a whole

• Managers can copy and edit the suggested comments

Did you know that the application enables suggestions only for competencies that have a rating?

Related Topics
• How You Upload Writing Assistant Data Using Spreadsheets

• Guidelines for Setting Up Performance Templates

• How Writing Assistant Works with Performance Documents

How You Upload Writing Assistant Data Using
Spreadsheets  
Human resource (HR) specialists can upload and associate new Writing Assistant data for competencies using an
application-generated spreadsheet.

Use the Export option on the Manage Content Items page in the Profiles work area to generate the spreadsheet for
uploading writing assistant data. The uploaded data is associated with each separate competency.

The application-generated spreadsheet for uploading Writing Assistant data contains the following two worksheets:

• Feedback Suggestions - Upload feedback suggestions for each proficiency level for each competency.

• Development Tips - Upload development tips associated for each competency.

Generate the Spreadsheet
Here's how you generate the spreadsheet to upload and associate data for Writing Assistant with competencies:

1. Navigate to the Profiles work area.

126

https://www.oracle.com/pls/topic/lookup?ctx=fa25a&id=s20041752


Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 12
Performance Template Sections

2. Search for and select the Items Catalog task.
3. In the Search Results region, click Actions > Open Writing Assistant Excel Template. A File Download dialog

box appears.
4. Click Save. Select a destination on your local hard disk to save the CompetencyFeedbackSuggestion.xlsx

spreadsheet.

Upload and Update Feedback Suggestions
To upload feedback suggestions, specify all the required columns in the Feedback Suggestions worksheet and click
Upload. After you click Upload, click Save to commit the feedback suggestions for proficiency levels for associated
competencies into the application database.

To update an existing feedback suggestion, click Download to download all feedback suggestions for competencies into
the spreadsheet. You can then update the suggested text and click Upload. After you click Upload, click Save to commit
the feedback suggestions for proficiency levels for associated competencies into the application database.

Note:  You can enter the same suggestion text for multiple competencies and for multiple proficiency levels.

Upload and Update Development Tips
To upload development tips, specify all the required columns in the Development Tips worksheet and click Upload.
After you click Upload, click Save to commit the development tips for associated competencies into the application
database.

To update an existing development tip, click Download to download all development tips for competencies into the
spreadsheet. You can then update the suggested text and click Upload. After you click Upload, click Save to commit the
updated development tips for associated competencies into the application database.

Note:  You can enter the same suggestion text for multiple competencies.

Related Topics
• Writing Assistant

• How You Set up Writing Assistant for Performance Documents

• How Writing Assistant Works with Performance Documents

• Guidelines for Using Desktop Integrated Excel Workbooks

How You Set up Writing Assistant for Performance
Documents  
Set up the Writing Assistant feature to assist managers in writing useful comments in the performance documents of
workers during a performance evaluation.

The Writing Assistant provides suggestions that are associated with competencies and their correlated proficiency
levels to managers. The suggestions help managers describe observed worker actions, and those workers aspire to
perform.

127

https://www.oracle.com/pls/topic/lookup?ctx=fa25a&id=s20041752
https://www.oracle.com/pls/topic/lookup?ctx=fa25a&id=s20030089


Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 12
Performance Template Sections

To set up the Writing Assistant, you must:

• Create the Profile Content section

• Upload development tips and feedback

Writing Assistant is available only for the Profile Content section type you configure for competencies.

Create the Profile Content Section
To set up the Writing Assistant, you must create and configure a Profile Content section for competencies. You create
the Profile Content section using the Performance Template Section or the Performance Template tasks in the Setup
and Maintenance work areas.

Select the Enable writing assistant for manager option in the Section Content section of the Create Performance
Template Section page to make it available in the performance document.

The Writing Assistant provides suggestions only for competencies and their respective proficiency levels. If you set
up the competencies section to use both proficiency levels and performance ratings, the Writing Assistant provides
suggestions only for the selected proficiency levels. If you set up the section to use only performance ratings, Writing
Assistant displays only development tips associated with the selected competency.

Upload Development Tips and Feedback
To use the Writing Assistant, you must also upload development tips and feedback suggestions for competencies
using a spreadsheet loader. You upload development tips and feedback suggestions on the Item Catalogs page for
competencies in the Oracle Fusion Profile Management business process.

Related Topics
• How Writing Assistant Works with Performance Documents

Create a Performance Template Section for Profile
Content  
This example demonstrates how to create a Profile Content section to rate competencies in the performance document
and use calculated ratings to determine the overall rating.

The following table summarizes key decisions for this scenario.

Decisions to Consider In This Example

What type of section is this?
 

Profile Content section, for competencies
 

Calculate section ratings? With which
calculation rule?
 

Yes, the section uses the Average calculation rule
 

Which section rating model is used?
 

Any
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Decisions to Consider In This Example

Weight the section?
 

Yes, the weight complements the Performance Goals and Development Goals section weights so the
sum of the sections is 100
 

Enable content items for the section?
 

Yes
 

Rate content items?
 

Yes, using the proficiency rating type, and section rating model
 

What properties are included with the
content items?
 

Weight, Required, Target Proficiency Level
 

What is the source of competencies for the
content items?
 

Worker job profile
 

Do you require any content items to be
added to the section?
 

Yes, one content item is required
 

Enable the writing assistant to suggest
comments managers can add for
competencies?
 

Yes
 

To create a performance template section for Profile Content, follow these steps:

1. Go to the Setup and Maintenance work area, and select Workforce Development from the Setup list.
2. Search for the Performance Template Sections task and select it.
3. Click Create in the Performance Template Sections page.
4. Complete each section as described below.

Section Details
1. In the Section Details section, complete the fields as shown in this table.

Field Value

Name
 

Competencies
 

Description
 

This section is used to rate competencies and calculate section ratings as part of the overall
ratings. The section weight section is 40 to complement the Performance Goals section.
 

From Date
 

01/01/2017
 

To Date
 

12/31/2021
 

Status
 

Active
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2. Click Save.

Section Processing Details
1. In the Section Processing section, complete the fields, as shown in this table.

Field Value

Section Type
 

Profile Content
 

Section Rating Model
 

Any
 

Rate Section
 

Select
 

Calculation Rule for Section
 

Average
 

Decimal Places
 

2
 

Decimal Rounding Rule
 

Standard
 

Mapping Metric
 

Numeric Rating
 

Mapping Method
 

Nearest
 

Enable section comments
 

Select
 

Weight section
 

Select
 

Item Weight
 

40
 

2. Click Save.

Item Processing Details
1. In the Item Processing section, complete the fields, as shown in this table. Use the default values except where

indicated.

Field Value

Enable items Select
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Field Value

  

Rate items
 

Select
 

Rating Type
 

Proficiency
 

Use section rating model for
performance rating
 

Select
 

Performance Rating Model
 

Any
 

Item Calculation
 

Proficiency
 

Enable item comments
 

Select
 

Target Proficiency Level
 

Select
 

Target Performance Rating
 

Select
 

Minimum Weight
 

Select
 

Weight
 

Select
 

Required
 

Select
 

2. Click Save.

Section Content Details
1. In the Section Content section, complete the fields, as shown in this table. Use the default values except where

indicated.

Field Value

Use profile related to worker's job
data
 

Select
 

Profile Type
 

Job profile type
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Field Value

Use specific content items
 

Select
 

Enable writing assistant for manager
 

Select
 

2. In the Content Items section, click Add.
3. In the Content Items section, complete the fields, as shown in this table. Use the default values except where

indicated.

Field Value

Item Name
 

Any
 

Target Proficiency Level
 

Any
 

Weight
 

Any
 

Required
 

Select
 

4. Click Save.

Create a Performance Template Section for Performance
Goals  
This example demonstrates how to create a Performance Goals section to rate performance goals in the performance
document and use calculated ratings to determine the overall rating.

The following table summarizes key decisions for this scenario.

Decisions to Consider In This Example

What type of section is this?
 

Performance Goals
 

Calculate the section rating? With which
calculation rule?
 

Yes, the section uses the Average calculation rule
 

Which section rating model?
 

Any
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Decisions to Consider In This Example

Weight the section?
 

Yes, the weight should complement the Competencies section weights so the sum of the sections is
100
 

Enable content items for the section?
 

Yes
 

Give workers and managers the
opportunity to add performance goals
during the Set Goals task, if that task is
included in the process flow?
 

Yes
 

Rate content items?
 

Yes, using the Performance rating type, and the same rating model as the section uses
 

What properties are included with the
content items?
 

Weight, Required, Target Performance Level
 

What is the source of performance goals
for the content items?
 

Oracle Fusion Goal Management
 

Add content items to the section?
 

Yes, add one content item.
 

To create a performance template section for Performance Goals, follow these steps:

1. Go to the Setup and Maintenance work area, and select Workforce Development from the Setup list.
2. Search for the Performance Template Sections task and select it.
3. Click Create in the Performance Template Sections page.
4. Complete each section as described below.

Section Details
1. In the Section Details section, complete the fields as shown in this table.

Field Value

Name
 

Performance Goals
 

Description
 

This section is used to rate performance goals and calculate section ratings as part of the
overall ratings. The section weight section is 60 to complement the Competencies section.
 

From Date
 

01/01/2017
 

To Date
 

12/31/2021
 

Status
 

Active
 

133



Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 12
Performance Template Sections

2. Click Save.

Section Processing Details
1. In the Section Processing section, complete the fields as shown in this table.

Field Value

Section Type
 

Performance Goals
 

Section Rating Model
 

Any
 

Rate Section
 

Select
 

Calculation Rule for Section
 

Average
 

Decimal Places
 

2
 

Decimal Rounding Rule
 

Standard
 

Mapping Metric
 

Numeric Rating
 

Mapping Method
 

Nearest
 

Enable section comments
 

Select
 

Weight section
 

Select
 

Section Weight
 

60
 

2. Click Save.

Item Processing Details
1. In the Item Processing section, complete the fields as shown in this table. Use the default values except where

indicated.

Field Value

Enable items Select
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Field Value

  

Rate items
 

Select
 

Rating Type
 

Performance
 

Use section rating model for
performance rating
 

Select
 

Performance Rating Model
 

Any
 

Item Calculation
 

Performance
 

Enable item comments
 

Select
 

Target Performance Rating
 

Select
 

Minimum Weight
 

Select
 

Weight
 

Select
 

Required
 

Select
 

2. Click Save.

Section Content Details
1. In the Section Content section, complete the fields as shown in this table. Use the default values except where

indicated.

Field Value

Populate with Worker Performance
Goals
 

Select
 

Allow update goals action to update
goal weights from goal management
business process
 

Select
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Field Value

Use specific content items
 

Select
 

2. In the Content Items section, click Add.
3. In the Content Items section, complete the fields, as shown in this table. Use the default values except where

indicated.

Field Value

Item Name
 

Any
 

Performance Rating Model
 

Any
 

Target Performance Rating
 

Any
 

Weight
 

Any
 

Minimum Weight
 

Any
 

Required
 

Select
 

4. Click Save.
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13  Review Periods

Review Periods in Talent Management  
Review periods are business periods that you use to measure performance and achieve results. Review periods enable
you to organize your processes into time bound business cycles. For example, you can create a review period for the
Financial Year 2020 as FY2020.

You can link Talent Management business objects that have the same review period time line. Review period is a
common component that ties to goal plans and performance document periods. For example, you can connect an
employee's performance to business objectives and results by associating goal plans in the Goals work area and
performance documents in the Performance Management work area with business periods using review periods.

Manage Review Periods
As an HR specialist or administrator, you manage review periods on the Review Periods page.

• HR specialists can go to My Client Groups > Goals, and then select the Review Periods link.

• HR specialists can go to My Client Groups > Performance, and then select the Review Periods link.

• Administrators can search for and use the Review Periods task in the Setup and Maintenance area.

These considerations apply for review periods:

• You can create review periods whenever you want to, and later associate them with goal plans, goal plan sets (if
enabled), and performance documents.

• Each review period must have a unique name.

• If a review period is in use, then you can't modify its start and end dates.

• You can set the status of a review period to active or inactive any time. The business objects already associated
with a review period that you make inactive continue to use the review period. But HR specialists can't see
an inactive review period when creating a business object, such as a goal plan, goal plan set, or performance
document.

• You can hide inactive review periods in all employees and managers responsive pages. You need to set the
Display Inactive Review Periods (ORA_HRT_DISPLAY_INACTIVE_REVIEW_PERIODS) profile option to No. But
remember that HR specialists will continue to see inactive review periods regardless of the profile option value.

• You can also delete review periods that aren't in use.

Review Periods You See
You can now only see relevant review periods on the Goal Management and Performance Management responsive
pages.

• On the employee Goals spotlight page, you can see only those review periods for which the employee has an
assigned goal plan. But if primary goal plan is enabled, you can see all review periods.
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• On the employee Performance Spotlight page, you can see only these review periods:

◦ Review periods where the employee has a performance document created for them or an Anytime
document can be created

◦ Review periods where the employee has a check-in document created for them or a check-in document
can be created

• On the Performance spotlight page, an employee can also see review periods where the employee has a
received a request to provide participant feedback for another employee.

• On the Evaluate Performance page, managers can see review periods for which there are created employee
performance documents (regular or Anytime) where the manager is the performance document manager.

• On the Goals and Performance Overview page, managers can see only these review periods:

◦ Review periods where the employee has an assigned goal plan. But if primary goal plan is enabled, all
review periods are shown.

◦ Review periods where the employee has a performance document created for them or an Anytime
Document can be created

◦ Review periods where the employee has a check-in document created for them or a check-in document
can be created

Link Goal Plans and Goal Plan Sets to Performance Documents
When you create performance templates, you select a review period for each document period.

When you create a goal plan, you select a review period and then associate performance document types with the goal
plan. If goal plan set is enabled, when you create a goal plan set, you select a review period. All goal plans in the goal
plan set have the same review period. The goal plan's review period and the associated performance document types
determine the goals that appear in the goal plan when a performance document is created.

Associate Check-In Templates with Review Periods
You can associate a check-in template with specific performance review periods or all review periods. By default, check-
in templates are associated with all review periods. When you create a check-in document based on the template, these
goals for the review period are included in the check-in document:

• Performance goals that aren't pending approval, not private, and not canceled

• Active and not private development goals

You can add a discussion topic for a performance goal if you're assigned any goals for the review period.

Note:  When you change the review periods associated with a check-in template, the already created check-in
documents aren't affected.

Did you know that you can also specify review periods or change review periods for inactive check-in templates? The
review periods can control the goals included in the check-in documents, when you later activate the template.
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Related Topics
• How Performance Documents Work with Performance Goals

• Guidelines for Setting Up Performance Document Periods

• Create a Check-In Template

• Goal Plans

• Goal Plan Sets
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14  Performance Document Types

Overview of Performance Document Types  
You must create performance document types to associate with performance templates to create performance
documents. You can use the document types to differentiate performance templates used to evaluate workers.

You can also use performance document types to determine:

• Which performance documents provide interim ratings in later performance documents

• Which goal plans the performance goals in a performance template belong to. Additionally, the Evaluation Type
determines which section of the performance template the goal plan is mapped to.

Use the Performance Document Types task in the Setup and Maintenance work area.

Attributes
Along with the name and optional description, you configure the following attributes:

• From Date and To Date: For the document type to be valid in the template, the following must be true:

◦ The from date must be the same as or before the performance template from date

◦ The to date must be the same as or later than the performance template to date

• Status: Set the status to Active to make it available for performance templates and performance goals plans.
Once it's used by a template or goal plan, you can't set it to Inactive.

About Performance Templates
You must select a performance document type to include in every performance template. You select the document type
on the General tab of the performance template.

In addition, if you configure the performance template to use interim evaluations, you must select at least one
document type to associate with the document period. The document types and review periods you select on the
Document Periods tab determine which interim ratings and comments appear in the later performance document.
The ratings, comments, or both (depending on configuration) from performance documents associated with those
document types appear in the document.

You can use the same document types, or create unique ones for the interim and final performance documents.

About Goal Plans
To make a goal plan available to use in performance documents, when creating the goal plan you must select the
document types to associate with the goal plan. The document type, in conjunction with the selected review period
determines which goal plans are added to the performance document.

When a worker or manager adds a performance goal to Performance Document D, the goals are automatically added to
Goal Plan A.
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Related Topics
• Interim Evaluations in Performance Documents

• Goal Plans
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15  Performance Templates

Guidelines for Setting Up Performance Templates  
Define performance templates to create the performance documents that managers, workers, and participants use to
evaluate workers' performance for a given time period or project. The performance template combines the process flow
definition, the section definitions, and the document type.

The performance template can also contain content, such as competencies and goals. When creating a performance
template, you can select either of the these types:

• Standard, for typical performance documents, such as annual or project or company-wide evaluations.

• Anytime, for performance documents that managers and workers can create any time to evaluate the worker.

When creating the performance template, the HR specialist must determine:

• Document types and eligibility profiles

• Participation roles

• Process flow

• Calculation rules, processing options, and participant options

• Structure

• Content

• Document periods

To create performance templates, use the Performance Templates task. Go to My Client Groups > Performance >
Performance Templates. You can create a new template by clicking Add or you can search for an existing template.

Document Types and Eligibility Profiles
Select or create a document type to identify the type of evaluation that the performance template supports, such as
annual evaluation, which would use the Standard template or Anytime for an anytime performance document. The
document type included in the performance template is also used to identify which employee's goal plans should
populate the goal sections in the performance document.

Associate eligibility profiles to the overall template, or to the document periods, to restrict the performance documents
made from the template to those who meet the criteria. You can limit access to the document by requiring a certain
eligibility profile; you can also include non-required profiles. Workers must meet the criteria for all required conditions.
They must also meet the conditions for at least one of the non-required criteria.

Participation Roles
Specify the roles that are eligible to access the performance document. You can select Manager, Worker, or any
participant roles created in the Performance Roles task. On the Structure tab, you select which roles can access
the individual section in the performance document to provide ratings and comments, questionnaire feedback, and
perform other actions. For example, if you set up the performance template so that only managers rate workers, but
workers can see the results, then you must select both roles as participants. If, however, the manager rates workers
without the workers participating in the performance evaluation process or viewing results, then you can select only the
manager role.
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In the Participation section, you also set the minimum number of participants required for participant feedback, and
the minimum for each role. These settings aren't enforced but serve as a guideline for managers and workers when they
request participant feedback.

Process Flow
The process flow determines which tasks are included in the performance template. You can select a previously-defined
process flow or create one as you create the template.

The process flow also determines which sections you can add to the performance template. If the performance template
is used to rate workers, set goals, and let workers and managers provide final feedback, the process flow you select
must include all those tasks. You can only add sections to the performance template that are required by the process
flow. For example, if the process flow doesn't include the Worker Final Feedback task, you can't add that section to the
performance template.

You can enter the number of days before the tasks are due that an email alert is sent for both standard and critical
alerts. You enter the task due dates on the Document Periods tab. Alerts aren't available for Anytime performance
templates.

Calculation Rules, Processing Options, and Participant Options
In the Process tab, you can select whether to calculate ratings and display the calculated ratings for performance
template sections. The sections included in the performance template must be set up to use calculated ratings to use
this feature.

Use Processing Options to select these features:

• Designate whether managers, workers, and participants can select star ratings to rate items and sections. For
star ratings, the number of stars correspond to the rating descriptions set for each star. For example, one star
may represent the Foundation rating description, two stars may represent the Intermediate rating description,
and so on. Star ratings can be used only for rating models that use 10 or fewer rating levels. If you specify not
to use star ratings, managers, workers, and participants select the rating descriptions from a choice list. The
rating description displays no numeric rating, but the description corresponds to a rating number set up for the
rating model. The number that corresponds to the rating description selected by the worker or manager is used
to calculate ratings.

• Include digital signature to require workers to verify that they're the people submitting the performance
document as part of the Worker Final Feedback task.

• Display feedback notes on the performance document to use them as a guide to rate workers while the
evaluation is in progress. Feedback can only be viewed by those roles configured to view it. The feedback notes
aren't included in the printed performance document.

Participant options let you determine whether participant feedback is required for the performance document, which
isn't enforced but serves as a guideline for managers and workers. You also specify these options:

• Whether to let workers view participants selected by the manager to provide feedback. When you choose this
option, it overrides other role options that you have set to allow workers to see participant feedback names or
roles, for example, in the Processing by Role section of the Structure tab.

• Whether to auto-populate matrix managers of a worker as participants to avoid manually adding them as
participants.

• The default participant role assigned to matrix managers.

• Whether matrix managers can access worker documents automatically after they're created.
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Structure
Add previously-defined sections or create ones that are required for the process flow selected for the template. You
must select or create one of each type of the sections that are required for this particular template. You can edit
previously-defined sections to suit the template requirements, including processing options, properties and content.

For each section, you must select which roles have access to the section in the performance document to view and if
applicable, provide ratings, comments, and questionnaire feedback.

You can choose which roles can provide item ratings and item comments for these sections in performance documents:

• Performance Goals

• Development Goals

• Profile Content

You can choose which roles can provide section ratings and section comments for these sections in performance
documents:

• Performance Goals

• Development Goals

• Profile Content

• Overall Summary

• Worker Final Feedback (section comments only)

• Manager Final Feedback (section comments only)

Note:  If the performance template is in use, then it's possible to exclude a role from providing ratings or comments.
If a role previously provided item ratings or comments, and you then excluded the role from providing them, the
application retains the previous ratings and comments but doesn't display them in the performance document.

Content
For each section that contains content that can be rated, you can add content items directly to the performance
template so they appear on the performance document. For both Goals and Profile Content sections you can load
content that was included in the previously-defined section. For a Profile Content section, such as competencies, you
can also copy content from whatever profile the section uses as a source for content items. You must set up profiles to
be used as a source in this case.

This lets you target this performance template as broadly or narrowly as you need. You can decide to load content items
from the section, for example, that apply to everyone who's rated using the performance document created from this
template. But you may decide not to copy content directly from a profile in the template because the population being
evaluated has varied profiles. The workers and managers can then copy profile content on the performance document
itself (if the process flow is set up to let them).

Document Periods
You can create a single, or multiple document periods, within a performance template. Adding multiple periods enables
you to create performance documents from the same template for different periods. The performance documents are
treated as distinct documents, but contain the same process flows, sections, and processing rules. For example, you can
create a template for an annual evaluation to use every year. If you create multiple periods (each period is used to create
a performance document), then the content of those performance documents may change as the content is coming
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from other sources: competencies from profiles in profile management, the employee's goals in goal management, or
development goals in career development.

The person who creates the performance document can change the performance document's start and end dates, if
desired. However, the performance document start and end dates must be between the document period's start and
end dates.

Configure these options for the selected period:

• Name: The name of the document period is the name of the performance document created for the period.

• Review Period: Select the review period for the document.

• Performance Document Start and End Dates: These must be the same as, or within, the review period start
and end dates.

• Short Name: Used for reporting.

• Available to Use: Select for anytime documents so they're available to managers and employees to create
them.

• Lock Manager Share Task: Select this to prevent managers from sharing the ratings with employees during
the calibration period. This option is available only if the Allow document sharing task to be locked for
calibration option is enabled in the Process Flow page.

On the document periods you add, you can also set up these items:

• Eligibility profiles: Add additional eligibility profiles or remove the ones inherited from the General tab, and
select whether they're required.

• Document types for interim and anytime evaluations: Add document types used in other performance
templates that you want to appear in the performance document for the selected period.

• Due Dates: Within each period, you can set the due date for each task that's included in the process flow used
by the performance template. Due dates aren't available for Anytime performance templates.

• Questionnaires: Add roles and associate them with questionnaires to give the role access to the appropriate
questions on which to provide feedback in the performance document.

Related Topics
• Considerations for Using Performance Template Section Calculation Rules

• Create a Performance Template Section for Profile Content

Guidelines for Defining Processing Roles for
Performance Template Sections  
Add roles to performance template sections and define processing settings for each role so managers, workers, and
participants can access the sections to rate workers and provide feedback.

You must decide:

• Which roles to add to each section

• Whether ratings and comments for items and sections are required

• Whether to share ratings and comments with workers
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• Whether to update worker profiles with ratings and content items

• Which roles can access questionnaires and feedback

You add roles to sections on the Content tab of the Create and Edit Performance Template pages. You can find those
pages using the Performance Templates task in the Setup and Maintenance work area.

Adding Roles to Sections
You must add all the roles that require access to the section, whether to provide ratings or feedback, or view the section.
For example, if your organization requires only managers to rate goals, but workers can only view the goals and ratings,
you must add both the manager and worker roles to that section.

If the section type is used by a specific role to provide ratings or feedback, you must still add that role. For example,
workers provide feedback on the Worker Final Feedback section type. However, you must add the worker role to the
Worker Final Feedback section so the worker can access it. For the manager to be able to view worker comments on the
Worker Final Feedback section, you must also add the manager role.

The roles that are available to add to the section are those you added in the Participation section of the General tab of
the performance template.

Requiring Ratings and Comments
You can configure the section so ratings and comments are either required, or optional, for both items and the section.
The available options are:

• Optional with warning message: Warning message when no ratings or comments are provided. This is the
default value for all ratings and comments.

• Optional with no warning message: No message because ratings and comments are optional.

• Required: Error message when roles that are required to provide ratings or comments don't provide them.

• Not Allowed: The role can't provide ratings and comments.

You can set up the section so one role is required to provide ratings and comments, but for other roles, they're optional.

To enable item ratings and comments, select the following check boxes in the Item Processing section:

• Enable ratings for items

• Enable item comments

To allow roles to provide section ratings and comments to be used, select the following check boxes in the Section
Processing section:

• Enable manual section rating

• Enable section comments

Sharing Ratings and Comments with Workers
After adding the role, specify whether to share with workers the ratings or comments that managers or participants
provided in the Profile Content, Goals, or Overall Summary sections. You can configure different settings for each
participant role, so workers can see participant ratings and comments for one role, but not another. In the Manager
Final Feedback and Worker Final Feedback sections, specify whether workers can view the manager comments.
Ratings and comments provided by workers and participants are always visible to all managers who have access to the
performance documents. Participants can't view manager or worker ratings and comments.
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Updating Worker Profiles with Ratings and Content Items
For the Profile Content section type, specify whether to update the worker profile with the ratings provided by the
manager and any content items that were added to the performance document that aren't in the worker profile.

For the Overall Summary section, specify whether to update and display the overall performance rating provided by the
manager. When you select the option, the rating appears in the employee's Talent Profile.

If you elect to update profiles for competency sections, you can also specify the instance qualifier to identify that the
source of the proficiency level provided by the manager for competencies is the performance document. Instance
qualifiers must be set up and maintained in Oracle Fusion Profile Management to use this feature.

Accessing Questionnaires and Feedback
When the Participant Feedback task is included in the process flow used by the template, you specify which roles can
see the participant questionnaires. You specify whether:

• Line managers and matrix managers can see questionnaires and feedback provided by workers and
participants, including the participant names.

• Workers can see questionnaires and feedback provided by the manager and participants, including the
participant names.

• Line managers, matrix managers, and workers can see the participant names and their roles.

When you use questionnaires for participant feedback and configure the template so that workers can't view participant
feedback, you can set the Participant Role Can Enter Comments Visible to Worker setting to Yes for a participant
role. Participants with that role can then add overall comments to the questionnaire that are visible to both the manager
and worker. The worker can't view the name of the participants. This option is only available if participants aren't given
access to the Overall Summary section where they can provide overall comments.

Related Topics
• Options for Configuring Performance Documents to Display Performance Ratings to Employees

• Instance Qualifier Sets

Performance Document Task Alert Notifications  
You can set up performance documents to alert workers and managers before a task is due. In the performance
template, you can set up one-time, or repeat notifications, for standard and critical alerts.

Use the Manage Performance Templates task in the Setup and Maintenance work area. Go to My Client Groups >
Performance > Setup Maintenance  > Performance Templates.

If you set up the standard and critical alerts, notifications are sent for all performance documents created from the
template. The notifications are sent when the task is available to begin. For example, the task must be the first in a
created performance document, or the previous task must be completed.

Standard and Critical Alert Days
Enter the number of days before a performance document task is due to send standard or critical alerts to remind
workers and managers of the deadline. The notification is sent once for each alert. You enter the number of days before
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the due date on the Process tab of the performance template. Enter the due date for each task on the Document Periods
tab of the performance template.

You can enter either, or both, standard and critical alert days. The number of standard alert days must greater than the
number of the critical alert days as standard alerts are sent before critical alerts.

If you edit the task due dates for performance documents for specific workers using the Change Due Dates
administrative task, the settings in the template aren't affected. The notifications are sent the specified number of days
before the task due date.

Repeat Standard and Critical Alerts
In the performance template, you can also select the options to send repeat standard and critical alerts until the task is
completed. Select the Repeat Standard Alert Until Task Completes and Repeat Critical Alert Until Task Completes
options that appear on the Process tab of the performance template.

To send notifications for a task deadline, you must run an Oracle Enterprise Scheduler Service process. To launch this
process, use the Navigator > Scheduled Processes > Schedule New Process button in the search results table. Use
the Send Performance Document Alert Notifications job to send the notifications, and set the schedule as appropriate
for your business processes. It is recommended that you set the process to send notifications daily. If you select the
options to send both standard and critical alerts, workers and managers receive notifications according to the following
schedule:

• Standard notifications are sent according to the process job schedule, such as daily, or weekly, starting from the
specified standard alert days before the task is due.

• Critical alerts are sent starting from the specified critical alert days, adhering to the process job schedule until
the task is completed.

For example, assume that you set the standard alert to be sent 14 days before a task is due, and the critical alert to be
sent 7 days before the task due date. In addition, you set the process schedule to send notifications daily. If you enable
the repeat alerts for both the standard and critical alerts, the standard alert is sent every day between 14 and 7 days
before the task due date. Then, the critical alert is sent daily for the 7 days before the task due date and continues
to until the task is completed. If you set only one or the other of the standard or critical alert days to repeat, the
notifications are sent starting from the number of the days before the task is due until the task is completed, according
to the process job schedule.

The notifications cease when the task is completed for the respective role or the performance document is completed.
For example, when the worker submits a completed a task, the worker no longer receives notifications. However, for
tasks that aren't completed, you must turn off the notifications to prevent them from continuing even after the task is
due. To turn off the notifications, you must either:

• Deselect the options in the performance template and save the template.

• Turn off the Enterprise Scheduler Service process.

Interim Evaluations in Performance Documents  
You configure performance templates and document periods to display the ratings and comments from interim
evaluations in subsequent performance documents. This topic explains what interim ratings are and use cases for them,
how you configure them, and how to display them.
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Use Cases for Interim Evaluations
You can use interim documents to view ratings and comments from previous performance documents in later, or
final performance documents in an evaluation period. For example, you can configure interim and later performance
documents to capture and display ratings and comments for:

• Midyear or quarterly evaluations

• Project evaluations

• Previous annual evaluations

You can configure interim documents to capture the same, more, or less information than, for example, an annual
evaluation. For example, you can configure the interim evaluation to require comments, but not ratings, for content
items and sections. Or, for simplicity, the interim evaluation may not contain tasks for participant feedback or approvals.

Available Ratings and Comments
The ratings and comments you configure to appear in each performance document are those that appear in the
later documents. You can configure ratings, comments, or both to appear for the Overall Summary, Profile Content
(competencies) and Goals sections, and ratings only for content items.

If you configure some ratings or comments to appear in the interim, but not the later performance document, the later
document doesn't display the ratings or comments from the interim document. For example, if you include section
ratings in the performance template for the interim evaluation, but not in the final evaluation template, the section
ratings don't appear in the final performance document.

About Configuring Interim Evaluations
Interim evaluations appear in subsequent documents based on configuration of:

• Review periods

• Document types

• Document periods on the performance template

Review periods must be the same for both the interim and later documents that consume the interim documents.

To make interim evaluations appear in later, or final performance documents, you must select at least one document
type to associate with the document period for the final document. The document types you select on the Document
Periods tab determine which interim ratings and comments appear in the final performance document. The ratings,
comments, or both (depending on configuration) from performance documents associated with those document types
appear in the document.

Document types associated with the performance templates used for the performance documents can be the same, or
different for the interim and later documents, depending on your needs. The document types must be the same for all
interim evaluations that you want to appear cumulatively. For example, if your organization uses quarterly evaluations,
to see the ratings for all previous quarters in subsequent quarters, each must use the same document type. If you want
to isolate interim performance documents from each other, but have them appear in a final document, the interim
performance documents must use different document types. You might use this approach, for example, if you have
both midyear and project evaluations and need neither to be visible to the other, but both to appear in an annual
evaluation.

In the document period of the performance templates you use to create the performance documents you select the
review period. In the document period for each later document in which you want interim documents to appear, you
also must select the document types for the interim evaluations you want to appear. If you have only one document
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type, such as for cumulative quarterly evaluations, select the document type those documents use. If you have multiple
evaluations to display, such as for the midyear and project evaluations mentioned previously, select all document types
that apply.

Access to Interim Ratings
Interim ratings and comments appear in the final document in this way:

• Section and Overall Summary ratings appear on the dialog box that appears when you click the Information
icon for the section.

• Content items appear on the dialog box that appears when you click the Information icon for the same content
items, and using the Interim link on the content item detail dialog box.

For individual content items, you can view ratings and comments from interim evaluations only for each matching
content item. For example, if you have a competency in Period 1, and the same competency in Period 2, you can select
the Information icon in Period 2 performance document to see the Period 1 information. If that competency isn't part of
the template or configured to appear as part of a profile in Period 2, it doesn't appear.

In the dialog box that appears, you can click the performance document name to open a PDF of the interim
performance document to see the entire interim performance document.

Guidelines for Setting Up Performance Document
Periods  
You configure document periods on a performance template from which to create performance documents.
Performance documents are created from the document period and the configured attributes, such as the review
period, document types, and associated questionnaires.

You can also associate eligibility profiles to determine which workers can access the documents. This topic describes the
configuration options for document periods. You configure performance templates using the Performance Templates
task.

Document Periods
You can add a single, or multiple periods, within a performance template. Adding multiple periods enables you to create
performance documents from the same template for different periods. This lets you create performance documents
that are treated as distinct documents, but contain the same process flows, sections, and processing rules.

Name
The name of the document period is the name of the performance document created for the period.

Review Period
You must select a review period for the document period. The review period typically corresponds to the talent business
period, such as a calendar or fiscal year, or semiannual period. You can select different review periods for different
document periods. The review period also helps determine which goal plans any goals added to the performance
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document are added to. The goals in the performance document are added to goal plans that are associated with both
the:

• Review period selected for the document period

• Document type selected for the template

Goal plans are available only when Oracle Fusion Goal Management is enabled.

Performance Document Start and End Dates
The performance document start and end dates must be the same as, or within, the review period start and end dates.
The dates for periods can overlap, but can't be identical for the same template.

Short Name
The short name appears in the rating history analytic for each of the three years that appear, rather than the complete
performance document name.

Available to Use
Available to Use is the default setting, and enables managers and workers to create documents for the period.

When you deselect Available to Use:

• Managers and workers can't create the document.

• Human resource (HR) specialists can still search and select the document using the Create Performance
Documents or Monitor Missing Performance Document tasks.

You can deselect the Available to Use option to prevent access, for example, if you have created future periods, but
don't want to make them available yet. Documents that are already created aren't affected by the Available to Use
selection.

Lock Manager Share Task
Select this option if you don't want managers to share their ratings and comments during the calibration period. The
managers won't have the option to share the performance document when this option is enabled and they see a banner
informing them that they can't share the performance document just yet because it's locked for calibration. This feature
only applies to performance documents that use this document period.

Note:  This option is visible only if the Allow document sharing task to be locked for calibration option is enabled
in the Process Flow page in the Setup and Maintenance work area.

Eligibility Profiles
Add eligibility profiles to the period to associate the profiles with the performance documents to restrict access to
the documents made from the templates. Only workers who meet the eligibility criteria can have the performance
documents created for them or access them. Managers can still access the performance documents even if they're not
eligible for them. You can add different eligibility profiles to each period. Eligibility profiles added to the General tab
appear automatically on the Document Periods tab.
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You can remove or select or deselect Required as needed for your business process. If you select eligibility profiles for a
document period, the application assigns performance documents as follows:

• If all eligibility profiles are marked as required, then an individual must meet criteria of all the eligibility profiles.

• If no eligibility profile is marked as required, then an individual must meet criteria of at least one eligibility
profile.

• If some eligibility profiles are marked as required and some aren't, then an individual must meet criteria of all
the required profiles and at least one nonrequired profile.

• If only one eligibility profile is marked as required, then an individual must meet criteria of that eligibility profile.

Document Types for Interim and Anytime Evaluations
If you use interim evaluations, such as quarterly or anytime evaluations, as part of your review process, you must
configure the document period that consumes these evaluations. The ratings and comments in the interim documents
appear in the later performance document. Using the combination of the document type and review period used in the
interim and final performance documents, the application determines which interim documents are included in the final
document.

Interim evaluation ratings and comments appear in the final performance document when:

• You add the document type for the interim evaluations to the document period of the later, or final, evaluation.
You can add document types for each interim evaluation you want to appear in the final evaluation.

• The review periods of the interim evaluations and the final evaluation are the same.

• The performance documents from the interim evaluations are completed.

Due Dates
Within each period, you can set the due date for each task that's included in the process flow used by the performance
template. The due date for each task must be the same or later than the task before, with the exception of the
Participant Feedback task. The due date for the Participant Feedback task must be the same or earlier than the Manager
Evaluation of Workers task due date.

The due dates are guidelines and don't prevent performance documents from being created or tasks from being
completed.

Questionnaires
When using participant feedback, you specify for a period which questionnaire to associate with each participant role,
including the manager and worker roles. The role then has access to the appropriate questions on which to provide
feedback in the performance document.

Related Topics
• How Performance Documents Work with Questionnaires
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Guidelines for Associating Eligibility Profiles with
Performance Templates  
Add eligibility profiles to a performance template to associate the profiles with the performance documents created
from the template. This lets you restrict access to the performance documents.

When associating eligibility profiles to performance templates, you need to make these decisions:

• Do I need to use eligibility profiles?

• Should I add eligibility profiles at the template-level or period-level?

• Should I mark eligibility profiles as required?

• Can I add or remove eligibility profiles when the template is in use?

To manage performance templates, use the Performance Templates task. Search for and select this task in the Setup
and Maintenance work area or go to My Client Groups > Performance.

Use Eligibility Profiles
Add eligibility profiles to performance templates to target performance documents to a specific population of
employees. This enables you to create multiple performance documents that are appropriate for specific review
purposes. For example, you can add an eligibility profile to performance documents that are appropriate for the Sales
team, and another for the Information Technology department.

Add Eligibility Profiles to the Template General Tab and the Document
Periods
You can add existing eligibility profiles to either, or both, the performance template on the General tab and the
document periods on the Document Periods tab. You can add as many profiles as required to either the General tab or
document periods.

Eligibility profiles you add to the General tab are inherited by the document periods when periods are added to the
template. You can add, remove, or change the eligibility profiles for the document periods, and change the required
status as well. The eligibility profiles associated with a document period are used to determine eligibility for documents
created for that period.

Mark Eligibility Profiles as Required
You can specify whether or not an eligibility profile is required.

If eligibility profiles are required for the document period, employees must satisfy all required profiles and at least one
that isn't required, if any are added, to be eligible for the performance document.

When you add only eligibility profiles that aren't required to the document period, employees must satisfy the criteria
for at least one of them to be eligible for the performance document.
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Add or Remove Eligibility Profiles when the Template is in Use
You can add or remove eligibility profiles from a template or document period even if the template or period is in use.
But remember that when you add an eligibility profile to a template, any previously-existing periods don't inherit the
new eligibility profile.

Related Topics
• How You Use Eligibility Profiles with Performance Documents

How You Specify the Number of Participants for a
Performance Document  
You can specify the total minimum and maximum number of participants that employees and line managers can select
to provide feedback for a performance document in the Participation section when configuring a performance template.

You can also specify the minimum and maximum number of participants with other roles such as peer or colleague.

You can enforce these numbers, if you want to. This means employees and managers can’t complete their evaluations
until the minimum number of participants provide feedback and can’t exceed the maximum number they request
provide feedback from.

If you set the total minimum or maximum number of participants, you also need to select a participant role. When you
specify the total maximum number of participants, ensure that you follow these guidelines:

• The maximum number of participants allowed per role isn’t more than the number in How many participants
allowed in total.

• The minimum number of participants isn’t less than the number in How many participants required in total.

Create a Performance Template  
This example demonstrates how to create a performance template that's used to create performance documents
containing most tasks in a process flow, and rate workers. You manage performance templates using the Performance
Templates task in the Setup and Maintenance work area.

The following table summarizes key decisions for this scenario.

Decisions to Consider In This Example

What type of performance template is
this?
 

Standard, for an annual performance evaluation
 

Add eligibility profiles to either the
template or performance document
periods, and are they required?
 

Yes, add the same eligibility profile to both the template and the performance document periods, and
specify it as required; add an additional eligibility profile to one period, and don't specify it as required
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Decisions to Consider In This Example

Calculate section ratings and the overall
rating? Who can see calculated ratings?
 

Yes, the worker, manager, participants, and matrix managers can see calculated ratings
 

Which section rating model to use?
 

Any
 

Weight the sections?
 

Yes, give the Profile Content section a weight of 40, and the Performance Goals section a weight of 60
 

Enable content items for the section?
Include content added to the performance
template in the sections?
 

Yes, enable content items for the Profile Content and Performance Goals sections; add a content item
to each section in the template
 

Is participant feedback required, and
is there a minimum requirement for
participants?
 

Yes, feedback is required with a minimum number of participants; participants should provide ratings
and comments on the Profile Content, Performance Goals, and Overall Summary sections, and a
Questionnaire section is added to the template to capture additional participant feedback
 

Enable options to automatically populate
matrix managers as participants?
Automatically grant access to performance
documents for matrix managers?
 

Yes
 

Enable which roles to provide feedback?
 

Manager, worker, colleague
 

Should managers share ratings with
workers?
 

Yes, managers share their ratings with workers
 

Use ratings to update the worker profile?
 

Yes, use manager ratings to update the worker profile
 

Use the performance template for more
than one period?
 

Yes, set up two performance document periods
 

Use interim evaluations?
 

Yes, use the first performance period as an interim evaluation in the second period
 

Which review periods do I select for the
periods?
 

FY2017
 

Summary of the Tasks
Create a performance template.

1. Enter general information.
2. Enter process details.
3. Enter structure details.
4. Load and add content to the Profile Content and Performance Goals sections.
5. Add two document periods, one for each half of an annual evaluation.
6. Review template settings.
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Prerequisites
1. Create a document type that can be used for an annual evaluation.
2. Create a performance role for Colleague and one for Matrix Manager. Configure the Matrix Manager role to

enable viewing worker and manager evaluations.
3. Create a process flow with the following tasks and subtasks, in the following order: Set Goals, Worker Self-

Evaluation, Manager Evaluation of Workers, Participant Feedback, First Approval, Share Documents, Worker
Must Acknowledge Document, Conduct Review Meetings, Worker Must Acknowledge Review Meetings, Worker
Final Feedback, Manager Final Feedback.

4. Create the following sections: Profile Content, Performance Goals, Questionnaire, Overall Summary, Worker
Final Feedback, Manager Final Feedback.

5. Create the review period named FY2017.

Enter General Information
1. In the Setup and Maintenance work area, on the Workforce Development task list page, in the Task panel, click

Search.
2. On the Search page, click Performance Templates to open the Performance Templates page.
3. Click Add.
4. On the Create Performance Template page, in the General section, complete the fields, as shown in this table.

Field Value

Template Type
 

Standard
 

Name
 

Annual Performance Evaluation
 

Comments
 

This template is used for an annual performance evaluation.
 

From Date
 

01/1/17
 

To Date
 

12/31/21
 

Status
 

Active
 

Document Type
 

Any that can be used for an annual evaluation
 

5. In the Eligibility Profile section, click Add.
6. In the Eligibility Profile section, complete the fields as shown in this table.

Field Value

Eligibility Profile
 

Any
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Field Value

Required
 

Select
 

7. In the Participation section, click Add.
8. Select Manager.
9. In the Participation section, click Add.

10. Select Worker.
11. In the Participation section, click Add.
12. Select Colleague.
13. In the Participation section, click Add.
14. Select Matrix Manager.
15. In the Participation section, complete the fields as shown in this table.

Field Value

Set the minimum number for each
role check box
 

Select
 

Total minimum number of
participants required in the
document
 

2
 

16. In the Colleague and Matrix Manager rows, in the Minimum Number of Participants Required Per Role
column, enter 1.

17. Click Save.

Enter Process Details
1. On the Process tab, complete the fields, as shown in this table. Use the default values except where indicated.

Field Value

Process Flow
 

The process flow you created as a prerequisite for this task.
 

Calculate ratings
 

Select
 

Display star ratings
 

Select
 

Include digital signature
 

Select
 

Display feedback notes
 

Select
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Field Value

Display requested feedback
 

Select
 

Participant feedback is required
 

Select
 

Worker can view participants added
by manager
 

Select
 

Auto-populate matrix managers of
the worker as participants
 

Select
 

Default participant role
 

Matrix Manager
 

Allow matrix managers to access
worker document automatically
 

Select
 

2. Click Save.

Enter Structure Details
Add an available section of each type to the performance template, edit the existing settings for the sections, and add
the manager and worker roles to each section.

1. Enter structure details for the Profile Content section.
2. Enter structure details for the Performance Goals section.
3. Enter structure details for the Questionnaire section.
4. Enter structure details for the Overall Summary section.
5. Enter structure details for the Final Feedback sections.

1. Enter structure details for the Profile Content section
1. On the Structure tab, in the Sections section, click Add.
2. In the Section Name section, select the name of the Profile Content section that you created as a prerequisite

for this task.
3. In the Section Processing section, complete the fields as shown in this table. Use the default values except

where indicated.

Field Value

Section Type
 

Profile Content
 

Section Rating Model
 

Any
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Field Value

Rate Section
 

Select
 

Enable manual section rating
 

Select
 

Calculation Rule for Section
 

Average
 

Decimal Places
 

2
 

Decimal Rounding Rule
 

Standard
 

Mapping Metric
 

Numeric Rating
 

Mapping Method
 

Nearest
 

Enable section comments
 

Select
 

Enable section weights
 

Select
 

Section Weight
 

40
 

Section Minimum Weight
 

10
 

4. In the Item Processing section, complete the fields as shown in this table. Use the default values except where
indicated.

Field Value

Enable items
 

Select
 

Enable ratings for items
 

Select
 

Rating Type
 

Proficiency
 

Use section rating model for
performance rating
 

Select
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Field Value

Performance Rating Model
 

Any
 

Item Calculation
 

Any
 

Enable item comments
 

Select
 

Target Performance Rating
 

Select
 

Weight
 

Select
 

Required
 

Select
 

Target Proficiency Level
 

Select
 

5. In the Processing by Role section, click Add.
6. In the Processing by Role section, complete the fields as shown in this table.

Field Value

Role
 

Manager
 

Item Ratings
 

Optional With Warning
 

Item Comments
 

Optional With Warning
 

Section Ratings
 

Optional With Warning
 

Section Comments
 

Optional With Warning
 

Share Ratings
 

Yes
 

Share Comments
 

Yes
 

Update Profile
 

Yes
 

Instance Qualifier Supervisor
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Field Value

  

View Participant Names
 

Yes
 

View Participant Roles
 

Yes
 

7. In the Processing by Role section, click Add.
8. In the Processing by Role section, complete the fields as shown in this table. Use the default values except

where indicated.

Field Value

Role
 

Worker
 

9. Repeat steps 7 and 8, substituting Colleague and Matrix Manager for Worker.
10. Click Save.

2. Enter structure details for the Performance Goals section
1. On the Structure tab, in the Sections section, click Add.
2. In the Section Name section, select the name of the Performance Goals section that you created as a

prerequisite for this task.
3. In the Section Processing section, complete the fields as shown in this table. Use the default values except

where indicated.

Field Value

Section Type
 

Performance Goals
 

Section Rating Model
 

Any
 

Rate Section
 

Select
 

Calculation Rule for Section
 

Average
 

Decimal Places
 

2
 

Decimal Rounding Rule
 

Standard
 

Mapping Metric
 

Numeric Rating
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Field Value

Mapping Method
 

Nearest
 

Enable section comments
 

Select
 

Weight section
 

Select
 

Section Weight
 

60
 

4. In the Item Processing section, complete the fields as shown in this table. Use the default values except where
indicated.

Field Value

Enable items
 

Select
 

Rate items
 

Select
 

Rating Type
 

Performance
 

Use section rating model for
performance rating
 

Select
 

Performance Rating Model
 

Any
 

Item Calculation
 

Performance
 

Enable item comments
 

Select
 

Target Performance Rating
 

Select
 

Minimum Weight
 

Select
 

Weight
 

Select
 

Required
 

Select
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5. In the Processing by Role section, click Add.
6. In the Processing by Role section, complete the fields as shown in this table.

Field Value

Role
 

Manager
 

Share Ratings
 

Yes
 

Share Comments
 

Yes
 

Update Profile
 

Yes
 

7. In the Processing by Role section, click Add.
8. In the Processing by Role section, complete the fields as shown in this table. Use the default values except

where indicated.

Field Value

Role
 

Worker
 

9. Repeat steps 7 and 8, substituting Colleague and Matrix Manager for Worker.
10. Click Save.

3. Enter structure details for the Questionnaire section
1. On the Structure tab, in the Sections section, click Add.
2. In the Section Name section, select the name of the Questionnaire section that you created as a prerequisite for

this task.
3. In the Section Processing section, select Questionnaire as the section type.
4. In the Processing by Role section, click Add.
5. In the Processing by Role section, complete the fields as shown in this table.

Field Value

Role
 

Manager
 

Manager Questionnaire Can Be
Viewed by the Role
 

Yes
 

Worker Questionnaire Can Be Viewed
by the Role
 

Yes
 

164



Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 15
Performance Templates

Field Value

Participant Questionnaire Can Be
Viewed by the Role
 

Yes
 

Participant Name Can Be Viewed by
the Role
 

Yes
 

Participant Role Can be Viewed by
the Role
 

Yes
 

6. In the Processing by Role section, click Add.
7. In the Processing by Role section, complete the fields as shown in this table. Use the default values except

where indicated.

Field Value

Role
 

Worker
 

Manager Questionnaire Can Be
Viewed by the Role
 

No
 

Worker Questionnaire Can Be Viewed
by the Role
 

Yes
 

Participant Questionnaire Can Be
Viewed by the Role
 

No
 

Participant Name Can Be Viewed by
the Role
 

No
 

Participant Role Can be Viewed by
the Role
 

Yes
 

8. In the Processing by Role section, click Add.
9. In the Processing by Role section, complete the fields as shown in this table. Use the default values except

where indicated.

Field Value

Role
 

Colleague
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Field Value

Participant Role Can Enter Comments
Visible to Worker
 

No
 

10. Repeat step 9, substituting Matrix Manager for Colleague.
11. Click Save.

4. Enter structure details for the Overall Summary section
1. On the Structure tab, in the Sections section, click Add.
2. In the Section Name section, select the name of the Overall Summary section that you created as a prerequisite

for this task.
3. In the Section Processing section, complete the fields as shown in this table. Use the default values except

where indicated.

Field Value

Section Type
 

Overall Summary
 

Rate Section
 

Select
 

Calculation Rule for Section
 

Average
 

Section Rating Model
 

Any
 

4. In the Processing by Role section, click Add.
5. In the Processing by Role section, complete the fields as shown in this table.

Field Value

Role
 

Manager
 

Share Ratings
 

Yes
 

Share Comments
 

Yes
 

Update Profile
 

Yes
 

6. In the Processing by Role section, click Add.
7. In the Processing by Role section, complete the fields as shown in this table. Use the default values except

where indicated.
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Field Value

Role
 

Worker
 

8. Repeat steps 6 and 7, substituting Colleague and Matrix Manager for Worker.
9. Click Save.

5. Enter structure details for the Final Feedback sections
1. On the Structure tab, in the Sections section, click Add.
2. In the Section Name section, select the name of the Worker Final Feedback section that you created as a

prerequisite for this task.
3. In the Section Processing section, complete the fields as shown in this table. Use the default values except

where indicated.

Field Value

Section Type
 

Worker Final Feedback
 

4. In the Processing by Role section, click Add.
5. In the Processing by Role section, complete the fields as shown in this table.

Field Value

Role
 

Manager
 

Share Comments
 

Yes
 

6. In the Processing by Role section, click Add.
7. In the Processing by Role section, complete the fields as shown in this table. Use the default values except

where indicated.

Field Value

Role
 

Worker
 

8. In the Section Name section, select the name of the Manager Final Feedback section that you created as a
prerequisite for this task.
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9. In the Section Processing section, complete the fields as shown in this table.

Field Value

Section Type
 

Manager Final Feedback
 

10. In the Processing by Role section, click Add.
11. In the Processing by Role section, complete the fields as shown in this table.

Field Value

Role
 

Manager
 

12. In the Processing by Role section, click Add.
13. In the Processing by Role section, complete the fields as shown in this table.

Field Value

Role
 

Worker
 

14. Click Save.

Load and Add Content to Sections
1. On the Content tab, complete the fields as shown in this table.

Field Value

Section Name
 

The name of the Profile Content section you created as a prerequisite for this task.
 

2. In the Section Items section, click Load Items from Section.
3. In the Section Items section, click Add, then complete the fields as shown in this table.

Field Value

Item Name
 

Any
 

4. In the Details section, complete the fields as shown in this table. Use the default values except where indicated.

Field Value

Target Proficiency Level Any
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Field Value

  

Performance Rating Model
 

Any
 

Required
 

Select
 

5. On the Content tab, complete the fields as shown in this table.

Field Value

Section Name
 

The name of the Performance Goals section you created as a prerequisite for this task
 

6. In the Section Items section, click Load Items from Section.
7. In the Section Items section, click Add, then complete the fields as shown in this table.

Field Value

Item Name
 

Any
 

8. In the Details section, complete the fields as shown in this table. Use the default values except where indicated.

Field Value

Performance Rating Model
 

Any
 

Target Performance Rating
 

Any
 

Required
 

Select
 

9. Click Save.

Add Document Periods
1. On the Document Periods tab, in the Document Periods section, click Add.
2. In the Document Periods section, complete the fields as shown in this table.

Field Value

Name
 

2017 Performance Evaluation First Half
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Field Value

Review Period
 

FY2017
 

From Date
 

1/1/17
 

To Date
 

6/30/17
 

Short Name
 

Any
 

Available to Use
 

Yes
 

Lock Manager Share Task
 

Yes
 

3. In the Eligibility Profile for the Period section, complete the fields as shown in this table. Use the default values
except where indicated.

Field Value

Eligibility Profile
 

Any
 

4. In the Due Dates section, complete the due date for each task as shown in this table.

Task Due Date

Set Goals
 

6/24/17
 

Worker Self-Evaluation
 

7/1/17
 

Manager Evaluation of Workers
 

7/8/17
 

First Approval
 

7/15/17
 

Share Performance Documents
 

7/20/17
 

Conduct Meetings
 

7/25/17
 

Provide Final Feedback
 

7/30/17
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Task Due Date

Set Next Period Goals
 

8/30/17
 

5. In the Questionnaires for the Period section, click Add.
6. In the Questionnaires for the Period section, complete the fields as shown in this table.

Field Value

Template Role
 

Manager
 

Questionnaire Name
 

Any
 

7. Repeat steps 5 and 6, substituting Worker, Colleague, and Matrix Manager for Manager.
8. On the Document Periods tab, in the Document Periods section, click Add.
9. In the Document Periods section, complete the fields as shown in this table.

Field Value

Name
 

2017 Performance Evaluation Second Half
 

Review Period
 

FY2017
 

From Date
 

7/1/17
 

To Date
 

12/31/17
 

Short Name
 

Any
 

10. In the Document Types for Interim Evaluations section, click Add.
11. In the Document Type field, select the document type selected on the general tab.
12. In the Due Dates section, complete the due date for each task as shown in this table.

Task Due Date

Set Goals
 

12/23/17
 

Worker Self-Evaluation
 

1/8/18
 

Manager Evaluation of Workers 1/15/18
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Task Due Date

  

First Approval
 

1/18/18
 

Share Performance Documents
 

1/21/18
 

Conduct Meetings
 

1/24/18
 

Provide Final Feedback
 

1/31/18
 

Set Next Period Goals
 

12/31/18
 

13. In the Questionnaires for the Period section, click Add.
14. In the Questionnaires for the Period section, complete the fields as shown in this table.

Field Value

Template Role
 

Manager
 

Questionnaire Name
 

Any
 

15. Repeat steps 13 and 14, substituting Worker, Colleague, and Matrix Manager for Manager.
16. Click Save.

Review Template Settings
1. On the Summary tab, review the settings you entered for the template.
2. Click Save.

Related Topics
• Overview of Performance Documents

Configure Anytime Performance Templates  
Implementors configure a performance template from which you create anytime performance documents.

1. Go to My Client Groups  > Performance and select the Performance Templates task.
2. Select the Anytime template type.
3. Configure the rest of the template using the same steps as creating a standard performance template, including

document types, process flows, performance template sections, and document periods.
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◦ When you create a anytime performance template, you can select or deselect the Worker can select
manager when creating document check box on the Processing tab of the performance template. If
selected, the worker can search and select a different manager other than the direct manager. The selected
manager becomes the manager of the performance document.

◦ Remember that you can't configure performance templates for anytime documents with due dates. HR
specialists can add them to individual employee performance documents after they're created using the
Performance Documents administration task.

Options for Updating In Use Performance Templates  
You can edit performance templates that are already in use to change the attributes of the templates. To edit an existing
template, use the Performance Templates task.

Search for and select this task in the Setup and Maintenance work area or go to My Client Groups > Performance.

Attributes You Can Edit on the Process Tab
On the Process tab, you can update these attributes of an in-use performance template:

• In the Alerts section, the number of days before a task due date alert is sent for both standard and critical alerts

• In the Rating Calculations section, if the Calculate ratings option is already enabled, these check boxes:

◦ Display calculated ratings to worker

◦ Display calculated ratings to participants

◦ Display calculated ratings to manager

◦ Display calculated ratings to matrix manager

• In the Processing Options section, these check boxes:

◦ Display star ratings

◦ Display Check-Ins

◦ Display Feedback Notes

◦ Display Requested Feedback

• In the Participant Options section, these check boxes:

◦ Employee can assign participant roles that can view worker and manager evaluations

◦ Manager can assign participant roles that can view worker and manager evaluations

Attributes You Can Edit on the Structure tab
On the Structure tab, you can update these attributes:

• The sequence number of the sections

• In the Performance Goals section, you can select or deselect the Allow update goals action to update goal
weights from goal management business process option, if the Populate with Worker Performance Goals
option is already enabled
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• In the Performance Goals, Development Goals, and Competencies sections, you can update these options in
the Processing by Role sub-section:

◦ Item Ratings

◦ Item Comments

◦ Section Ratings

◦ Section Comments

◦ Share Ratings

◦ Share Comments

◦ View Participant Names

◦ View Participant Roles

• In the Overall Summary section, you can update these options in the Processing by Role sub-section:

◦ Section Ratings

◦ Section Comments

◦ Share Ratings

◦ Share Comments

◦ View Participant Names

◦ View Participant Roles

• In the Manager Final Feedback section, you can update these options in the Processing by Role sub-section for
the Manager role:

◦ Section Comments

◦ Share Comments

• In the Worker Final Feedback section, you can update these options in the Processing by Role sub-section for
the Worker  role:

◦ Section Comments

◦ Share Comments

• In the Questionnaire section, you can update these options in the Processing by Role sub-section:

◦ View Manager Questionnaire

◦ View Worker Questionnaire

◦ View Participant Questionnaires

◦ View Participant Names

◦ View Participant Roles

Attributes You Can Edit on the Document Periods Tab
On the Document Periods tab, you can add or remove these attributes:

• Document Periods
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• Eligibility profiles

• Questionnaires for the period

You can also change the due dates for the tasks.

Automatic Updating of Performance Documents
When you save the updated performance template, a dialog box appears enabling you to review the changes. When you
click OK, a process job starts automatically to update the template and all performance documents created from the
template. The changes appear when a performance document is opened. If there is already a process job running for
the template, you must wait until it completes before submitting it again.

Note that if you change the due dates, existing performance documents that were earlier created based on the edited
template aren't affected. HR specialists need to manually update the due dates in the existing performance documents.
The changed due dates apply only to the performance documents that are created after the template is edited.

Set Up Interim Evaluations in Performance Templates  
You can create performance document types and configure performance templates and document periods to set up
interim evaluations to appear in later performance documents.

You can configure the performance template to display ratings and comments for individual content items, section
ratings, and the overall summary rating. This topic describes how to create document types and document periods to
configure interim evaluations in which ratings and comments appear in successive performance documents, a project
evaluation, and an annual performance document.

Before You Begin
Set up the performance process flow and the review period.

1. Create performance process flows to include tasks for the manager and worker rating the worker for the annual
and quarterly evaluations, and the project evaluations. You can use the same process flow for both.

2. Create the sections required by the process flow, including at least these three sections:

◦ Profile Content (Competencies)

◦ Performance Goals or Development Goals

◦ Overall Summary

3. Create a review period to use in all performance document periods.

Create Document Types
For this procedure, you create document types to use in two performance templates:

• Project Evaluation: Evaluate workers for a project completed within the annual evaluation period. Ratings and
comments for the project evaluation appear in the annual evaluation.

• Annual and Quarterly: Evaluate workers quarterly and annually. The ratings and comments for each interim
quarter appear in the subsequent quarter and annual evaluations.

1. Go to My Client Groups > Performance > Performance Document Types.

175



Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 15
Performance Templates

2. In the Search Results section of the Performance Document Types page, click Create to open the Create
Performance Document Types page.

3. In the Name field, enter Project Evaluation.
4. (Optional) Enter a description.
5. Enter the From Date and To Date. These dates must be the same as or extend beyond the date range of the

performance templates in which they're used.
6. Keep the default status of Active.
7. Select the check box Worker can select manager when creating document to let workers select the manager

who manages their performance documents.
8. Click Save and Close.
9. Click OK.

10. Repeat steps 2 through 6 and 8 to 9 to create the Annual and Quarterly document type. For step 3, enter the
name Annual and Quarterly.

Set up the Project Evaluation Performance Template
In this procedure, you create the performance template for the project evaluation, which is one of the interim
documents that appears in the annual evaluation.

1. Go to My Client Groups > Performance > Performance Templates.
2. In the Search Results section of the Performance Templates page, click Create to open the Create

Performance Template page.
3. Set up the General tab.

a. Select the Template Type as Anytime.
b. Enter a name and optionally comments.
c. Enter the From Date and To Date. The From Date must be the same or later than, and the To Date the

same as or earlier than the From Date and To Date range of the performance document type, process
flow, roles, and sections used in the template.

d. Leave the status as Active. In the Document Type field, select Project Evaluation.
e. In the Eligibility Profile section, add eligibility profiles to limit the performance documents to eligible

employees, if required by your business process.
f. In the Participation section, select participant minimums, if required by your business process.

g. Click Add to add the roles that evaluate the employee.

Note:  Make sure that you add manager and employee roles to the template as only their ratings and
comments appear in interim evaluations.

4. Set up the Process, Structure, and Content tabs.

a. Click the Process tab.
b. In the Process Flow field, select a process flow for the project evaluation.
c. Set up the Alerts, Calculation Rules, Processing Options, and Participant Options sections as required for

your business process.
d. Click the Structure tab.
e. In the Sections region, click Add to add the first section required for the tasks required in the process

flow.
f. Set up the Section Processing, Item Processing, Section Content, and Processing by Role sections as

required to conform to your business process. Note: Ensure that you add manager and employee roles to
the section as only their ratings and comments appear in interim evaluations.

g. Repeat steps 4e and 4f for each section required by the process flow.
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h. Click the Content tab.
i. Add content items to the Goals and Competencies sections, if required by your business process.

5. Click the Document Periods tab.
6. Set up the Document Periods tab.

a. In the Document Periods section, click Add.
b. In the Name field, enter a name. The name is the name of the project evaluation performance document.
c. Select a Review Period. The review period must be the same used for the annual performance template.
d. Edit the performance document start and end dates, if required for your business process.
e. Enter a Short Name for the period.
f. Add eligibility profiles as required for your business process.

g. Enter the Due Date for each task.
h. Select the Available to Use check box.
i. Select the Lock Manager Share Task check box if you don't want managers to share the document with

employees during the calibration period.
j. Add roles and select questionnaires as required for your business process.

7. Click the Summary tab.
8. Review the template and click Save and Close.
9. Click OK.

Set Up the Annual and Quarterly Performance Template
In this procedure, you configure the performance template used for both the annual and quarterly evaluations. On
the Document Periods tab, you configure the periods for each so that each quarterly performance document is an
interim evaluation. Ratings and comments for each appear in the subsequent quarterly and annual evaluations. You
also configure the annual document period so the project evaluation ratings appear.

1. Go to My Client Groups > Performance > Performance Templates.
2. In the Search Results section of the Performance Templates page, click Create to open the Create

Performance Template page.
3. Set up the General tab.

a. Keep the default Template Type as Standard.
b. Enter a name and optionally, comments.
c. Enter the From Date and To Date. The From Date must be the same or later than, and the To Date the

same as or earlier than the From Date and To Date range of the performance document type, process
flow, roles, and sections used in the template.

d. Leave the status as Active. In the Document Type field, select Annual and Quarterly.
e. In the Eligibility Profile section, add eligibility profiles to limit the performance documents to eligible

employees, if required by your business process.
f. In the Participation section, select participant minimums, if required by your business process.

g. Click Add to add the roles that evaluate the employee.

Note:  Ensure that you add manager and employee roles to the template as only their ratings and
comments appear in interim evaluations.

h. Click the Process tab.
4. In the Process Flow field, select a process flow for the annual and quarterly evaluations.
5. Repeat steps 4b through 4i from the Set up the Project Evaluation Performance Template procedure.
6. Click the Document Periods tab.
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7. Configure the document period for the first quarter evaluation.
a. In the Document Periods section, click Add.
b. In the Name field, enter a name for the first quarter performance document.
c. Select a Review Period. The review period must be the same used for the annual performance period.
d. Edit the performance document start and end dates, if required for your business process.
e. Enter a Short Name for the period.
f. Select the Available to Use check box.

g. Select the Lock Manager Share Task check box if you don't want managers to share the document with
employees during the calibration period.

h. Add eligibility profiles and select roles and questionnaires as required for your business process.
i. Enter the Due Date for each task.

8. Set up the document period for the second quarter evaluation.
a. In the Document Periods section, click Add.
b. In the Name field, enter a name for the second quarter performance document.
c. Repeat steps 7c through 7g for the period. The short name must be unique for each period.
d. In the Document Types section, click Add.
e. In the Document Type field, select Annual and Quarterly so the ratings and comments from the first

quarter document appear in the document.
9. Set up the document period for the third quarter evaluation using the following steps.

a. In the Document Periods section, click Add.
b. In the Name field, enter a name for the third quarter performance document.
c. Repeat steps 7c through 7g for the period.

10. Set up the document period for the annual evaluation.
a. In the Document Periods section, click Add.
b. In the Name field, enter a name for the annual performance document.
c. Repeat steps 7c through 7g for the period.
d. In the Document Types period, click Add.
e. In the Document Type field, select Annual and Quarterly so the ratings and comments from each

preceding quarter appear in the annual document.
f. In the Document Types period, click Add.

g. In the Document Type field, select Project Evaluation so the ratings and comments from the project
evaluation appear in the annual document.

11. Click the Summary tab.
12. Review the template and click Save and Close.
13. Click OK.

FAQs for Performance Templates  

What happens when I duplicate a performance template?  
To duplicate a performance template, use the Performance Templates task. Search for and select this task in the Setup
and Maintenance work area or go to My Client Groups >  Performance.
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You have the option to copy all document period information, if it exists, including eligibility profiles, from the original
template. Edit the document period name and short period name on the Document Periods tab to avoid having Copy
in the title. If you copy periods, the new template opens, otherwise the template appears in the search results list, from
where you can open it.

If the template you duplicate is in use, the In Use status of the copied template is set to No. This lets you edit the new
template before making it available. If eligibility profiles are added, documents created from the template aren't available
until eligibility is processed.

What's a participation role in the performance template?  
A role that can access the performance document created from the performance template. You must add to the
template every role that is required to participate in viewing, or providing ratings or participant feedback in the
performance document.

For example, if the process flow requires that managers rate workers and share the performance document, but
workers don't provide ratings, you must add both the manager and worker roles. You can select a minimum number of
participants required for each role to provide feedback, but the number is a guideline and not enforced.
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16  Check-In Templates

Create a Check-In Template  
Before you can create check-in documents, you must have check-in templates available in the application.

When you create check-in templates, you determine these features of check-in documents:

• Associate check-in documents with specific performance review periods or all review periods.

• Include discussion topics for performance goals, development goals, questionnaires, or general discussion
topics.

• Make the template available to employees by specifying one or more eligibility profiles.

Follow these steps to create a check-in template:

1. Go to Home > My Client Groups > Performance, scroll down to the Setup Maintenance section and click
Check-In Templates.

2. Click Create to create a new template.
3. Enter a name for the template, and add comments, if any.
4. In the From Date and To Date fields, specify the period during which an employee or manager can create

check-in documents from this template.
5. From the Review Periods list, select specific performance review periods or all review periods to associate with

the template.
Note:

◦ If you dissociate a check-in template from a review period, there's no impact on employees'
existing check-in documents.

◦ You can specify or change review periods even if a check-in template is inactive. These review
periods will come into effect when the template is activated later.

6. From the Status list, select whether the check-in template is active or inactive.
7. Select Include in Performance Document to automatically include a check-in document created from this

template in a performance document.
8. Select one or more options in the Check-In Content section, as shown in this table.

Check-In Content Options Description

Development goals
 

Employees or managers can create discussion topics for their active development goals in the
check-in document.
 

Add default discussion topics for
development goals
 

Automatically creates discussion topics for active development goals in the check-in document.
 

Performance goals
 

Employees or managers can create discussion topics for their active performance goals in the
check-in document.
 

181



Oracle Fusion Cloud Talent Management
Implementing Performance Management

Chapter 16
Check-In Templates

Check-In Content Options Description

Add default discussion topics for
performance goals
 

Automatically creates discussion topics for performance goals in the review period in the check-
in document.
 

General discussion topics
 

Employees or managers can create general discussion topics in the check-in document.
 

Questionnaire
 

Specify a questionnaire for the employee or manager, or both.
 

9. In the Eligibility Profile section, you can make the template available to eligible employees who meet one or
more eligibility criteria. Click Add Row, and select one or more eligibility profiles. Select Required  to make an
eligibility profile required among the set of eligibility profiles you've selected. For example, if you want only
Sales employees who are either in the UK or the US to create check-in documents, add the Sales, UK, and
US eligibility profiles to the template, and make the Sales eligibility profile as Required, but not the UK or US
profiles.

Note:  Ensure you schedule the eligibility batch process to assign check-in templates to eligible profiles.

10. Click Save and Close.

Related Topics
• Guidelines for Associating Eligibility Profiles with Check-In Templates

Guidelines for Associating Eligibility Profiles with Check-
In Templates  
Add eligibility profiles to a check-in template to restrict which check-in documents can be created for employees.

To manage check-in templates, use the Check-In Templates task. Search for and select this task in the Setup and
Maintenance work area or go to My Client Groups > Check-In Templates.

Add Eligibility Profiles
You can add eligibility profiles to check-in templates to determine which employees check-in documents can be created
for. For example, if you want different content in check-in documents for employees in the US and UK, you can create
2 templates and attach different eligibility profiles to each of them. Then it will only be possible to create check-in
documents for employees from the relevant template.

Mark Eligibility Profiles as Required
You can specify whether an eligibility profile added to a check-in template is required. If an eligibility profile is required,
employees must be eligible for that profile to create check-in documents using that template.

If the check-in template has 2 or more eligibility profiles that aren't required, employees must be eligible for at least one
of the profiles to be able to create check-in documents using that template.
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For example, to create a specific check-in template for Sales employees who are either in the UK or the US, you can
add a required eligibility profile for employees with a Sales job. Then you can add 2 additional eligibility profiles for the
employees located in the US or UK.

Add or Remove Eligibility Profiles when the Template is in Use
You can add or remove eligibility profiles even if the template or period is in use. But when you remove an eligibility
profile from a template it will not impact any existing created check-in documents.

Related Topics
• Create a Check-In Template

Edit a Check-In Template  
When a check-in template is being actively used to create check-in documents, you can go ahead and edit the
template's Name, Comments, and To Date fields as well as the Eligibility Profile section. However, you can't make
changes to the Check-in Content section.

When you modify the eligibility profile, it doesn't impact check-in documents that were already created. However, new
check-in documents can be created only by those employees who match the modified eligibility profile. When you
specify a template's end date (in the To Date field), users can't create check-in documents after that date.

If the check-in template isn't in use, you can set its status to Inactive.

To edit a template, follow these steps:

1. Go to Home > My Client Groups > Performance, scroll down to the Setup Maintenance section, and click
Check-In Templates.

2. Search for the template by specifying one or more search criteria. To view all available templates, click Search
without specifying any search criteria.

3. From the search results area, click the template name to edit it.

Note:  You can check whether a check-in template is in use or not from the search results area.

Delete Future Scheduled Check-ins for Inactive
Assignments  
You can delete future scheduled Performance or Touchpoints check-ins for attendees (either the employee or the
named check-in manager) with inactive assignments using the Delete Future Check-ins for Inactive Assignments
scheduled process so that redundant check-in information isn’t stored.

1. Click Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process. Search and select the Delete Future Check-ins for Inactive Assignments process.
3. In the Process Details dialog box, select the action. You can preview which check-ins will be deleted or update which

will process the deletions.
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4. Select all check-in templates or specific check-in templates. For specific, you can select more than one check-in
template.

5. Select a parameter.

◦ Department - Specific department to which the employees belong.

◦ Manager Person Number - Person number of a specific manager.

◦ Worker Person Number - Person number of a specific employee.

6. Submit the process.
When the process runs, it checks if there are any scheduled check-ins after the employee’s assignment or the
manager’s work relationship was made inactive. Check-ins identified this way are deleted along with any notes and
associated questionnaires created for that check-in.

Manage Check-In Documents Using HCM Data Loader
Tools  
Streamline the mass upload of check-in documents by using the HCM Data Loader or the HCM Spreadsheet Data
Loader tools.

Using these tools, you can upload a number of check-in documents along with discussion topics for performance and
development goals, general discussion topics, and related questionnaires. You can also update or delete existing check-
in documents using these tools.

To upload check-in documents using HCM Data Loader, you need to use the CheckInDocuments.dat file. To upload
using HCM Spreadsheet Data Loader, you need to create a check-in spreadsheet template first and then upload the
template.

To access these tools, go to My Client Groups > Data Exchange.

For more information on performing these tasks, refer to the HCM Integrations Guide and the HCM Business Objects
Guide.

Dispose Check-in Documents  
To meet your data protection requirements, you may want to dispose a terminated employee's check-in documents and
associated data. To do this, run the Remove Person Information task from My Client Groups > Data Exchange.

Before you can perform this task, the administrator needs to first access the Configure Person Information Removal
Policies task from the Data Exchange work area and include the Check-In Document business object in a new or
existing template.

For more information about running this task, see the HCM Integrations and Data Loading guide.
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Feedback Templates  
Create feedback templates as per your organization requirements. You need to specify a questionnaire and set the
template status to Active so that feedback templates are available when creating a feedback request.

As an administrator, you can manage feedback templates in: My Client Groups > Performance > Setup
Maintenance > Feedback Templates.

If the feedback template is in use, the application indicates it in the Feedback Templates page. When the feedback
template is Active, you can modify the template name and description, but not the questionnaire.

You can set the template status to Inactive so that no feedback requests are created using the inactive template.

When the feedback template isn't in use, you can:

• Change the questionnaire in the feedback template

• Delete the feedback template
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18  Customize Feedback Pages

How You Disable the Feedback Tab from Person
Spotlight for Employees  
Using HCM Experience Design Studio, you can hide the Feedback tab from an employee's person spotlight page.

Before you start
Create a sandbox and activate it.

Here's what to do

1. Go to My Client Groups > HCM Experience Design Studio.
2. From the left navigation menu, select Person Spotlight.
3. Edit the Feedback section.
4. From the Visible list, select Expression.
5. In the Expression field, type this EL expression and substitute the Role Name value with the employee seeded

abstract role:
securityContext.userInRole[‘<Role_Name>']

6. Click Save.
7. Click Done.

Results:
The Feedback tab section is now hidden from the employee’s person spotlight page.

Related Topics
• Create and Activate Sandboxes

How You Disable the Feedback Requests About Me
Section for Employees  
You can disable feedback sections for specific user roles using Page Composer and EL expressions. This procedure
describes how you can disable the Feedback Requests About Me section from an employee's feedback spotlight page.

Before you start

Create a sandbox with the Structure and Page Composer tools in it, and activate it.

Here's what to do

1. Open a feedback spotlight page. For example, go to Me  >  Quick Actions  >  Show More  >  Feedback.
2. Click your user name or image in the global header, and select Edit Pages.
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3. Click the Structure tab. A component panel appears at the end of the page. Drag it to the middle of the page to view
the list of page components.

4. Select the Feedback Requests About Me section heading on the Feedback page. If a dialog box appears, prompting
you to confirm editing of the component, click Edit.

5. In the component panel, select the panelCollectionEdit value.
6. On the component panel’s toolbar, click the Show the properties of panelCollectionEdit icon.
7. In the dialog box that appears, click the Show Component menu, and select Expression Builder.
8. Type this EL expression and click OK:

#{!(pageFlowScope.params['pLoggedInPersonId'] eq pageFlowScope.params['pWorkerPersonId'])}

9. Click Apply, and then click OK.
10.Click Close on the top right of the page to exit the Edit Pages mode.

Results:
The Feedback Requests About Me section is now hidden when an employee views their feedback spotlight page.

Related Topics
• Create and Activate Sandboxes
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Overview of Notifications  
As an administrator, you can configure the application to send notifications to different roles such as the HR specialist,
manager, and employee for various performance management tasks.

The application can send notifications in these scenarios, for example:

• Notification to a manager when a worker completes their self-evaluation in a performance document.

• Notification to an employee when the manager creates a new check-in document for them.

• Notification to the feedback provider when you request feedback from them.

When you enable notifications, users get notifications by email or through the Notifications icon on the global header.

Performance Document and Participant Feedback Notifications
You can configure notifications for completing various tasks in performance documents, or for actions such as creating
or completing performance documents.

You can also configure notifications for various participant feedback actions, such as requesting or receiving feedback.

Check-In Notifications
You can configure the application to send notifications when different roles create or delete check-ins, discussion topics
in check-ins, or notes for discussion topics:

• When an employee makes any of the above changes, it sends notifications to the performance manager.

• When the performance manager makes these changes, it sends notifications to the respective employees.

• When an HR specialist makes these changes, it sends notifications to the performance manager and the
employee.

Note:  When a user deletes a check-in document or a discussion topic, the application doesn't send separate alert
notifications for any deleted notes within the check-in document or discussion topic. It sends a notification only once
for the deleted discussion topic or check-in document.

Requested Feedback Notifications
You can configure the application to send notifications to all persons associated with the feedback, such as the feedback
requester and feedback provider, in these scenarios:

• You send a feedback request for yourself or others.

• You request the feedback provider to revise their feedback.

• You request feedback on goals and request revisions on such feedback.

• The feedback provider completes their feedback or revises their feedback.

• You delete a feedback request.
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Related Topics
• Configure Performance Management Notifications Using Reports

Configure Notifications for Performance Documents and
Participant Feedback  
You can configure notifications for tasks related to performance documents and participant feedback either using My
Client Groups or using the Setup and Maintenance work area.

Configure Using My Client Groups
1. Go to My Client Groups > Performance > Talent Notifications.
2. Enable the notifications you need.

Configure Using Setup and Maintenance
1. Open the Settings and Actions menu on the global header, and select Setup and Maintenance.
2. Select Workforce Development from the Setup list.
3. Search for the Performance Notifications task and select it from the search results.
4. Click the Performance Management tab and enable the notifications that you want to send.

Configure Notifications for Check-Ins and Requested
Feedback  
As an HR specialist, you can configure notifications for check-ins and requested feedback using Alerts Composer.

Before you start
You need to have the HRC_ACCESS_ALERTS_COMPOSER_PRIV privilege to do so.
Here’s how you configure the notifications:

Here's what to do

1. From Home, go to Navigator > Tools > Alerts Composer.
2. Search for the keywords, check-in or feedback, to see the related alerts.
3. Select Edit from the Action menu next to the alert that you want to enable or disable.
4. On the Edit Event Alert page, you can see the available email templates sent to different roles as part of the alert.

They are enabled by default.
5. You can enable or disable each of the email templates from the Enabled list.
6. Click Save and Close.
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Configure Notifications for Requested Feedback
Reminders  
You need to enable the alert notification template, Requested feedback reminder, in Alerts Composer to send due date
reminders.

1. From Home, go to Navigator > Tools > Alerts Composer.
2. Search for the HRA_FEEDBACK_REQUESTED alert.
3. Click the alert name from the search results.
4. On the Templates tab, enable the Requested feedback reminder template.
5. Click Save and Close.

Related Topics
• Overview
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